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Preface

Welcome to the JD Edwards EnterpriseOne Tools Foundation Guide.


Audience

This guide is intended to teach users about all functionality of the EnterpriseOne interface.

This guide assumes you have a working knowledge of the following:

• The principles and customary practices of your business area.

• Computer desktop application usage and terminology.


Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/us/corporate/accessibility/index.html.


Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/support/contact.html or visit http://www.oracle.com/accessibility/support.html if you are hearing impaired.


Related Documents

You can access related documents from the JD Edwards EnterpriseOne Release Documentation Overview pages on My Oracle Support. Access the main documentation overview page by searching for the document ID, which is 876932.1, or by using this link:

https://support.oracle.com/CSP/main/article?cmd=show&type=NOT&id=876932.1

To navigate to this page from the My Oracle Support home page, click the Knowledge tab, and then click the Tools and Training menu, JD Edwards EnterpriseOne, Welcome Center, Release Information Overview.

This guide contains references to server configuration settings that JD Edwards EnterpriseOne stores in configuration files (such as jde.ini, jas.ini, jdbj.ini, jdelog.properties, and so on). Beginning with the JD Edwards EnterpriseOne Tools Release 8.97, it is highly recommended that you only access and manage these settings for the supported server types using the Server Manager program. See the Server Manager Guide on My Oracle Support.


Conventions

The following text conventions are used in this document:


	Convention	Meaning
	Bold	Indicates field values.
	Italics	Indicates emphasis and JD Edwards EnterpriseOne or other book-length publication titles.
	Monospace	Indicates a JD Edwards EnterpriseOne program, other code example, or URL.











1 Introduction to JD Edwards EnterpriseOne Foundation

This chapter contains the following topics:

	
Section 1.1, "JD Edwards EnterpriseOne Tools Foundation Overview"


	
Section 1.2, "JD Edwards EnterpriseOne Tools Foundation Implementation"






1.1 JD Edwards EnterpriseOne Tools Foundation Overview

JD Edwards EnterpriseOne Tools software provides a flexible, configurable solution in the face of constantly changing technology and enterprise practices. JD Edwards EnterpriseOne software is the first network-centric software that separates business rules from the underlying technology. As new technologies emerge, JD Edwards EnterpriseOne software enables you to easily add them to the framework of your enterprise.






1.2 JD Edwards EnterpriseOne Tools Foundation Implementation

This section provides an overview of what you need implemented to complete Foundation tasks.

In the planning phase of your implementation, take advantage of all of Oracle's sources of information regarding JD Edwards software, including the installation guides and troubleshooting information.

You might also want to complete at least one JD Edwards introductory training course, if applicable. You should be familiar with navigating the system and adding, updating, and deleting information by using JD Edwards menus, and pages, forms, or windows. You should also be comfortable using the World Wide Web and the Microsoft Windows graphical user interface.









2 Understanding JD Edwards EnterpriseOne Software

This chapter contains the following topics:

	
Section 2.1, "JD Edwards EnterpriseOne Access"


	
Section 2.2, "JD Edwards EnterpriseOne Software Features"


	
Section 2.3, "JD Edwards EnterpriseOne System Integration"


	
Section 2.4, "JD Edwards EnterpriseOne Foundation"






2.1 JD Edwards EnterpriseOne Access

JD Edwards EnterpriseOne supports web client users through the EnterpriseOne Menu. EnterpriseOne Menu is an HTML-based menu system that provides the ability to navigate EnterpriseOne Menus and launch an HTML version of JD Edwards EnterpriseOne. EnterpriseOne Menu is used primarily by end users to conduct end user tasks.






2.2 JD Edwards EnterpriseOne Software Features

JD Edwards EnterpriseOne software offers the following features:

	
Multiplatform computing. JD Edwards EnterpriseOne software has the ability to run on different platforms. This versatility allows for easy maintenance of information across a network.


	
Integrated supply chain. JD Edwards EnterpriseOne software provides the ability to use the internet and an intranet to enable you to communicate and share information with your employees, customers, and suppliers.


	
Interoperability. JD Edwards EnterpriseOne software lets you leverage your existing investments in hardware, databases, and software, and integrate them with legacy and third-party products.


	
Adaptability. JD Edwards EnterpriseOne software adapts easily to different languages, currencies, reporting provisions, and technology standards.


	
Usability. JD Edwards EnterpriseOne software lets you point and click, drag and drop, and use fill-in-the-blank forms to easily complete your tasks.




Through the JD Edwards EnterpriseOne Portal, users access JD Edwards EnterpriseOne applications using links in the Portal's menus.

The following browsers are supported by JD Edwards EnterpriseOne:

	
Safari on Mac OS


	
Mozilla on Linux


	
Internet Explorer on Windows









2.3 JD Edwards EnterpriseOne System Integration

JD Edwards EnterpriseOne software combines enterprise applications with an integrated toolset to tailor those applications to the needs of your business.

JD Edwards EnterpriseOne refers to each group of its software products as an application suite. The application suites support manufacturing, financials, distribution or logistics, and human resource operations for multisite and multinational organizations. Your business needs determine what application suites are installed for your enterprise system. For complex business situations, you might use several application suites to achieve a comprehensive solution.

Each application suite is made up of systems. For example, the Financial Suite contains systems such as Enhanced Accounts Receivable, system 03B; Accounts Payable, system 04; General Accounting, system 09; Fixed Assets, system 12; and others. Each system consists of applications, forms, reports, and database tables that are designed to handle specific business needs.

Because the functions and features of all the systems are similar and integrated, you are not necessarily aware of moving from one system to another when working with various applications.

This guide often refers to Address Book, system 01, to illustrate the foundational concepts of JD Edwards software. Address Book, an online version of a traditional card file, is a database of names, addresses, and phone numbers that:

	
Provides easy access to all addresses for searching and reporting purposes


	
Reduces the need for duplication of records


	
Provides security through Business Unit assignment or Search Type authorization


	
Interfaces with other JD Edwards software systems




Because it is fundamental to business solutions, Address Book provides a realistic subject for learning the foundational concepts of JD Edwards EnterpriseOne software. Many of the tasks that you perform use Address Book examples.






2.4 JD Edwards EnterpriseOne Foundation

The Foundation Guide introduces you to the integrated environment of JD Edwards EnterpriseOne. Through overviews, procedures, and examples, Foundation describes the operations and functions that are common to all applications. Foundation comprises the following topics:


	Topic	Description
	JD Edwards EnterpriseOne Access	Learn about the different applications that can be used as an entry point for accessing JD Edwards EnterpriseOne tools and applications.
	Application User Interface	Learn about the operating environment, including menus, forms, and the grid.
	Records	Learn how to locate, add, and work with database records, add objects, and format and move around on a record-entry form.
	Messages and Queues	Learn to use Work Center to send and work with messages from JD Edwards EnterpriseOne users and recipients outside of the JD Edwards EnterpriseOne software environment.
	Media Object Attachments	Learn how to attach objects (text, images, OLE objects, and JD Edwards EnterpriseOne shortcuts) to rows and forms.
	MailMerge Workbench	Learn about merging JD Edwards EnterpriseOne system records with third-party word processing documents for automatic creation of form letters by using certain application workflows.
	Interactive Versions for Applications	Learn to modify the behavior of applications through changes to processing options and interactive version detail.
	Batch Versions for Reports	Learn how to create, modify, and print your own report versions.
	Processing Options	Learn key functionality, types, and how to access and use processing options.













3 Using the JD Edwards EnterpriseOne Web Application User Interface

This chapter contains the following topics:

	
Section 3.1, "Understanding Web Application Forms"


	
Section 3.2, "Form Types"


	
Section 3.3, "Accessing JD Edwards EnterpriseOne Web Client"


	
Section 3.4, "Navigating in EnterpriseOne"


	
Section 3.5, "Using the Grid"


	
Section 3.6, "Working with Records"


	
Section 3.7, "Working with Toolbar Options"


	
Section 3.8, "Using Parameterized URL"


	
Section 3.9, "Working with Interface Features"






3.1 Understanding Web Application Forms

This section discusses web application forms.






3.2 Form Types

Applications use a variety of form types. The characteristics of each form type remain the same, regardless of the application in which you access the form.



3.2.1 Find/Browse Form

The Find/Browse form provides the entry point to most applications. It contains an optional query-by-example (QBE) line so that you can search any field in the grid. The standard title for a Find/Browse form begins with "Work With" followed by information that is specific to the business task. You cannot add or change existing records on a Find/Browse form.

Find/Browse forms enable you to do these tasks:

	
Search, view, and select multiple records in a grid


	
Exit to another form to add, change, or view a record









3.2.2 Search/Select Form

Use the Search/Select form to locate a value for a field. The grid displays values that are stored in a database table. When you select a value from the grid and click the Select button, that value is automatically placed in the field. For example, when you need to enter a user defined code (UDC) into a field, the search button appears, enabling you to access a Search/Select form that displays a list of UDCs. You can select an item from the list and place it in the appropriate field. You cannot edit the information that appears on this form.






3.2.3 Header Detail and Headerless Detail Forms

The Header Detail and Headerless Detail forms include a detail area, the OK button, and the Cancel button. You can change multiple records using these forms. The Header Detail form includes information from two different business views to provide more depth on the information that appears on the form. The Headerless Detail form provides information from only one table. Data that is common to all the records in the grid displays at the top of the form.

Header Detail and Headerless Detail forms enable you to:

	
Display multiple records


	
View records


	
Add records


	
Change records


	
Delete records









3.2.4 Fix/Inspect Form

The Fix/Inspect form does not include a detail area. If a record was chosen on a previous form, the Fix/Inspect form displays data for that record. If you are adding a record, the Fix/Inspect form is empty, except for any default values.

Fix/Inspect forms enable you to:

	
View a single record


	
Add a record


	
Change a record









3.2.5 Parent/Child Form

The Parent/Child form presents parent/child relationships in an application on one form. The left portion of the form presents a list of items. The right portion of the form displays information that relates to the selected item in the left portion of the form. The Parent/Child form supports the ability to drag and drop items from one area to another. This form includes Select and Close buttons.

You can resize the display areas according to your personal preferences.






3.2.6 Message Box

The message box contains information about processing that occurs when you work with JD Edwards EnterpriseOne software. For example, when you delete a record, a Confirm Delete message box appears to ask if you are sure that you want to delete the object. The message box might also include information about an event that occurs while you work with the system.






3.2.7 Power Forms

Power forms are web-only application forms that enable you to view multiple, interrelated views of data, grids, and tab pages on one form and to pass logic between them. The tab pages can have their own business views (BVs), and these BVs can communicate with each other and can update based on data selection and changes that occur in other BVs on the form.








3.3 Accessing JD Edwards EnterpriseOne Web Client

This section provides an overview of accessing the JD Edwards EnterpriseOne web client and discusses how to:

	
Access the JD Edwards EnterpriseOne Web Client through the JD Edwards Collaborative Portal.


	
Accessing the JD Edwards EnterpriseOne Web Client through the through the Enterprise Portal.


	
Access the JD Edwards EnterpriseOne Web Client Directly.






3.3.1 Understanding JD Edwards EnterpriseOne Web Client Access

Accessing JD Edwards EnterpriseOne applications on the web is similar to accessing files and applications on a company network. Typically, either when you start your computer or when you want to access company network directories, you must sign in to identify yourself to the system as an employee who has the right to access company resources. After you sign in, you can access files and applications on the network. Similarly, you must sign in the Web client-the gateway through which you access JD Edwards EnterpriseOne-before you can launch JD Edwards EnterpriseOne applications.

To sign in to the JD Edwards EnterpriseOne web client, your computer must have access to your company's intranet, you must have a Web browser installed on your computer, and your system administrator must create an account for you. When your system administrator sets up your account, he or she creates a user ID and assigns you a password.

Usually, you must enter your ID and password when you launch the JD Edwards EnterpriseOne web client. However, your system administrator can configure your computer in such a way so that you appear to bypass the sign-in process. For security reasons, however, most system administrators want you to sign in manually. When you sign in to the JD Edwards EnterpriseOne web client, EnterpriseOne Menu appears. EnterpriseOne Menu enables you to access JD Edwards EnterpriseOne applications, reports, and other features.






3.3.2 Accessing the JD Edwards EnterpriseOne Web Client through the JD Edwards Collaborative Portal

When you sign in to the Collaborative Portal, the Portal can pass your sign-in information to JD Edwards EnterpriseOne. Therefore, all you must do is bring up a workspace containing the EnterpriseOne Menu portlet. The EnterpriseOne Menu portlet enables you to access JD Edwards EnterpriseOne applications, reports, and other features.






3.3.3 Accessing the JD Edwards EnterpriseOne Web Client through the through the Enterprise Portal

When you sign in to the Enterprise Portal, the Portal can pass your sign-in information to JD Edwards EnterpriseOne. To access specific JD Edwards EnterpriseOne applications, reports, or features, your system administrator must provide you with specific menu options. Choose a menu option to launch a specific JD Edwards EnterpriseOne object.






3.3.4 Accessing the JD Edwards EnterpriseOne Web Client Directly

To sign in to the JD Edwards EnterpriseOne web client directly:

Follow this task to sign in to the JD Edwards EnterpriseOne web client if you do not use a portal.

	
Launch your Web browser and navigate to your company's JD Edwards EnterpriseOne Web sign-in.

Depending on how your system administrator has configured your system, the Web sign-in might appear when you launch your browser, you might need to click a button or a link, or you might need to navigate to a particular page. Your ability to access the JD Edwards EnterpriseOne Web Client directly might have been disabled. If you do not know how to find the JD Edwards EnterpriseOne Web sign-in, contact your system administrator.


	
Complete the following fields:

	
User ID


	
Password





	
If your system administrator indicated that you must sign in to a particular environment, click Details and complete the Environment field.


	
If you have multiple roles and wish to sign in as one of them, click the Details button and complete the Role field.




	
Note:

The default value is *ALL, which signs you in as a member of all of your roles. Select the *ALL role if you are not sure which role to use.








	
If you want your computer to remember your settings for the future, select Remember my sign in information.




	
Note:

Do not use this option if other people have access to your computer.








	
Click Sign In.

The EnterpriseOne Menu appears.











3.4 Navigating in EnterpriseOne

This section provides an overview of the EnterpriseOne Menu, and discusses how to:

	
Navigate in EnterpriseOne Menu.


	
Use the fast path.


	
Access your favorites task view.


	
Add a Task to your Favorites Task View






3.4.1 Understanding EnterpriseOne Navigation

EnterpriseOne Menu is the Web-based application you run to access JD Edwards EnterpriseOne applications.



3.4.1.1 Menu

The left portion of EnterpriseOne Menu displays a tree structure that you can use to navigate to the specific application or report that you want to launch. The tree can contain objects other than applications; for this reason, all objects in the tree are called tasks. Nodes, applications (including reports), and shortcuts in the tree are all tasks. Each time you click a node, you expand the tree a level and the view of the tree changes.

Principal sets of tasks are called task views. Your system administrator configures your task view list; that is, the initial contents of the tree. The list might start or end with a special task view called Favorites. All your other task views appear above or below this one.

System administrators use JD Edwards Solution Explorer and JD Edwards EnterpriseOne ERP security applications to manage user accounts and to configure EnterpriseOne Menu.

As you expand nodes the description of the node will wrap to the next line. You can use the Expand icon on the top of the menu to maximize the menu to full screen. To collapse the menu to the fixed width, you use the Restore icon. When the menu is expanded, applications will be displayed in a new window. You can customize the width of the menu by clicking the edge of the menu and dragging it to the size you desire. This width will be stored for you, and will continue to display at the same width until you change it.

EnterpriseOne Menu displays visual cues to help you identify the type of task. Interactive applications have a dash (-) beside them; batch applications have a blue dot beside them; all other tasks have a green dot beside them.






3.4.1.2 Open Application List

EnterpriseOne Menu enables you choose to have applications launch in a new window, or to launch in the window that is already displayed, replacing the current application located there. Each application that is open displays at the top of the EnterpriseOne Menu. This enables you to navigate between open applications.






3.4.1.3 Fast Path

Fast Path is a field that enables you to access a specific task (that is, a folder, application, or report) directly. You use commands in Fast Path to move quickly among menus and applications. To use the Fast Path field, enter a Fast Path code and click the button to the right of the field. Depending on how your system administrator configured your account, you might not be able to see Fast Path. You can also use the Fast Path field to access menus. Task views are composed of menus and individual tasks. Menus have no special format in EnterpriseOne Menu; they simply provide application developers with a convenient method of grouping applications. When you access a menu, you actually access a specific place in a task view. To access a menu, enter its ID. For example, G0 accesses the Foundation Systems menu. You can find a menu's ID by hovering over it. To launch an application, enter the application's program number. To specify a form in the application, enter the application's program number followed by a |, and then enter the form ID. For example, when you enter P01012|W01012B, the system displays the Work with Addresses form in the Address Book application. You can specify a version of a form to open by adding a | and the version number after the form name; for example, P01012|W01012B|ZJDE0003. Contact your system administrator for specific internal task, menu, and application IDs. Not all objects have Fast Path commands.






3.4.1.4 Favorites

The Favorites task view is where you can save links to other tasks. If you frequently run a task, you can save that task in your favorites list. Then, you can access that task directly from your Favorites task view. You have your own Favorites task view, and other users in your company have their own Favorites task views. No one else can see your Favorites task view or your changes. Depending on how your system administrator configured your account, you might not be able to see or change your Favorites task view.






3.4.1.5 Roles — Role Chooser

The tasks you see in the EnterpriseOne Menu are filtered by role. Your system administrator decides the tasks that will be available for each role and then assigns the role to you. You can have one or many roles assigned to you. You choose which role you want to use at the time you sign into EnterpriseOne. The role you choose determines the tasks that will be available to you. Your ability to choose roles at sign in and to choose roles from the EnterpriseOne Menu depends on if your system administrator has given you permissions to do so. If she/he has not, then you can only sign in using the *ALL (All My Roles) role. When signed in as *ALL (All My Roles) role, the EnterpriseOne Menu displays a concatenated list of all the tasks enabled for each role that is included in *ALL (All My Roles) role.




	
Note:

Your system administration determines the roles that are included in *ALL (All My Roles) role.







If enabled by your system administrator, the EnterpriseOne Menu displays the Role drop-down menu. This menu enables you to display different sets of tasks by role. You can either select *ALL – ALL My Roles to view a concatenated view of all of the tasks assigned to all of the roles in the *ALL (All My Roles) role. Or you can select an individual role and view only the tasks for that role. Only the roles that are included in the *ALL (All My Roles) role appear in the drop-down menu. If your system administrator has not enabled you to choose roles, the Roles drop-down menu will not display. Instead, you only see the *ALL (All My Roles) role and the tasks enabled within that role. This feature is only available if: Viewing tasks by role is enabled by your system administrator. You sign in using *ALL.






3.4.1.6 Actions

The Actions section displays static links that your system administrator makes available for you to use. These links are tasks that are used frequently by most users, such as a link to the online help, or a link to your personal profile. These links are available to all users accessing the same environment.






3.4.1.7 Preferences

The Preferences section of the EnterpriseOne Menu has the following option: Minimize menu on app launch.

These options determine whether the menu is displayed when an application is opened and where the application is displayed. If you choose Minimize menu on app launch option, the menu will not display when you launch an application. Clicking the Restore button will redisplay the menu.








3.4.2 Navigating in EnterpriseOne Menu

Access EnterpriseOne Menu.

	
In EnterpriseOne Menu, click a task (that is, a folder) in the tree.

The task node expands to show the tasks beneath it.


	
Continue to drill into the tree structure until you reach the object you want to launch.

Hover over a task to see more information about it. The system tells you what kind of object the task is (for example, application, report, and so on) and other information, such as its number and version.


	
To launch the object, click it.

You can launch multiple applications. Depending on how your system administrator has configured your system, additional applications launch in the same window or in a different window. If the system is configured for multiple browser windows, you can hold down the CTRL key when you press Enter to launch the application in a new window. Either way, the applications you have running appear at the top of the tree under Open Applications.


	
If you have multiple applications open, click the application name under Open Applications to bring a specific application to the forefront.

Depending on the object type, you might be able to select a version or to set data selection or processing options. Click the triangle to the right of the object and make a choice from the resulting drop-down menu.









3.4.3 Accessing your Favorites Task View

To access your Favorites task view:

In EnterpriseOne Menu, click the Favorites Task.






3.4.4 Adding a Task to your Favorites Task View

Access EnterpriseOne Menu.

To add a task to your Favorites task view:

	
In EnterpriseOne Menu, navigate to the task that you want to add to your Favorites task view.


	
Click the arrow next to the task and select Add To Favorites from the resulting menu.











3.5 Using the Grid

This section provides an overview of the grid and discusses:

	
Create a Grid Format.


	
Create a Grid Format for Pervasive Devices.


	
Apply a Grid Format.


	
Change a Grid Format.


	
Delete a Grid Format.


	
Hide or Showing Grid Columns.


	
Rearrange Grid Columns.


	
Set Grid Color and Font.


	
Change Grid Column Width.


	
Change the Sort Sequence of a Grid.


	
Exporting All Records from a Grid


	
Exporting Detail Area Content to Microsoft Excel, Word or to a Comma Separated Values File


	
Importing Data from an External Spreadsheet to a Grid


	
Customizing the Grid Dynamically


	
Copying and Pasting Grid Data






3.5.1 Understanding the Grid

Similar to find/browse forms, hierarchical grids, or parent/child browse forms, are used to query business views (BVs) and select records from BVs for operations. However, instead of a default grid control, hierarchical grids contain a default parent child control instead. Whether or not you have hierarchical grids depends on if your system administrator incorporated them into the applications you use.

The following table describes the features of the hierarchical grid:


	Feature	Description
	Cut, Copy, and Paste	You can cut, copy, and paste a node in the tree. Cutting a node will copy the data of a node and mark the node as being cut. Copy will copy the data of a node. Paste will paste the node as the last child of the new node. If the node is copied, the original node stays. If a node has been cut, the original node is removed. Cancel Cut will cancel the operation. Use the copy, cut, and paste buttons located on the toolbar of the grid to perform these functions.
	Indent/Outdent	You can change the indentation of a tree node. Use the Indent and Outdent buttons located on the toolbar of the grid to perform these functions.
	Expand All	You can expand all the nodes in the tree. Use the Expand All button located on the toolbar of the grid to perform this function.
	Collapse All	You can collapse all the nodes in the tree. Use the Collapse All button located on the toolbar of the grid to perform this function.
	Fully Expand One Tree Node	You can fully expand a selected tree node. When this happens, all cascading children of the selected tree node will be displayed. Use the Expand All button to perform this function.
	View Location Number	If your system administrator has turned on the View Location Number option, you will see a number beside each tree node. Use this number to determine the location of the tree node within the tree.
	Flat Display Tree	You can make all tree nodes display on one vertical level. Child nodes will not be indented.
	Select All Children	You can select all of the children in a node. Use the Select All button located on the toolbar of the grid to perform this function.
	Editable Parent Child	You can edit the tree column and all the grid columns in the hierarchical grid.
	Change Data Dictionary Item on the Fly	You can display custom selected columns in a user defined sequence.
	Vertical Scrolling Keeps Column Header	When scrolling down grid data, grid column header will remain visible.










3.5.2 Understanding Grid Icons and Buttons

This table shows the icons and buttons that might display on the grid. Whether or not you see any of these icons or buttons depends on if the application you are using was designed to display them. You might see a variation of these icons and buttons, depending on the application in which you are working.


	Icon	Description
	[image: Description of delete.gif follows]
	Delete
	[image: Description of edit.gif follows]
	Edit
	[image: Description of copy_and_lock.gif follows]
	Lock
	[image: Description of unlock.gif follows]
	Unlock
	[image: Description of move_up.gif follows]
	Move Up
	[image: Description of move_down.gif follows]
	Move Down
	[image: Description of price.gif follows]
	Price
	[image: Description of print.gif follows]
	Print
	[image: Description of attach.gif follows]
	Attach
	[image: Description of copy_and_lock.gif follows]
	Copy
	[image: Description of view.gif follows]
	View
	[image: Description of toggle_off.gif follows]
	Toggle Off
	[image: Description of toggle_on.gif follows]
	Toggle On
	[image: Description of weigh.gif follows]
	Weigh










3.5.3 Creating a Grid Format

Your ability to create a grid format depends on whether or not your system administrator has enabled the Customize Grid option. If you do not see the Customize Grid option in the blue bar located at the top of the grid, you do not have permissions to customize the grid.

If you want to recall the default format, save the original grid format before you save a new format. Otherwise, you must remove the new format, exit the application, and then access the application again to view the default grid format.




	
Note:

Columns that you are required to use have an asterisks beside the column name. You cannot remove these required columns from your grid format.







Access the application for which you want to create a new grid.

	
Launch the application for which you want to create a new grid format and click the Customize Grid link


	
On Select Grid Format, click the Create button.


	
Enter a name for the format in the Grid Format Name field.


	
Complete the rest of the options as desired, and click the OK button.


	
Click the Close button.









3.5.4 Creating a Grid Format for Pervasive Devices

Access the JD Edwards EnterpriseOne web client.

	
Using the JD Edwards EnterpriseOne web client, launch the application for which you want to create a grid format for pervasive devices.


	
Click Customize Grid and select the format that you want to use for pervasive devices.

If you have not created the format, do so now. Follow the same steps for creating the format that you use for creating a Web-based format. However, keep in mind the limited space and color options offered by most pervasive devices when you decide about columns to display, column widths, column and text colors, and so forth.


	
Click Default for Mobile Device and click Close.









3.5.5 Applying a Grid Format

Access a form with a grid.

On any form with a grid, select a grid format from the drop-down list next to Customize Grid.

You must create one or more grid formats before you can apply a grid format.






3.5.6 Changing a Grid Format

Your ability to change a grid format depends on whether or not your system administrator has enabled the Customize Grid option. If you do not see the Customize Grid option in the blue bar located at the top of the grid, you do not have permissions to customize the grid.




	
Note:

Columns that you are required to use have an asterisks beside the column name. You cannot remove these required columns from your grid format.







Access the application containing the grid format that you want to change.

	
Click the Customize Grid link.


	
On Select Grid Format, select the grid format that you want to change and click the Modify button.


	
To change the name of the grid format, enter a new name in the Grid Format Name field.


	
Change other elements of the grid as desired and click the OK button.


	
Click the Close button.









3.5.7 Deleting a Grid Format

Your ability to delete a grid format depends on whether or not your system administrator has enabled the Customize Grid option. If you do not see the Customize Grid option in the blue bar located at the top of the grid, you do not have permissions to customize the grid.

Access a form with a grid.

	
On any form with a grid, click the Customize Grid link.


	
On Select Grid Format, select the grid format that you want to delete and click the Delete button.

The grid format disappears from the list.


	
Click the Close button.









3.5.8 Hiding or Showing Grid Columns

Access the application containing the grid you want to change.




	
Note:

Columns that you are required to use have an asterisks beside the column name. You cannot remove these required columns from your grid format.







	
Click the Customize Grid link and either create a new format or select an existing one to modify.


	
On Customize Grid, scroll to the Display and Order section.


	
To prevent a column from showing on the grid, select it in the Display and Order list, and then click the left arrow.


	
To make a column appear on the grid, select it in the Available Columns list, and then click the right arrow.


	
Use the up and down arrows to change the order in which the system displays the columns on the grid.


	
When finished, click the OK button, and then click the Close button.









3.5.9 Rearranging Grid Columns

Access the application containing the grid you want to change.

	
Click the Customize Grid link and either create a new format or select an existing one to modify.


	
On Customize Grid, scroll to the Display and Order section.


	
In the Display and Order list, click a column name and use the up and down arrows to move it up or down in the list.

The system displays the columns in the list in the order in which they appear from top to bottom. In other words, the column at the top of the list appears first on the grid, the column second from the top appears second on the grid, and so forth.


	
Repeat step 4 for any other columns that you want to move.


	
When finished, click the OK button, and then click Close.









3.5.10 Setting Grid Color and Font

Access the application containing the grid that you want to change.

	
Click the Customize Grid link and either create a new format or select an existing one to modify.


	
On Customize Grid, scroll to the Display and Order section.


	
Click a column name in the Display and Order list.

The column name appears in the Selected Column field.


	
To apply a background color to the column, click a color in the pallet under Column Color.

The hexadecimal value for the color that you chose appears in the Column Color field.


	
To apply a color to the text in the column, click a color in the pallet under Text Color.

The hexadecimal value for the color that you chose appears in the Text Color field.


	
To apply a font style such as bold or italics to the text in the column, click the styles that you want to apply in the Text Options list.


	
Click the Update Style button.

The system updates the Selected Column field to show you how your choices will look. The system also places a plus sign next to the column name in the Display and Order list. This symbol indicates that user-defined formatting will be applied to the column.


	
Repeat steps 4-8 to apply formatting to additional columns in the grid.


	
When finished, click the OK button, and then click the Close button.









3.5.11 Changing Grid Column Width

Access the application containing the grid that you want to change.

	
Click the Customize Grid link and either create a new format or select an existing one to modify.


	
On Customize Grid, scroll to the Display and Order section.


	
Click a column name in the Display and Order list.

The column name appears in the Selected Column field.


	
Enter a percentage value in the % Column Width field.

This value is the percentage of the space that you want the system to allot to the column based on the width defined for the data item on which the column is based. You can enter a value between 25 and 400.


	
When finished, click the OK button, and then click the Close button.









3.5.12 Changing the Sort Sequence of a Grid

Access the application containing the grid that you want to change.

	
Click the Customize Grid link and either create a new format or select an existing one to modify.


	
On Customize Grid, scroll to the Data Sequencing section.


	
If you want to sort on a column, click the column name in the Available Columns list, and then click the right arrow.

The system moves the column name from the Available Columns list to the Sequenced Columns list.

A column must be included in the grid-that is, its name must appear in the Display and Order list-before you can sort on it.


	
If you do not want to sort on a column, click the column name in the Sequenced Columns list, and then click the left arrow.

The system moves the column name from the Sequenced Columns list to the Available Columns list.


	
To rearrange the order of sort precedence, use the up and down arrows under the Sequenced Columns list to rearrange the column names.

The system first sorts by the column at the top of the list, then by the column second from the top, and so forth.


	
To sort column values in ascending order, click the column name in the Sequenced Columns list and select the Ascending check box.

If you leave the Ascending box blank, the system sorts the column in descending order.

An A appears next to the column names to be sorted in ascending order, and a D appears next to the column names to be sorted in descending order.


	
When finished, click the OK button, and then click the Close button.









3.5.13 Exporting All Records from a Grid

You can export all records from a grid, rather than choosing a range of records to export.

	
Launch an application with a detail area, and then click the Find button to load the detail area with records.


	
Click the Tools icon, and then click the Export Grid Data menu.


	
On Export Assistant, select one of these options:

	
Export To Excel




	
Note:

If you select this option, select if you want to export to a new workbook, or an existing workbook.








	
Export To Word


	
Export To Comma Separated Values (CSV) File character encoding





	
Select the Export All option.


	
Click Continue.









3.5.14 Exporting Detail Area Content to Microsoft Excel, Word or to a Comma Separated Values File

Access an application with a grid.

	
Launch an application with a grid, and then use Find to load the detail area with records.


	
From the Tools menu, click Export Grid Data.


	
On Export Assistant, select one of these options:

	
Export to Excel

If you select this option, select if you want to export the data to a new workbook, or an existing workbook.


	
Export to Word


	
Export to Comma Separated Values





	
Select Export All to export all the data in the grid, or clear the Export All check box to export a range cells within the grid containing data that you want to export.

If you clear the Export All check box, then you must select on the grid the range of cells you want to export. First, click the cell where you want the range to begin, then click the cell where you want the range to end.

If you click the wrong cell, click Reset Selection.


	
Click Continue.

The system exports the detail area contents that you selected to the appropriate file type and displays it.









3.5.15 Importing Data from an External Spreadsheet to a Grid

You can import data from an external spreadsheet into a grid in EnterpriseOne. The external grid must be in CSV or Excel format. EnterpriseOne enables you to choose a range of data by entering the beginning and ending row and column where the data resides in the spreadsheet.

Access an application with a grid.

	
From the Tools menu, choose Import.


	
Click the Import from Excel or the Import From Comma Separated Values (CSV) option.

If you choose the CSV option, the Excel file and Worksheet name options are hidden.


	
In the Excel file: field, enter the location where the external spreadsheet from which you want to import data resides. You can also click the Browse button located beside the field and navigate to the file.


	
In the Starting Cell fields, in the Col and Row fields, enter the co-ordinates of the first cell in the range of cells you want to import from the external file.


	
In the Ending Cell fields, in the Col and Row fields, enter the co-ordinates of the last cell in the range of cells you want to import from the external file.


	
Click one of the following options:

	
Insert (Import new rows at column A, row 0 of the grid): click this option if you want to add the rows you identified to the beginning of the grid. This option will not overwrite the existing data that resides in the grid; rather, it will add the rows to the existing data.


	
Paste: click this option if you want to overwrite the existing data that resides in the grid. With this option, you can paste the new rows anywhere in the existing grid. If you paste a range of data that exceeds the existing range of data in the grid, EnterpriseOne appends the new data after the last row of the grid data. These new rows are new, not overridden.

If you choose Paste, the Select Paste Location in Grid fields become active. Enter the first cell location where you want to paste the data.

You can click Reset to undo your changes and to return the initial data that was in the grid when you first entered the Import Assistant.





	
Click Apply.





Importing and Exporting to the Clipboard

Exporting/importing to the Clipboard is available in ActiveX mode and HTML mode. When HTML mode is enabled the following options are removed:

	
Export to Word


	
Impor from Excel




The clipboard functionality replaces these options when in HTML mode.


Figure 3-1 HTML Mode

[image: Description of Figure 3-1 follows]






Figure 3-2 ActiveX Mode

[image: Description of Figure 3-2 follows]





To export data to the clipboard:

	
Navigate to the Export Assistant


	
Select Export to Clipboard.


	
Define the cell range in the Export Assistant.


	
Click the Apply button.


	
Press Ctrl+C to copy the data to the clipboard.




To Import Data from the Clipboard:

	
Navigate to the source data.


	
Copy the desired data.


	
Navigate to the Import Assistant from the target application.


	
Select Import From Clipboard.


	
Define an import location.


	
Press Ctrl+V in the Import Assistant to view the data in the preview grid.


	
Click the Continue button to complete the import.









3.5.16 Customizing the Grid Dynamically

JD Edwards EnterpriseOne enables you to dynamically customize a grid. “Dynamically” means that you are able to make changes directly to a grid on which you are working. You can change column widths, arrangement. You can save these changes and use them in any application where dynamic grid formatting is enabled.

To change column width

	
Navigate to an application grid that you want to modify.


	
Click the right side of the column and, while holding down the left mouse button, drag it to the desired width.




To rearrange columns

	
Navigate to an application grid that you want to modify.


	
Click the top of the column and, while holding down the left mouse button, drag it to the desired location and release the mouse button.




To save the changes you have made to the grid

	
Navigate to an application grid that you want to modify.

When you customize a grid, the page refreshes and a Save icon displays in the upper-right corner of the grid, beside the grid format name.


	
Click the Save icon on the grid. If prompted, type a name in the field that is located beside it.

When you log into the application again, your saved grid format is available.









3.5.17 Copying and Pasting Grid Data

In JD Edwards EnterpriseOne, you can select a single cell or a range of cells that contains grid data to copy and paste into any EnterpriseOne editable grid. An editable grid is one in which you can enter or delete data. You can also paste grid data into a tab delimited spreadsheet, like Microsoft Excel. You deselect cells by pressing the F5 button on your keyboard, or by clicking outside of the grid.

The “start cell” is the first grid cell you click to begin selecting a range of cells. The “end cell” is the last grid cell you click to end selecting a range of cells. The cells you select to copy can be editable or non-editable.

To copy and paste grid data

Navigate to an application grid that contains the data that you want to copy.

	
Select a range of cells to copy by completing one of the following actions:

	
Click the start cell and, while holding down the left button, drag the mouse to the end cell. If the start cell is editable, you cannot use this action to select a range of cells. Instead, use the action described below.


	
Click on the start cell and while pressing the Shift key on your keyboard, click on the end cell. You can expand the range of cells you have already selected by pressing the Shift key and clicking on a different end cell.

As you move your cursor toward the scroll bar, the grid will automatically begin scrolling so that you can select a cell outside of those that are currently visible on the grid.


	
Click the checkbox located beside a record. Press the Ctrl and C keys on your keyboard.

This option only works if you have not selected a range of cells as described in option A or B.





	
Press the Ctrl and C keys on the keyboard.

The grid data that you selected is copied to the EnterpriseOne clipboard, which is located at the following location: :\WINDOWS\system32\clipbrd.exe


	
Navigate to an editable grid, and place your cursor in an editable cell.

It is important that you notice in which columns you are pasting the grid data. EnterpriseOne enables you to paste the grid data in any field on an editable grid, regardless of whether or not the columns match up. Therefore, you can paste grid date from an Alias Name column into an Address column, and EnterpriseOne will not correct the action.


	
Press the Ctrl and V keys on the keyboard.

EnterpriseOne pastes the data into the grid.











3.6 Working with Records

The section provides an overview of records and discusses how to:

	
Locate Records Using Specific Selection Criteria


	
Use the Query-by-Example Line


	
Locate Records Using Wildcard and Operators


	
Choose a Record


	
Add a Record


	
Change a Record


	
Delete a Record






3.6.1 Understanding Records

Databases store information in units called records. Each record might contain more than one item of information. For example, Dominique Abbott is an item of information in the EnterpriseOne system. When you access Dominique Abbott from the Address Book application, the record that appears might also include Dominique's phone number, address, and other pertinent information. The system might save all of this information as one record, or it might save some of this information as a primary record and other information as secondary records. These types of relationships exist throughout the system. Database tables store all system records. Each record must have at least one key that links the record to a database table. Keys are unique identifiers that distinguish one record from another. For example, Address Book uses Address Number as the key to distinguish each record. Therefore, each Address Number must be unique. When creating new records, you must enter information into a key field. If you do not enter information into a key field, the system displays an error message. Once you have entered information into a key field, you cannot edit that key field later. To change the key field information, you need to create a new record. The Media Objects feature allows you to add notes, graphics, and other objects to records.






3.6.2 Locating Records Using Specific Selection Criteria

Selection criteria defines your search by specific types of records. For example, you can include information in filter fields such as Name Search and Search Type to search only for employees whose names begin with the letter A.

	
On Work With Addresses, complete the Search Type field.

If you do not know the Search Type, use the Search button to view a list of user defined codes.


	
Click the Find button.

A list of matching records appears.









3.6.3 Using the Query-by-Example Line

You can use the query-by-example line to search for records by a grid column. For example, if you are searching for a person by name, enter all or part of the name in the query-by-example line directly above the Alpha Name column in the grid. The information that you enter in the query-by-example line must be a valid value for the column. If it is not, the system will not find a match. You cannot enter values in the disabled (grayed-out) columns because these columns do not allow searches. Some query-by-example lines work differently. On some forms in the Tools setup applications, tabbing to the end of a line after filling in one or more fields achieves the same result as clicking the Find button.

On any Find/Browse form, type the characters on which you want to search in the corresponding column of the query-by-example line, and then click Find. For example, on Address Book Revisions (P01012), type all or part of the name of the individual you are searching for in the Alpha Name column of the query-by-example line, and then click Find. The record that matches the query criteria appears in the grid.






3.6.4 Locating Records Using Wildcards and Operators

You can use the asterisk (*) as a wildcard character in place of one or more letters. Using the asterisk widens your search. For example, you can type abb* in the Alpha Name column of the query-by-example line to view all records that begin with the letters abb. Or you can type *bb* in the query-by-example line to retrieve those records that contain the letters bb in the middle of the name. In addition, you can search for values in a set using operators. For example, in the Address Number column of the query-by-example line, type <87 to specify address numbers that are less than 87. Type <b in the Alpha Name column of the query-by-example line to specify names that begin with a. The following operators are valid in the query-by-example line:

< Less than

< = Less than or equal to

> Greater than

> = Greater than or equal to

! Not equal to

Each time that you enter values in a search, click the Find button to retrieve matching records. 82






3.6.5 Choosing a Record

You choose a record for a variety of reasons. For example, you might need to change an employee's address and phone number. You can choose a single record or multiple records from the Find/Browse form, and then you can change the information on a Revision form.

You can choose a record in one of two ways:

	
Click the record and then click the Select button to open the corresponding form.


	
Double-click a record to select it and open the corresponding form.




To choose a record:

	
On any Find/Browse form, locate a record.


	
Double-click the record to display it on a revision form.


	
On the revisions form, revise the record and then click OK.

If you selected more than one record, your second record might appear now. If your second record does not appear, click the Next button at the top of the form. Continue to revise as needed.


	
After you finish, be sure to click OK to save your latest revision and then click Cancel to exit.









3.6.6 Adding a Record

When adding records to the database, you add the primary record first and then add the secondary records.

To add a record:

	
On a Find/Browse form, click Add to open a blank revision form.


	
Enter the information for the new record.


	
Click OK.

When you add records, the system uses the Next Numbers feature to automatically number Address Book records, journal entries, purchase orders, and other documents.









3.6.7 Changing a Record

In EnterpriseOne, a Find/Browse form appears when you open most applications. On the Find/Browse form, you choose the action that you want to perform. Choosing a button or function that you want to perform displays, for example, a Fix/Inspect form on which you can change your record.

As you move from field to field, you view your changes reflected in the form. If you type an invalid value in a field, the field highlights in red and an error appears. You must correct the error before you click OK. Clicking OK saves your changes in the database.

You cannot change information on the Find/Browse form itself. The information you have changed appears after you choose the appropriate button on the Find/Browse form.

To change a record:

	
On a Find/Browse form, choose a record.

You can double-click a record, or choose a record and then click the Select button.


	
On the revisions form, revise information as needed.


	
Click OK to accept the revisions.









3.6.8 Deleting a Record

Occasionally, you might need to remove a record from your database. For example, you might no longer use a particular supplier. Depending upon the application, if you delete a primary record the system might also delete any secondary records related to the primary record, such as phone numbers. See the appropriate application guide for information about deleting child records.

To delete a record:

	
On a Find/Browse form, choose one or more records.


	
Click Delete.

The system prompts you to confirm the deletion.











3.7 Working with Toolbar Options

This section contains the following topics:

	
Understanding Toolbar Options


	
Working with Row and Form Exits




	
Setting Up Favorite Row and Form Menu Selections






3.7.1 Understanding Toolbar Options

Most JD Edwards EnterpriseOne forms include a toolbar with buttons that provide access to specific tasks. You must be familiar with toolbar options to use the JD Edwards EnterpriseOne system. Toolbar options vary depending on form type. For example, a Find/Browse form usually includes a Select button so that you can select a record in the grid, whereas a Fix/Inspect form does not have a Select button because it displays the values for a specific record.

The following table describes many of the standard toolbar buttons:


	Toolbar Button	Description
	Find	The Find button displays records in a grid.
	Select	The Select button selects one or more records and opens corresponding forms.
	Search	The Search button displays all the entries from your database that match the search criteria that you specify.
	Add	The Add button opens a new form where you can add a new record.
	OK	When you click the OK button, record additions and updates are written to the database.
	Copy	From a Find/Browse form, the Copy button copies the entire record. The system copies all fields into a new record, except those fields that are unique to the existing record.From a Fix/Inspect form, the Copy button selects the fields for the new form. You must enter data in all other fields. You can modify on the new form those fields that you copied from the existing record.
	Delete	From a Find/Browse or Fix/Inspect form, the Delete button deletes the entire record.
Depending on the application that you are using, the Delete button might also remove related information. For example, if you delete an Address Book record, the system also deletes the phone numbers for that record. See your application user guide for information about deleting child records.


	Close	The Close button closes the form.
	Cancel	When you click the Cancel button, any changes you have made are lost and no database changes are made.
	Tools	The Tools button can include options such as Refresh, Export Grid Data, or Data Browser.






In addition to standard buttons, the toolbar can include other options such as reports (which provides a list of reports pertaining to the application), row exits, and form exits






3.7.2 Working with Row and Form Exits

When you click the Form or Row button on the toolbar, a list appears with options relating to the active form. The functions on the form and row exits vary from form to form. For example, a form or row exit might open a data entry form or provide access to other forms that relate to the record you selected.

You can also use row exit and form exit right-click options to access the selections on the row and form toolbar menus. When you right-click a cell in the grid, the grid row is selected and the row menu selections display in a pop-up menu. Using this feature, you do not need to click the Row button at the top of the form. This feature has been enabled for Find/Browse, Search & Select, Parent/Child, Headerless Detail, Header Detail, Power Browse, Power Edit, and Subform forms.

The following example shows the pop-up menu that displays on the Customer Service Inquiry form after right-clicking a cell in the grid:


Figure 3-3 Row Exit Pop-Up Menu

[image: Description of Figure 3-3 follows]








	
Note:

If the JD Edwards EnterpriseOne form does not have any Row menu selections available, the default browser's pop-up menu appears and the grid row is not selected.







Similarly, when you right-click in the form outside the grid, the form menu selections display. The form menu selections are not accessed from a row. Any disabled menu selections in the form and row menus do not display in the pop-up menu list.

The following example shows the form menu selections on the Customer Service Inquiry form:


Figure 3-4

[image: Description of Figure 3-4 follows]








	
Note:

To hide the form exit pop-up menu you can click anywhere in the form header. To hide the row exit pop-up menu, click anywhere in the grid except for grids which are editable. In the case of editable grids you have to click on the form header (or) below the grid area to hide the pop-up menu.









3.7.2.1 Accessing Row Menu Selections

To access row menu selections:

	
On a form with a Row button on the toolbar, click the Row button.

The row menu selections display in a drop-down list.


	
Click the desired menu selection.


	
Alternatively, click a cell in the grid to display the row menu selections in a pop-up window.









3.7.2.2 Accessing Form Menu Selections

To access form menu selections:

	
On a form with a Form button on the toolbar, click the Form button.

The form menu selections display in a drop-down list.


	
Click the desired menu selection.


	
Alternatively, right-click anywhere in the form (except the grid) to display the form menu selections in a pop-up window.











3.7.3 Setting Up Favorite Row and Form Menu Selections

The row and form menu selections can be managed and displayed in a the Favorites section of a row or form exit pop-up menu. For example, if you frequently use the SO Header Browse form exit in the Customer Service Inquiry (P4210) application, you can set up that selection in the Favorites menu, as shown in the following example:


Figure 3-5 Form Exit Pop-Up Menu with Favorites

[image: Description of Figure 3-5 follows]







3.7.3.1 Adding Favorites to a Form or Row Pop-Up Menu

To add row or form exit selections as favorites in a pop-up menu:

	
On a form with a Row button on the toolbar, right-click a cell in the grid to display the row pop-up menu.


	
If the form has a Form button on the toolbar, right-click the form to display the form pop-up menu


	
Click a selection in the Form or Row portion of the pop-up menu and drag it to the Favorites section.




	
Note:

If there are no menu items in the Favorites section, drag and drop the menu selection onto the Favorites label to add the menu item to the Favorites menu.








	
If necessary, drag and drop the Favorites selections to reorder them.


	
To remove a selection from Favorites, drag it to the Row or Form section of the pop-up menu.













3.8 Using Parameterized URL

The Simplified Parameterized URL is a feature that enables an external system to launch a native JD Edwards EnterpriseOne application through the use of a simple URL. This feature provides external applications the ability to have a nearly seamless user interface integration with any available JD Edwards EnterpriseOne application.

When you select Parameterized URL from the Tools menu on a form, a JavaScript Alert message shows the parameterized URL for that application. You can copy and paste the URL into a new browser page to launch the application.




	
Note:

If you are using Microsoft Internet Explorer, you must select the parameterized URL and use the keyboard shortcut Ctrl+C to copy it. If you are using the Mozilla Firefox browser, select the parameterized URL by using the Right -click and copy option in the Alert window to copy it.








Figure 3-6 Parametertized URL Selection on Tools Menu

[image: Description of Figure 3-6 follows]









3.9 Working with Interface Features

The section provides an overview of interface features and discusses how to:

	
Use Online Documentation


	
Work with Error Messages and Error Dialog Boxes


	
Turn Auto Populate On or Off






3.9.1 Understanding Interface Features

EnterpriseOne contains features that you use to globally impact the EnterpriseOne web client interface.



3.9.1.1 Error Messages and Error Dialog Boxes

When you enter information into a field that is inaccurate or unrecognizable by JD Edwards EnterpriseOne, or if you fail to enter data into a required field, the field displays a red background to indicate the error, and an error message displays at the top of the form. If there are multiple errors on one form, they will display as a list at the top of the form. You can view more information about the error by clicking the arrow located to the left of the error message. If the error message has a Go To Error link to the right of it, you can click the link and JD Edwards EnterpriseOne will place your cursor in the field that correlates to the error message.

When you place your cursor in a field that contains an error, a dialog box displays that further identifies what you must enter into the field to correct the error. You can move the dialog box by clicking the top of it and dragging it to another location on the screen. You can tab out of the field to validate the information. After the information is validated, the error message is removed from the list. To view all the errors on the form listed at the top of the form, click Go to Top. To disable the pop-up dialog box, clear the Enable Error Pop-Ups check box at the top of the form.






3.9.1.2 Auto Populate On

AutoPopulate assists you when you are performing repetitive data entry on the grid control. It uses content that already exists in the grid column to populate the cell in which you are currently typing. If the characters you are typing match those that already exist in the same column, AutoPopulate automatically adds the whole string of characters from the existing cell to the current cell. For example, you have already entered the following number into a cell in the column in which you are currently typing: 330456 If you type a 3 in the current cell, AutoPopulate will automatically place 330456 in the cell in which you are working. You can opt to accept the number by pressing tab, or you can delete the number and enter one of your own. You can turn AutoPopulate on or off. The action you select will apply to all applications to which you have access within JD Edwards EnterpriseOne.

The feature is disabled for simplified Chinese, Korean, Japanese, and traditional Chinese language environments.








3.9.2 Using Online Documentation

Some tasks have documentation associated with them that you can view for information about how to perform a task.

To see the task documentation, click the triangle next to the task and select Documentation from the menu. A task might have multiple pages of documentation associated with it. If it does, two or more tabs appear at the top of the documentation frame. Click the different tabs to see all the documentation.

You access field-level help by placing the cursor is in a field and pressing F1 or by clicking the Item Help icon located at the top-right corner of a form. If the field in which the cursor resides is a business view column, the system displays the alias name, business view name and description, table name and description, and glossary text. If the field in which your cursor resides is a data dictionary column, the system displays the alias name, the term Data Dictionary Item, and the glossary text.






3.9.3 Working with Error Messages and Error Dialog Boxes

To view error messages and correct errors:

	
On the application on which you are working, if there are red fields indicating errors, scroll to the top of the form and review the error messages that are displayed.


	
If the error messages you are viewing contains a Go to Error link, click the link to go to the field that correlates to the error message.


	
Enter valid information into the field.


	
Tab out of the field, to ensure that the information you entered is correct or recognizable. If it is, the dialog box disappears, the field displays a white background, and the error message is removed from the list.









3.9.4 Turning Auto Populate On or Off

To turn Auto Populate On or Off, from the Tools menu, click AutoPopulate. If a check mark displays beside AutoPopulate, the feature is turned on. If no check mark displays, it is turned off.











4 Using JD Edwards EnterpriseOne Accessibility with JAWS Screen Reader Software

This chapter contains the following topics:

	
Section 4.1, "JD Edwards EnterpriseOne Web Client Accessibility Compliance"


	
Section 4.2, "JD Edwards EnterpriseOne Application Accessibility"


	
Section 4.3, "JD Edwards EnterpriseOne Menu Accessibility"


	
Section 4.4, "Data Browser Accessibility"






4.1 JD Edwards EnterpriseOne Web Client Accessibility Compliance

A single JAS server port serves for both the standard and visually impaired accessibility as opposed to a separate JAS server set up in LOW interactivity for visually impaired users. When the Accessibility mode is set to Yes in the User Profile Revisions application (P0092), the web client is rendered in LOW interactivity, irrespective of the jas.ini setting. All the extra tags with the relevant information are rendered so that they can be read by the screen reader software, JAWS.

The JD Edwards EnterpriseOne components that are accessible include:

	
JD Edwards EnterpriseOne application accessibility.


	
EnterpriseOne Menu accessibility.


	
Data Browser accessibility.









4.2 JD Edwards EnterpriseOne Application Accessibility

These components of JD Edwards EnterpriseOne applications are accessible through JAWS:

	
Forms in JD Edwards EnterpriseOne


	
Controls in JD Edwards EnterpriseOne


	
Hot Keys


	
HTML pages


	
Hyper Exit Menu


	
Processing Indicator






4.2.1 Forms in JD Edwards EnterpriseOne

The screen reader software, JAWS, reads the form title when a form initially loads.






4.2.2 Controls in JD Edwards EnterpriseOne

JAWS reads the names of the controls and the associated details when you navigate to the various form controls in the JD Edwards EnterpriseOne application.

This table lists the details read by JAWS when you navigate through the various form controls:


	Name of the Form Control	Details given by JAWS
	Edit	Reads the following details:
	
The text description of the associated label, when the edit control has an associated label.


	
Required field - when the edit control is a required field. • Errors and warnings when an error or warning is set on the edit control. The error details include information which indicates "Error on Control" or "Warning on Control," the error "No," and the cause and resolution for the error or warning.


	
Visual assist details when the edit control is associated with a visual assist. The visual assist details include information which indicates if the visual assist is a form interconnect, calendar, calculator or UTime.


	
The text for the associated description, when a value entered in the edit control has an associated description loaded onto the screen.


	
The value entered in the edit control.





	Push Button	Reads the title for the push button control. If a hot key is defined for the push button control, JAWS reads the hot key information within parenthesis.
	Check Box	Reads the text description of the label associated with the check box control.
	Radio Button	Reads the text description of the label associated with the radio button control. When you navigate to a radio button that is logically grouped inside a group box, JAWS reads the title for the Group Box (if any) and then the text description of the label associated with the radio button.
	Combo Box	Reads the text description of the label associated with the combo box control. When you navigate through the list of items in the combo box, JAWS reads the text description for each item.
	Static Text	Reads the text description of the associated static text control.
	Image	Reads the text description of the ALT associated with the image control.
	Text Block	Reads the text description for the segment associated with the text block control.
	Saved Query	Reads the following details:
	
Select a Query - if you navigate to the Select a Query combo box.


	
Save Query - if you navigate to the Save Query link.


	
Edit Queries - if you navigate to the Edit Queries link.




Note: When you navigate through the list of queries in the Select a Query combo box, JAWS reads the text description for each query.


	Text Search	Reads the following details:
	
Keywords - if you navigate to the Keywords Edit Box.


	
Case sensitive - if you navigate to the Case Sensitive check box.


	
Include Similar Words - if you navigate to the Include Similar Words check box.





	Tab Control	Reads the following details:
	
Active Tab and then the name of the tab page if you navigate to the currently active Tab page. For example if the Versions tab is the currently active tab, JAWS reads it as Active Tab: Versions.


	
Tab and then the name of the tab page if you navigate to the currently inactive Tab page. For example when you navigate to the Process tab that is inactive, JAWS reads it as Tab: Process.




Note: When the Tab pages are displayed as links, you can navigate to the Tab Page links using the JAWS links list window.








Apart from the controls listed in this table, there are some additional controls in JD Edwards EnterpriseOne applications that are accessible through JAWS.

The other controls include:

	
Calendar control


	
Grid control


	
Parent Child control


	
Tree control




Calendar Control

JAWS reads the associated details when you navigate to the calendar controls in the JD Edwards EnterpriseOne application.

This table lists the details read by JAWS when you navigate to the various calendar controls:


	Navigation Path	Details given by JAWS
	Day tab	Reads as Active Tab: Day (Ctrl + Alt + D), when the Day tab is the currently active tab.
	Week tab	Reads as Tab: Week (Ctrl +Alt +W).
	Month tab	Reads as Tab: Month (Ctrl +Alt +M).
	Add Activity button	Reads as Add Activity (Ctrl +Alt A).
	Previous link/image on the Calendar control	Reads as:
	
Previous Day (Ctrl + Alt + LeftArrow), when the Day tab is the currently active tab.


	
Previous Week (Ctrl + Alt + LeftArrow), when the Week tab is the currently active tab.


	
Previous Month (Ctrl + Alt + LeftArrow), when the Month tab is the currently active tab.





	Next link/image	Reads as:
	
Next Day (Ctrl + Alt + RightArrow), when the Day tab is the currently active tab.


	
Next Week (Ctrl + Alt + RightArrow), when the Week tab is the currently active tab.


	
Next Month (Ctrl + Alt + RightArrow), when the Month tab is the currently active tab.





	Link for an activity added	Reads the text describing the activity details.
	Calendar icon for an activity	Reads as Calendar Icon.
	Previous image	Reads as Previous (Ctrl + Alt + LeftArrow): Month Year. For example, for a Previous image on the Reference calendar for month of June, 2007, JAWS reads it as Previous (Ctrl + Alt + LeftArrow): June 2007.
	Next image	Reads as Next (Ctrl + Alt + RightArrow): Month Year. For example, for a Next image on the Reference calendar for month of June, 2007, JAWS reads it as Next (Ctrl + Alt + RightArrow): June 2007.
	Calendar Week Drill image	Reads as Calendar Week Drill: Week No Month Year. For example, for a Calendar Week Drill image referring to the first week of month of June, 2007 on the Reference calendar, JAWS reads it as "Calendar Week Drill: Week 1. June 2007."
Note: The Week No can vary from 1 to 5, depending on the week the Calendar Week Drill image refers to.


	Day link	Reads the date, month, and the year details. For example, for the day link for 28 June 2007, JAWS reads it as 28 June 2007.









	
Note:

For a tab that is currently active, the prefix is set as "Active Tab" while for the other tabs the prefix is set as "Tab."







Grid Control

The screen reader software, JAWS, reads the associated details when you navigate through the grid in the JD Edwards EnterpriseOne application.

The grid control is accessible as a table.

The QBE row and the column header row constitute of one table with the QBE row being the first row and the column header row being the second row. When you navigate to the table for the QBE row, JAWS reads the name for the grid (same as the form title) and then QBE Row. For example, for the QBE row table in the Work with Addresses Grid in the P01012 application, JAWS reads it as "Work with Addresses. QBE Row."

Each data row is rendered as a separate table, with the Column Header row being the first row and the actual data row being the second row. When you navigate to the table for the data row, JAWS reads the name for the Grid (same as the Form Title) and then the specific Row No. For example, for the third data row table in the Work with Addresses Grid in the P01012 application, JAWS reads it as "Work with Addresses Grid. Row 3."

This table lists the details read by JAWS when you navigate through the grid:


	Navigation Path	Details given by JAWS
	QBE edit field in a QBE row	Reads the following details:
	
The text description of the label for the QBE edit field which is actually the corresponding column's header and then the text QBE. For example, for the Address Number QBE field, JAWS reads it as Address Number QBE.


	
The visual assist details, when the QBE edit field is associated with a visual assist. The visual assist details include information which indicates if the visual assist is a form interconnect, calendar, calculator or UTime.





	Cells in a data row	Reads the corresponding column header text and then the contents of the current cell.
	Grid cell set with a special color	Reads as Special Setting and then the corresponding color information. For example, when you navigate to a grid cell set with a color called magenta, JAWS reads Special Setting: Color is Magenta along with all the other details.
	Grid cell set with a special font	Reads as Special Setting and then the corresponding font information. When you navigate to a grid cell set with a special font, JAWS reads as Special Setting: Font is Broadway. Font Style is Italic. Text Decoration is Underline. Font Weight is Bold, where broadway is the font name, italic is the font style, underline is the text decoration, and bold is the font weight.
	Row selector check box cell in a data row	Reads as Checkbox checked or not checked and then reads the Row No.
	Paper clip image	Reads Attachment or NoAttachment, when you navigate to a paper clip image for Attachment in the Click to search for the Attachments cell.
	Next image	Reads as Next and then the name for the grid (same as the Form Title) as a suffix. Hence, if there is more than one grid on the form, you can clearly identify the grid to which the Next image belongs. For example, the Next image on the Work with Addresses grid, JAWS reads as Next: Work with Addresses.
	Previous image	Reads as Previous and then reads the name of the grid as a suffix.
	Customize Grid link	Reads as Customize Grid and then the name of the grid as a suffix.
	Grid formats combo box	Reads as Grid Column Display and then the name of the grid as a suffix.
	image for Export Grid Data	Reads as Export Grid Data (Ctrl +Shift + E) and then the name of the grid as a suffix.
	image for Import Grid Data	Reads as Import Grid Data (Ctrl +Shift + I) and then the name of the grid as a suffix.
	Maximize Grid	Reads as Maximize Grid (Alt + R) and then the name of the grid as a suffix.
	Restore Grid	Reads as Restore Grid (Alt + R) and then the name of the grid as a suffix.









	
Note:

The name for the grid is added as a suffix for all the links and images on the grid control to enable you to clearly identify the grid to which the link or image belongs to if there is more than one grid on the form.
You must install a JAWS script to enable you to move up and down in a column in a grid. You can use the key strokes Windows + N to move down the column and Windows + Shift + n to move up the column.









This table lists the details read by JAWS when you navigate to the grid cells:


	Navigation Path	Details given by JAWS
	Check Box	When you navigate to a grid cell that has its display style set to check box, JAWS reads the corresponding Column Header text and then Check Box checked or unchecked.
	Combo Box	When you navigate to a grid cell that has its display style set to combo box, JAWS reads the corresponding Column Header text and then the text description of the item selected in the combo box cell.
	Edit Box	When you navigate to a grid cell that has its display style set to edit box, JAWS reads the following information:
	
The corresponding column header text.


	
The value of the current cell.


	
The error or warning details when an error or warning is set on the editable cell. The error details include information which indicates "Error on Cell" or "Warning on Cell", the error or warning description, and the cause and resolution for the error or warning.


	
The visual assist details when the editable cell is associated with a visual assist. The visual assist details include information which indicates if the visual assist is a form interconnect, calendar, calculator or UTime.





	Icon	When you navigate to a grid cell that has its display style set to icon, JAWS reads this information:
	
The corresponding column header text.


	
The value of the current cell.


	
The ALT details of the <IMG> element corresponding to the icon.





	Clickable Text	When you navigate to a grid cell that has its display style set to clickable text, JAWS reads the corresponding column header text and then the data content of the current cell.






Tree Control

The screen reader software, JAWS, reads the associated details when you navigate to the various tree controls in the JD Edwards EnterpriseOne application.

The tree control is accessible as a table, where the first row in the table is the header row consisting of two columns with the headers set as:

	
Row Selector


	
Tree Node Text




This table lists the details read by JAWS when you navigate to the Row Selector radio button in the tree control:


	Name of the Node	Details given by the JAWS
	Root Node (collapsed)	Reads it as Tree Row Selector for Root Node, the value in the cell, and Collapsed.
	Root Node (expanded)	Reads it as Tree Row Selector for Root Node, the value in the cell and Expanded.
	Child Node at Level N (sibling collapsed)	Reads it as Tree Row Selector for Child Node at Level N with Sibling, the value in the cell, and Collapsed.
	Child Node at Level N (sibling expanded)	Reads it as Tree Row Selector for Child Node at Level N with Sibling, the value in the cell, and Expanded.
	Child Node at Level N (without sibling collapsed)	Reads it as Tree Row Selector for Child Node at Level N without Sibling, the value in the cell, and Collapsed.
	Child Node at Level N (without sibling expanded)	Reads it as Tree Row Selector for Child Node at Level N without Sibling, the value in the cell, and Expanded.
	Leaf Node (with sibling at Level N)	Reads it as Tree Row Selector for Leaf Node with sibling: Level N and then the value in the cell.
	Leaf Node (without sibling at Level N)	Reads it as Tree Row Selector for Leaf Node without sibling: Level N and then the value in the cell.






This table lists the details read by JAWS when you navigate to TreeNodeCell in the tree control:


	Name of the Node	Details given by JAWS
	Root Node (collapsed)	Reads it as Root Node, the value in the cell, and collapsed.
	Root Node (expanded)	Reads it as Root Node, the value in the cell and expanded.
	Child Node at Level N (sibling collapsed)	Reads it as Child Node at Level N with Sibling, the value in the cell, and Collapsed. To expand use (Ctrl + Shift + Right Arrow).
	Child Node at Level N (sibling expanded)	Reads it as Child Node at Level N with Sibling, the value in the cell, and Expanded. To collapse use (Ctrl + Shift + Left Arrow).
	Child Node at Level N (without sibling collapsed)	Reads it as Child Node at Level N without Sibling, the value in the cell, and Collapsed. To expand use (Ctrl + Shift + Right Arrow).
	Child Node at Level N (without sibling expanded)	Reads it as Child Node at Level N without Sibling, the value in the cell, and Expanded. To collapse use (Ctrl + Shift + Left Arrow).
	Leaf Node (with sibling at Level N)	Reads it as Leaf Node with sibling: Level N: and then the value in the cell.
	Leaf Node (without sibling at Level N)	Reads it as Leaf Node without sibling: Level N and then the value in the cell.






When you navigate to a TreeNodeCell of text type that is set with a special bitmap, along with the other details, JAWS reads Special Setting for Node and the corresponding name of the image. For example, when you navigate to a TreeNodeCell that is set with a special bitmap called Group, along with all the other details, JAWS reads it as Special Setting For Node:Group.






4.2.3 Hot Keys

When you navigate to a button, image, or icon in the hyper exit menus, EnterpriseOne Menu, grid, calendar or the tree controls where an EnterpriseOne hotkey is defined, JAWS reads the hotkey information within parenthesis.






4.2.4 HTML Pages

HTML pages in JD Edwards EnterpriseOne applications are accessible through JAWS. These HTML pages include:

	
About Page


	
Data Sequencing Page


	
Data Selection Page


	
Edit Query Page


	
EnterpriseOne Login Page


	
Environment Roles Page


	
File Upload Page


	
File Download Page


	
Hot Key Reference Page


	
In Your Face Error Page


	
Literal Prompt Page


	
Item Help Page


	
Processing Options Page


	
Save Query Page




About page

The application, form, and other information in the About page are accessible as Static Text. The screen reader software, JAWS reads the application, form, and other information as you navigate through the page.

Data Selection Page

When you navigate through the data selection in the Data Selection page, the screen reader software reads these details:


	Navigation Path	Details given by the JAWSDetails given by the JAWS
	Header Row	Reads the five header columns in the heard row as Row Selector, Operator, Left Operator, Comparison, and Right Operand.
	Cells	Reads the corresponding column header text and then the contents of the current cell. For example, when you navigate to the left operand combo box, JAWS reads the column header Left Operand and reads the label for the combo box as left operand. Also, if you select a value in the combo box, JAWS reads the details of the selected value.
	Add Link Row	Reads as Add Row.
	Advanced Link	Reads as Advanced.






Data Sequencing Page

When you navigate through the Sequenced Columns in the Data Sequencing page, the screen reader software reads the following details:


	Navigation Path	Details given by the JAWS
	Header Row	Reads the six header columns in the heard row as Row Selector, Column Sort Order, Page Break, Data Item and Table.
	Cells	Reads the corresponding column header text and then the contents of the current cell. For example, when you navigate to the Row Selector check box cell, JAWS reads the column header "Row Selector" and reads the label for the combo box as Row Selected for the Company.
	Ascending/Descending link in the Sort Order cell	Reads the corresponding column header text Sort Order and then Ascending or Descending for the link graphic.
Note: The Ascending and Descending link graphic can be activated using spacebar.


	Page Break Toggle link in the "Page Break" cell	Reads the corresponding column header text Page Break and then Page Break Toggle for the link graphic.
Note: The Page Break Toggle link graphic can be toggled using spacebar.


	Show Available Columns link	Reads as Show Available Columns.






If you activate the Show Available Columns link and navigate through the Available Columns table, then JAWS reads these details.


	Elements of the table	Details given by JAWS
	Header Row	Reads the four header columns in the heard row as Row Selector, Column, Data Item, and Table.
	Cell	Reads the corresponding column header text and then the contents of the current cell. For example, when you navigate to the Row Selector checkbox cell for the Address Number column, JAWS reads the corresponding column header text Row Selector, and the label for check box as Row Selector For Address Number.






Edit Query Page

The screen reader software, JAWS, reads the associated details when you navigate to the Edit Queries link in the Saved Query control on the Edit Queries page.

This table lists the details read by JAWS when you navigate to the Edit Queries link on the In the Edit Queries page:


	Navigation Path	Details given by the JAWS
	Editable Saved Queries combo box	Reads as Editable Saved Queries. When you navigate through the list of editable saved queries, JAWS reads the text description for each saved query.
	Edit button	Reads as Edit.
	Delete button	Reads as Delete.
	Cancel button	Reads as Cancel.






EnterpriseOne Login Page

When you navigate through the web client JD Edwards EnterpriseOne login page, JAWS reads these details:


	Navigation Path	Details given by the JAWS
	Input fields	Reads the text description for the label associated with the input fields and the value entered.
	Details link	Reads as Details.
	Sign In button	Reads as Sign In.
	Input fields	Reads the text description for the label associated with the input fields and the value entered.






When you enter an incorrect User ID or password in the User ID edit field, JAWS reads it as Sign in Error. Incorrect User ID or Password. User ID provided the sign in error set in the web client login page.

Environment Roles Page

JAWS reads the associated details when you navigate to the environment and roles page in the JD Edwards EnterpriseOne application.

This table lists the details read by JAWS when you navigate to the environment and roles page:


	Navigation Path	Details given by the JAWS
	Environment radio button	Reads the corresponding environment name.
	Role combo box	Reads as Role for and the corresponding environment name.
	Role combo box	Reads the Text corresponding to the selected role.
	OK button	Reads as OK.






File Upload Page

The screen reader software, JAWS, reads the associated details when you navigate to the File Upload Page in the JD Edwards EnterpriseOne application.

This table lists the details read by JAWS when you navigate to the File Upload Page:


	Navigation Path	Details given by the JAWS
	File Upload edit	Reads as Please specify a file to upload. File Upload Edit. Browse". Here Browse refers to the Browse button that appears next to the File Upload Edit and is used to select the file to upload.
	Browse button	Reads as Browse when you navigate to the File Upload edit. However, JAWS does not read the text for the Browse button. This is a known issue with JAWS and form input fields that use type="file" (<input type=file>) to automatically create a Browse button to select a file to upload.
	Load button	Reads as Load.
	Cancel button	Reads as Cancel.






When you launch the Select a Form field window of JAWS, both the File Upload browse buttons are listed as "Please specify a file to Upload Edit/Button." When you select and navigate to the Browse button, JAWS reads as Browse. When you activate the Browse button, select the File to upload and then navigate to the File Upload Edit, JAWS does not read the value in the edit that is the location and the name of the file selected. This is a known issue with JAWS.

When you launch the Select a Button window of JAWS, the Browse button is listed as "Please specify a file to Upload." When you select and navigate to the Browse button, JAWS reads it as Browse.

When you navigate to the Browse button using the "B" key and the Forms mode set to off, JAWS reads it as Browse.

File Download Page

The screen reader software, JAWS, reads the associated details when you navigate to the File Download Page in the JD Edwards EnterpriseOne application.

This table lists the details read by JAWS when you navigate to the File Download Page:


	Navigation Path	Details given by the JAWS
	Download link	Reads as Download.
	Close button	Reads as Close.






Hot Key Reference Page

The screen reader software, JAWS, reads the associated details when you navigate to the Hot Keys Reference page in the JD Edwards EnterpriseOne application.

This table lists the details read by JAWS when you navigate to the Hot Keys Reference page:


	Navigation Path	Details given by the JAWS
	Different Hot Key sections	Reads the six hotkey tables as on the page as Overall Navigation HotKeys, EnterpriseOne Menu Hotkeys, Grid HotKeys, Tree HotKeys, Calendar HotKeys, Button HotKeys and Spell Checker HotKeys.
	First row in each HotKey	When you navigate through the first row in each Hotkey table which consists of two header columns, JAWS reads it as Hot Key and Description.
	Cells of the HotKey tables	Reads the corresponding column header text and then the contents of the current cell. For example, when you navigate to the hotkey cell TAB in the Overall Navigation HotKeys table, JAWS reads as HotKey and then TAB.






In Your Face Error Page

When you enter an invalid value in any control in the JD Edwards EnterpriseOne form, the In Your Faces Error (IYFE) page is displayed. Certain controls are set with errors that enables you to identify the errors occurred in that form. The error page is displayed irrespective of the .ini setting or application override, provided you set the accessibility mode to Yes.

The elements of the IYFE page are accessible as links using the JAWS link list window.

This table lists the details read by JAWS when you navigate through the In Your Face Error page.


	Navigation Path	Details given by the JAWS
	Error link	Reads as Error.
	Error description link	Reads the description of the error.
	Error cause and resolution link	Reads the cause and resolution details for the error.
	Go to error link	Reads as Go To Error. Also, JAWS reads the error details when the Go To error link is activated as the focus is set on the control with the errors.
	Image for collapsing or expanding the IYFE page	Reads as Collapse or Expand Errors.
	Error or Warning summary link	Reads as This form has X Errors, X Warnings, where "X" indicates the number of errors or warnings.
	Enable error pop-ups checkbox	Reads as Enable Error Pop-ups.






Item Help Page

The item information in the Item Help page is accessible as Static text. The screen reader software JAWS reads the details of the selected item in the Item Help page.

Literal Prompt page

JAWS reads the associated details when you navigate to the Literal Prompt page in the JD Edwards EnterpriseOne application. The tab pages in the Literal Prompt page are accessible as links using the JAWS links list window.

This table below that lists the details read by JAWS when you navigate to the environment and roles page:


	Navigation Path	Details given by the JAWS
	Currently active tab page	Reads as Active Tab for the Tab page that is currently active and then the tab page name. For example, if the Single Value tab is the currently active tab page, JAWS reads it as Active Tab: Single Value.
	Inactive tab page	Reads as Tab for the Tab page that is currently inactive and then the tab page name. For example, when you navigate to the Range of Values tab page that is inactive, JAWS reads it as Tab: Range of Values.






Processing Options Page

When the Tab pages are displayed as links in the Processing Option page, you can navigate to the Tab Page links using the JAWS links list window.

This table lists the details read by JAWS when you navigate to the Tab Page links:


	Elements of Tab Pages	Details given by JAWS
	Currently active tab	Reads as Active Tab and then the name of the tab page. For example if the Versions tab is the currently active tab, JAWS reads it as Active Tab: Versions.
	Currently inactive tab	Reads as Tab and then the name of the tab page. For example when you navigate to the Process tab that is inactive, JAWS reads it as Tab: Process.
	Text field	Reads the text description of the label corresponding to the text field, then Possible Values Are followed by the actual list of values. Also, JAWS reads the visual assist details (if any) and the pre – existing values (if any) for the text field.






Save Query Page

The screen reader software, JAWS, reads the associated details when you navigate to the Save Query link in the Saved Query control on the In the Save Query page.

This table lists the details read by JAWS when you navigate to the Save Query link on the Save Query page:


	Navigation Path	Details given by the JAWS
	Saved Query Name edit	Reads as Saved Query Name.
	More Options link	Reads More Options.
	Comparison Type Combo box	Reads the corresponding Label of the combo box and Comparison Type. For example, for the Comparison Type Combo box for Address Number, JAWS reads it as Address Number Comparison Type.
	Standard value radio button	Reads as Standard Value for and the corresponding name of the option. For example, for the Standard value radio button for Address Number, JAWS reads it as Standard Value for Address Number.
	Standard value edit box	Reads as Standard Value Text for and the corresponding name of the option. For example, for the Standard value edit box for Address Number, JAWS reads it as "Standard Value Text for Address Number."
	Special value radio button	Reads as Special Value for and the corresponding option's name and finally the Label associated with the radio button. For example, for a Special value radio button for Address Number that has the associated label as Current User's Address Book number, JAWS reads it as Special Value for Address Number Current User's Address Book number.
	Save button	Reads as Save.










4.2.5 Hyper Exit Menus

When you navigate to a hyper exit menu, JAWS reads the name of the hyper exit menu. If the hyper exit menu has a hot key defined, then JAWS reads the hot key information within parenthesis.

When you navigate to a hyper exit menu that has sub menus or items under using the JAWS links list window, JAWS reads the name of the hyper exit menu and then the text corresponding to the menu item or sub menu. For example, when you navigate to the Refresh menu item under the Tools menu, JAWS reads it as Tools: Refresh.

Navigation between the Hyper Exit Menu Items

You can navigate between the hyper exit menu items using the Up and Down arrow keys.

To navigate between the hyper exit menu items or a hyper exit menu that has sub menus, you must use the Up and Down arrow keys. When you use the Down arrow key for the first time, the JAWS reads it as hyper exit menu has a sub menu. When you use the Down arrow key for the second time, the focus moves to the graphic item that is used for the layout. You must press the Enter key to display the sub menu. When you use the Down arrow key for the third time, the focus moves to the blank graphic that is used for the layout. Now, when you use the Next arrow key, the focus moves to the actual hyper exit menu item and the JAWS reads the text corresponding to the menu item.






4.2.6 Processing Indicator

When you fast path to an application from the JD Edwards EnterpriseOne Menu and if the application is not yet loaded onto the screen, then the Processing Indicator text conveys the message "Opening Application. You may continue working while the application loads." When you navigate through the Processing Indicator page, JAWS reads the static text of the page.




	
Note:

The Processing Indicator text is accessible only until the application is loaded onto the screen.














4.3 JD Edwards EnterpriseOne Menu Accessibility

The screen reader software, JAWS, reads the names of the nodes or links and the associated details when you navigate through the JD Edwards EnterpriseOne Menu. All the JD Edwards EnterpriseOne menu nodes are accessible as links using the JAWS links list window.

This table lists the details read by JAWS for the corresponding nodes or links when you navigate through the JD Edwards EnterpriseOne Menu:


	Navigation Path	Details given by the JAWS
	Link for Root Node	Reads the node name, the status of the node as Collapsed or Expanded, and then E1 Menu Root Node.
	Link for Child Node	Reads the node name, the status of the node as Collapsed or Expanded, and then E1 Menu Child Node.
	Link for the Application task	Reads the names of the task, application, form, version and then the E1 Menu Application Task.
	Link for the Report task	Reads the names of the task, application, form, version and then E1 Menu Report Task.
	Link for the URL task	Reads the task name and then URL Is followed by the URL name. For example, when you navigate to an URL task link called "Test URL" that refers to the URL – http://www.yahoo.com , JAWS reads as "Test URL. E1 Menu URL Task. URL Is http://www.yahoo.com".
	Link for a Crystal Report task	Reads the task name, the crystal report information, and then E1 Menu Crystal Report Task.
	Link for a Flyout task	Reads the task name and then E1 Menu Flyout. For example, when you navigate to the Flyout link for the Favorites task, JAWS reads Favorites. E1 Menu Flyout.
	Link for an Action task	Reads the Action name followed by E1 Menu Action. For example, when you navigate to the My System Options action link, JAWS reads My System Options. Application: P0085 Form: W0085N. E1 Menu Action.
	Link for Roles combo box	Reads as E1 Menu Roles.
	Link for Checkbox in the Preferences section	Reads as Minimize menu on app launch. E1 Menu Preferences.
	Link for an Open Application	Reads the Application name, the number "N" which indicates that it is the Nth application that has been launched and finally E1 Menu Open Application. For Example, when you navigate to the "Work with Addresses" Open Application link, JAWS reads Work with Addresses (1). E1 Menu Open Application, where (1) indicates that "Work with Addresses" was the first application to be launched.









	
Note:

When you activate a Flyout link for a task and then navigate to a specific Flyout Item link under the Flyout, JAWS first reads the name of the Flyout Item and then "E1 Menu Flyout Item For" followed by the task name. For example, when you Activate the Flyout link for the "Favorites" task and then navigate to the Flyout Item "Documentation", JAWS reads "Documentation. E1 Menu Flyout Item for Favorites."












4.4 Data Browser Accessibility

The screen reader software, JAWS, reads the names of the fields and the associated details when you navigate through the Query Selector page.

This table lists the details read by JAWS for the corresponding fields when you navigate through the Query Selector page:


	Navigation Path	Details given by the JAWS
	Personal Queries radio button	Reads as Personal queries.
	Select a Personal Query combo box	Reads the label for the combo box as Queries you have created and then the text for the selected query.
	Public Queries radio button	Reads as Public queries.
	Select a Public Query combo box	Reads the label for the combo box as Queries you have created and then the text for the selected query.
	By Table radio button	Reads as By Table. JAWS also helps you to search and select tables.
	Name Edit field to enter table name	Reads the label for the edit field as Table Name and then the visual assist details, the associated description details (if any) and the pre – existing value (if any).
	By Business View radio button	Reads as By Business Views. JAWS also helps you to search and select business view.
	Name Edit field to enter a business view	Reads the label for the edit field as Business View Name and then the visual assist details, the associated description details (if any) and the preexisting value (if any).
	Data Source Edit field to enter the data source name	Reads the label for the edit field as Data Source and then the visual assist details and the preexisting value (if any).













5 Using JD Edwards Web Applications and Reports

This chapter contains the following topics:

	
Section 5.1, "Launching Applications and Reports"


	
Section 5.2, "Working with Search Criteria"


	
Section 5.3, "Viewing the Data in Tables and Business Views"


	
Section 5.4, "Recovering Data"


	
Section 5.5, "Working with Tasks, User Options, and the Calendar"







	
Note:

If you are not using Internet Explorer as your browser, you might not have access to some of the functionality mentioned in this chapter.









5.1 Launching Applications and Reports

This section provides an overview of how to launch an application or report and discusses how to:

	
Launch an application or report.


	
Launch Applications in Separate Windows


	
Send a Shortcut to an application form.






5.1.1 Understanding How to Launch an Application or Report

JD Edwards provides a variety of applications, reports, and other objects. Typically, you access these objects from the EnterpriseOne Menu.






5.1.2 Launching an Application or Report

Access EnterpriseOne Menu.

	
In EnterpriseOne Menu, navigate to the application or report you want to launch.


	
To launch the application or report without defining processing options, version, and so forth, double-click the report or application.

Applications launch immediately. If you launch a report the system launches Work with Batch Versions so you can select which version you want to run.


	
To select processing options or version for an application, click the arrow next to the task and select Values or Versions, respectively.

After you select the processing options or version, the system launches the application. Depending on how your system administrator configured the system, the application can be launched either in the existing window or in a new one. If the system is configured for multiple browser windows, you can hold down the CTRL key when you press Enter to launch the application in a new window. Either way, you can run multiple applications simultaneously. All applications you have running are listed in the EnterpriseOne Menu toward the top, under Open Applications. You can switch among them by clicking the application you want in the list.


	
To select processing options or version or to designate data selection parameters for a report, click the arrow next to the task and select one of these options:

	
Values


	
Versions


	
Data Selection


	
Data Selection & Values

After you set the options, the system might launch Work with Batch Versions so you can select which version you want to run. Then, Version Prompting appears. Select the prompting you want and click Submit to select a printer and process the report.












5.1.3 Launching Applications in Separate Windows

When you open more than one application, you can select to have the application launch in the existing window, or in a new window. If you select to have it launch in the existing window, JD Edwards EnterpriseOne replaces the application on which you are currently working with the application that you have just launched. If you select to launch additional applications in new windows, then each application appears and is fully functional in its own window. Each open application is listed in the menu area of each window.

To launch applications in new windows:

	
Open an application.


	
Click New Window on the menu area.

A new browser window will be opened, which also contains the menu area. You can launch any application in this new browser window.









5.1.4 Viewing Report Output

Access EnterpriseOne Menu.

Before you can view the output of your reports online, you must run a report version.

	
In EnterpriseOne Menu, click My System Options.


	
On User Default Revisions, click Submitted Reports.


	
On Work with Servers, select the server on which the report was run.


	
Click Select.


	
On Submitted Job Search, select the report you want to view.


	
From the Row menu, click View PDF.

The report displays in read-only, PDF format.

To view report data on pages other than the one currently displayed, type a page number in the field located at the bottom of the PDF viewer.

JD Edwards EnterpriseOne contains a feature called Page at a Time PDF that assists in downloading large files quickly. If your system administrator has enabled this feature, you should immediately see the first page of the PDF file. If Page at a Time is not enabled, you will see a blank screen in the PDF viewer while the file downloads. If this is the case, contact your system administrator.









5.1.5 Changing your Password

Access EnterpriseOne Menu.

	
In EnterpriseOne Menu, click User Options.


	
On User Default Revisions, click Change Password.


	
On User Password Revisions, complete the following fields and click OK:

	
Old Password


	
New Password


	
New Password - Verify












5.1.6 Sending a Shortcut to an Application Form

While you are working in the JD Edwards EnterpriseOne web client, you can email other users a shortcut to the application and form that you are looking at. The recipient double-clicks the shortcut in the email to access your current position in the software.

To send a shortcut to an application form:

	
Launch a Web application and access the form that you want to send.


	
Click Tools and select Send Shortcut.


	
On Send Shortcut, complete these fields:

	
Address Number / User / Role / Distribution List




	
Note:

If you are sending a shortcut to members of a distribution list, you must click the Distribution List option and then select the address book number of the distribution list. If you enter the distribution-list address-book number without choosing the Distribution List option, the shortcut will be sent only to the distribution-list address-book number and not to the members of the distribution list.








	
Mail Box

Select which mailbox/queue you want the message to be sent to.


	
Subject

Type the text that you want to appear in the Subject line of the email message.





	
If you want to include a message with the shortcut, type it in the large field at the bottom of the form.


	
Click OK to send the shortcut.

The recipient will receive the shortcut using an email in the Work Center or a third-party email system, depending on the recipient's email preferences in JD Edwards EnterpriseOne.











5.2 Working with Search Criteria

This section provides an overview of search criteria and discusses how to:

	
Save search criteria


	
Apply saved search criteria


	
Edit search criteria


	
Delete search criteria






5.2.1 Understanding Search Criteria

You can create search criteria using the QBE and wildcard features, then save that criteria for use later. Save search criteria that you use often to find records. Your ability to save search criteria depends on how the application has been designed. The search criteria that you save is available to you only; no other user can access it.

After you have saved search criteria using the Save Query option, you can apply the criteria to your current search.






5.2.2 Saving Search Criteria

Access a form that contains the Save Query option.

	
Enter your search criteria in the fields and then click Save Query.


	
On Save Query, in the Saved Query Name field, type a name for the saved search criteria.


	
Click the More Options link to enter more search criteria to further narrow your search. The information that is listed as more options is determined by how the application has been designed.


	
Click Save.









5.2.3 Applying Saved Search Criteria

To apply criteria to your current search:

	
Access the form where you saved your search criteria.


	
From the Select a Query field, select the query that contains the search criteria you want to apply.

JD Edwards EnterpriseOne applies the search criteria to the current form.









5.2.4 Editing Search Criteria

Access the form where you saved your search criteria.

	
Click Edit Queries.


	
Select the query you want to edit.


	
Edit the information.









5.2.5 Deleting Search Criteria

Access the form where you saved your search criteria.

	
Click Edit Queries.


	
Select the query you want delete, and click Delete.











5.3 Viewing the Data in Tables and Business Views

The section provides an overview of Data Browser and discusses how to:

	
Access Data Browser.


	
Search for data in tables.


	
Search for data in business views.


	
Use existing queries to search for data in tables and business views.






5.3.1 Understanding Data Browser

If you want to view the data in tables and business views, you can use Data Browser. This tool enables you to verify the existence of data in a table or business view, as well as to determine the table or business view structure. This section provides an overview about the EnterpriseOne Menu, and discusses how to:

	
Access Data Browser.


	
Use existing queries to search for data.


	
Search for data in tables.


	
Search for data in business views.


	
Create personal search queries for data in tables and business views.









5.3.2 Accessing Data Browser

Type databrowser in the Fast Path. If you type databrowser in the Fast Path, the Query Selector form displays. If you are in an application, you can access the Data Browser by clicking the Tools menu, and then clicking Data Browser. If you access the Data Browser from an application, the Query Selector and the Data Browser forms display. The Query Selector form enables you to select queries, tables, or business views to search for data. The Data Browser form enables you to search for data for a specific table or business view. When you access Data Browser from an application, the only tables and business views on which you can search are those that correspond to the application you are in.






5.3.3 Searching for Data in Tables

Access the Data Browser.

	
Type databrowser in the Fast Path.


	
Select the By Table option.


	
In the Name field located under the By Table option, type the name of the table on which you want to search, or use the search button to locate a table.


	
Press Tab.

The Data Source field automatically displays the name of the data source in which the table resides for the environment in which you are currently logged.


	
In the Data Source field, if the data source that is displayed is different than the one from which you want to search, type a new data source, or use the search button to locate a data source.


	
Click OK.









5.3.4 Searching for Data in Business Views

Access the Data Browser.

	
Type databrowser in the Fast Path.


	
Select the By Business View option.


	
In the Name field, type the name of the business view on which you want to search, or use the search button to locate a business view.


	
Click OK.









5.3.5 Using Existing Queries to Search for Data in Tables and Business Views

Access the Data Browser.

	
Select the Personal Queries or Public Queries option.

The Personal Queries option enables you to select from a drop-down menu queries you have created for yourself. The Public Queries option enables you to choose from a drop-down menu queries that have been made available to you by a system administrator.


	
From the drop-down menu located next to the option you selected, select the query on which you want to search.


	
Click OK.









5.3.6 Creating Personal Search Queries to Search for Data in Tables and Business Views

Access the Data Browser.

	
Follow the instructions for Searching for Data in Tables or Searching for Data in Business Views.


	
On Data Browser, enter any filter information you want included in the query.


	
Click Save Query.


	
Click Close.

The query is saved and displays in the Personal Queries drop-down menu.











5.4 Recovering Data

This section provides an overview of how to recover data and discusses how to:

	
Retrieve all records from the database


	
Voluntarily save data


	
Retrieve data


	
View data






5.4.1 Understanding how to Recover Data

You use JD Edwards EnterpriseOne web client to recover data from applications that have erred or timed out due to:

	
Catastrophic errors


	
Transaction failures


	
Session time outs


	
Voluntary save




Data saved from system failures are saved at the time when the system errors, failures, or time outs occur. The P95400 program (Application Failure Recovery Applications) enables you to access and recover data from any transaction from which you have saved data. Using P95400, you can view the data from failed transactions. You must be granted permission by an administrator to view data from applications that are not your own. For example, an administrator might give a sales department supervisor the permission to recover data from transactions performed by other users in the department. If you are unable to save data, check with your system administrator.






5.4.2 Retrieving All Records from the Database

Fetch All Records enables you to retrieve all records from the database that match your search criteria. JD Edwards EnterpriseOne then categorizes the records into larger groups so that you are able to view several records by scrolling through the grid, rather than having to view only ten at a time. The default number of records in a group is 200.

To fetch all records, click the Go to End button located on the blue bar on the grid.






5.4.3 Voluntarily Saving Data

Your ability to save data voluntarily depends on whether or not your system administrator has this feature enabled or disabled. Access an application in which you have entered data.

	
Click Tools, then select one of these options:

Save

Save As


	
On Select Application Failure Header Label, select the check box if you want the JD Edwards EnterpriseOne to assign a label to the data you are saving. To manually enter a label and description, clear the box and enter a label and description in the respective fields.




	
Note:

The label is a name you assign the data, like a filename. The description is a brief explanation that helps you identify what the data is.








	
Click OK.

JD Edwards EnterpriseOne saves the data you have entered in the application.









5.4.4 Retrieving Data

The Failure Recovery Data and Application Saved Data links on the JD Edwards EnterpriseOne Menu opens the P95400 application.

Access the P95400 application.

	
On Work with Application Failure Records, search for data using these criteria:

From Saved Date and To Saved Date Type the dates between which the data for which you are searching was saved.

If you select one of the following options in addition to the dates you have entered in these fields, JD Edwards EnterpriseOne retrieves the data saved within the dates, and that matches the search criteria you specify.

View All

Click this option to view all of the data that was saved, including system failures, time outs, or voluntary saves.

View Failures

Click this option to view only that data that was saved due to system failure.

View Saves

Click this option to view only that data that was saved voluntarily.

View Timeouts

Click this option to view only that data that was saved because the system timed out.


	
Click Find.

JD Edwards EnterpriseOne retrieves the data that matches the search criteria you entered.


	
Click the record that contains the data you want to save.

On Saved Application Data, click the record or records containing the data you want to view.




	
Note:

Each record is a form within the application where data was saved. If no data was saved on the form, either because it was not saved voluntarily, or because there was no data added to it---as in a Search/Browse form---you will see an N in the Data Saved (Y/N) column.















5.4.5 Viewing Data

After you have retrieved data, you view the information contained in the records.

	
Retrieve the data you want to view.


	
Select a record from the bottom grid, and then click View Data.

The information contained in the record displays in a read-only format.











5.5 Working with Tasks, User Options, and the Calendar

The section discusses how to:

	
Filter tasks by role.


	
Use task profiles.


	
Work with user options.


	
Access the calendar.






5.5.1 Filtering Tasks by Role

You filter the tasks that you see by selecting a role. Each role contains its own set of tasks. When you log into JD Edwards EnterpriseOne using the *ALL role, you now see only those tasks associated with a single role rather than a concatenation of all tasks associated with all roles.

In the Web client, you view the other roles assigned to you by choosing the role from the Role drop-down menu located on EnterpriseOne Menu, and then clicking the button to the right of the field.

The tree view changes to show the tasks that are available to the role that you chose.






5.5.2 Using Task Profiles

For each task, you can view profile information about the task itself. To display the profile for a task, click the triangle to the right of the task and select Task Profile.

The Task Profiles window has three tabs: Basic, Intermediate, and Advanced. The information in the window varies based on the item currently selected. Some of the information on the tabs is described below:

	
Version resides on the Intermediate tab.


	
Object Name resides on the Intermediate tab.


	
Task ID resides on the Advanced tab. If you know an object's task ID, you can launch it directly from the Fast Path toolbar.









5.5.3 Working with User Options

When you click My System Options, the User Default Revisions form appears. The following list describes the associated action for each button on the User Default Revisions form:


	Button	Description
	User Profile Revisions	Launches the User Profile Revisions program (P0092). Only system administrators should change user profiles.
	Change Password	Launches the JD Edwards EnterpriseOne Security program (P98OWSEC), which you use to change your password.
	Submitted Reports	Launches the Work With Servers program (P986116), which you can use to review the status of a submitted report or job, change your report or job priority, work with the report output, and review errors.
	View Local Output	Accesses the PrintQueue directory on the machine that is running JD Edwards EnterpriseOne.
	Default Printer	Launches the Printer Application program (P98616). Only system administrators should change default printer settings.










5.5.4 Accessing the Calendar

The calendar enables you to enter and view time sensitive information, such has meetings and appointments. Depending on the permissions your system administrator has assigned you, you can view, add, delete, and modify activities listed in the calendar. You can view the calendar one day at a time, by the week, or by the month. Your system administrator determines the calendar view that you see.

This section discusses the default features and functionality that are available in the calendar. You might not see some of these features or might not be able to perform some functions due to your permissions. The default view for the calendar consists of one large calendar on the left with a Day tab, a Week tab, and a Month tab. Three small calendars are located on the right side. The first small calendar shows the month previous to the month displayed in the large calendar. The second calendar shows the month displayed in the large calendar. The third calendar shows the month following the month displayed in the large calendar. Today's date is highlighted in a yellow box in the appropriate small calendar.

The large calendar and the three small calendars are fully interactive. Clicking in any calendar automatically adjusts the other calendars. For example, if you select a week in the large calendar, the week will be selected in the corresponding small calendar as well.

You can double click in the large calendar to add an activity, if you have appropriate permissions. If you are adding an activity on the Day tab, double clicking on a time line automatically assigns a 30 minute time slot, which you can change. Clicking on the time located at the beginning of the line automatically assigns a 1 hour time slot, which you can change as well. If you your calendar displays an activity that exceeds 24 hours, the activity displays in the All Day row at the top of the large calendar. The calendar automatically adjusts across time zones. For example, if someone schedules a meeting for 8:00 a.m. Pacific time, the activity will appear at 10:00 a.m. Central time.

To access the calendar, type P01301 in the Fast Path.











6 Understanding Messages and Queues

This chapter contains the following topics:

	
Section 6.1, "Messages and Queues Overview"


	
Section 6.2, "Internal and External Messages"


	
Section 6.3, "Workflow Messages"


	
Section 6.4, "Queues"






6.1 Messages and Queues Overview

With JD Edwards EnterpriseOne, you can send and receive electronic mail (email) messages through the Work Center program. The JD Edwards EnterpriseOne email system includes messages sent by users and messages sent by a workflow process.

You can organize your messages by placing them into queues (storage areas for your messages) provided by the software or by setting up your own queues. This section explains how to work with your messages and with your queues. In addition, you can indicate your work-time location and add remarks to your time log.






6.2 Internal and External Messages

JD Edwards EnterpriseOne sends your email messages in different ways, depending upon whether the message is internal or external to the system.


	Internal Messages	Internal messages stay within the JD Edwards EnterpriseOne system. They are read using the Work Center.
	External Messages	External messages are sent to third-party email software packages such as Microsoft Outlook or Lotus Notes.






You system administrator configures your JD Edwards EnterpriseOne user account to receive either internal or external email. However, certain messages are sent as internal email regardless of this preference; for example, notifications of submitted UBE jobs.






6.3 Workflow Messages

In addition to sending and receiving internal and external messages, you can receive an active message, which is a type of message that a system workflow process automatically sends to a recipient.


	Active Messages	Workflow processes sometimes generate messages that require you to take action, such as approving or rejecting a change to a customer record. A lightning bolt button identifies an active message.
Active messages contain a shortcut button that links directly to an application. When you click the shortcut button, the system retrieves the most current information from the database, which ensures that you get accurate information even if changes are made after an active message is sent to you.

You can set up a workflow process to send active messages to specific queues.












6.4 Queues

Queues are storage areas that enable you to organize messages using the Work Center. For example, messages can be organized into queues for priority mail or for submitted jobs. Through a queue, users can approve or reject specific tasks in a workflow process. A queue is actually a UDC, and you set up a queue in the same way that you would set up a UDC.



6.4.1 Queues Provided with JD Edwards EnterpriseOne

JD Edwards EnterpriseOne provides these queues:


	Sent	Messages that you have sent to others.
	Deleted	Messages that you have deleted. After you delete a message, you can view it but you cannot move it to another queue.
The system administrator has the authority to purge deleted messages from the system, which is typically done periodically or on a predetermined schedule. You can also remove a message from the system by deleting it from your Deleted queue.


	Submitted Jobs	Messages generated by the system for jobs that you have submitted for batch processing, such as the General Ledger Post.










6.4.2 Workflow Queues

Workflow includes several predefined queues, but you might want to set up a custom queue for messages generated by processes that you create. For example, you might want to set up a queue for messages generated by a credit limit approval process. This queue would gather any approval or rejection messages related to credit limits for customers. A user could then open that queue and act on the message contained within it.











7 Working with Messages

This chapter contains the following topics:

	
Section 7.1, "Sending Messages"


	
Section 7.2, "Working with Shortcuts"


	
Section 7.3, "Using the Work Center"


	
Section 7.4, "Printing Messages"






7.1 Sending Messages

This section provides an overview of sending messages and discusses how to:

	
Send an internal message to a single recipient.


	
Use a quick list to send a message to multiple recipients.


	
Send a message to members of a role.






7.1.1 Understanding How to Send Messages

When you send internal email messages, you send them to other users within JD Edwards EnterpriseOne software. You can control the time of delivery for a message by assigning a tickler date to the message. A tickler date is a date in the future when the system will automatically show the message. Assigning a tickler date is especially helpful if you plan to be out of the office on the day that you want others to receive your message, or if you want to remind yourself about upcoming meetings or other obligations.

When you send internal messages, you can also include an attachment. Attachments enable you to include files, images, or links that conform to the OLE standard, such as word processing documents and spreadsheets.

You can send messages to one or more recipients. If you are sending a message to multiple recipients, you can use a quick list, a predefined distribution list, or a role.




	
See Also:

	Understanding Messages and Queues.















7.1.2 Forms used to Send an Internal Message to a Single Recipient


	Form Name	FormID	Navigation	Usage
	Send Internal Message	W012505A	From any application, click theTools button, then click Send Shortcut.	Send a non-workflow shortcut.










7.1.3 Sending an Internal Message to a Single Recipient

Access any application in JD Edwards EnterpriseOne.

	
From any application, click the down arrow on the hyper-button, select Tools, Send, and then select Internal Mail.


	
On Send Internal Mail, click the Search button in the "Send To Address Number / User / Role" field.


	
On Address Number / User / Role, select one of the following options to search for a recipient by address number or user ID, and then click OK:

	
Address Number


	
User





	
Highlight the row that contains the recipient and then click Select.


	
Type the subject of the message in the Subject field.


	
Complete the following optional fields, as necessary:

	
Type


	
Mail Box


	
Marketing


	
Lead Source


	
Keep Copy


	
Receipt Notify


	
Address


	
Contact


	
Tickler Date


	
Phone Number





	
Type your message in the text area at the bottom of the form.


	
To include an attachment with your message, right-click the panel with the Text button.


	
Choose New, and then one of these options:

	
Image


	
OLE


	
Shortcut


	
URL/File





	
Click OK to send the message.

The system returns you to the previous application. If you opt to keep a copy of a message that you send, you can view it in the same queue from which you sent the message.









7.1.4 Using a Quick List to Send a Message to Multiple Recipients

Access any application in JD Edwards EnterpriseOne.

	
From any application, click the down arrow on the hyper-button, select Tools, select Send, and then select Internal Mail.


	
On Send Internal Mail, select Quick List from the Form menu.


	
On Quick List, complete either of the following fields for each person you want on the list, and then click OK:

	
Alpha Name


	
Address Number





	
Follow the steps for sending an internal message to a single recipient.




	
Note:

You cannot save a quick list.















7.1.5 Sending a Message to Members of a Role

Access any application in JD Edwards EnterpriseOne.

	
From any application, click the down arrow on the hyper-button, select Tools, select Send, and then select Internal Mail.


	
On Send Internal Mail, click the Search button in the "Send To Address Number / User / Role" field.


	
On Address Number / User / Role, select the Role option, and then click OK.


	
Highlight the row that contains the role that you want to use and then click Select.


	
Follow the steps for sending an internal message to a single recipient.











7.2 Working with Shortcuts

This section contains an overview of working with shortcuts and discusses how to send a non-workflow shortcut.



7.2.1 Understanding Shortcuts

With the JD Edwards EnterpriseOne messaging system, you can send messages that contain a shortcut to a JD Edwards EnterpriseOne application. When you send a shortcut, you can preface it with a message for the recipient to review and approve. For example, you might want your manager to approve a change that you made to a customer record. After sending a shortcut to your manager, he or she can view the record immediately by clicking the shortcut button. When you send a shortcut, the system sends the key for that particular record to the recipient. When the recipient clicks the shortcut button, the system opens the application and retrieves the record.

The JD Edwards EnterpriseOne system uses workflow to automatically send messages with a shortcut to an application. These types of messages, called active messages, require that the recipient open the shortcut to verify information or approve a transaction.

Since JD Edwards EnterpriseOne software supports Windows and Web clients, the message can contain a shortcut for a Windows application or a Web application.






7.2.2 Form Used to Send a Non-Workflow Shortcut


	Form Name	FormID	Navigation	Usage
	Send Shortcut	W012505A	From any application, click theTools button, then click Send Shortcut.	Send a non-workflow shortcut.










7.2.3 Sending a Non-Workflow Shortcut

From the application from which you want to create a shortcut, access any records you want the recipient to view.

	
Click the down arrow on the hyper-button and select Tools, and then Send Shortcut.

The Send Shortcut form appears with a shortcut to the application.


	
On Send Shortcut, complete these fields:

	
Address Number / User / Role / Distribution List


	
Mail Box (Internal Messages Only)


	
Subject





	
Type your message.


	
Click OK to send the message.











7.3 Using the Work Center

This section provides an overview of the Work Center and discusses how to:

	
View messages.


	
Revise messages.


	
Move a message to another queue.


	
Redirecting messages to the Priority or Secondary queue.


	
Cancel the delivery of messages.


	
Reassign messages.


	
Delete messages.


	
Print messages.


	
Print a report that lists all messages in a queue






7.3.1 Understanding the Work Center

Use the Work Center to send and receive internal email messages within the JD Edwards EnterpriseOne system. Work Center enables you to perform standard email functions. 



7.3.1.1 View Messages

You can view your messages in the Work Center. Messages sent from other users will appear in either your Personal In Basket queue or, if you set them up, your Priority Mail and Secondary queues. You can also view workflow messages, or active messages, sent by a workflow process.




	
Note:

If you cannot view messages, make sure that queue security is set up to enable you to view the Address Book number and queue that you want to view.












7.3.1.2 Revise Messages

You can revise the text of messages in any of your queues. This feature opens up the actual message and enables you to change the text or add new text.






7.3.1.3 Move a Message to Another Queue

You can move a message from one queue to another. For example, you might want to move a message from your Priority queue to your Personal To Do List queue.






7.3.1.4 Redirect Messages to the Priority or Secondary Queue

You can redirect messages that you receive from an individual to your Priority Mail queue. When you do this, the system sends all future messages from that individual directly to your Priority Mail queue. Alternatively, you can redirect messages from an individual to your Secondary queue.

To redirect messages to the Priority Mail or Secondary queue, you must follow these steps and not the ones for moving messages. Moving messages only moves individual messages, whereas redirecting messages to the Priority Mail or Secondary queue affects all messages from that user until you remove the designation.

Although you can move a message to the Archived or Deleted queue, the system does not redirect future messages from the sender to that queue. You must manually move the sender's message to the Archived or Deleted queue each time.

You can redirect messages from more than one person to your Priority Mail and Secondary queues. You can also prevent messages from being delivered to a specific queue.






7.3.1.5 Cancel the Delivery of Messages

If you decide that you no longer want the system to automatically redirect messages from an individual to a Priority Mail queue, you can cancel the automatic delivery of messages to your Priority Mail or Secondary queue.






7.3.1.6 Reassign Messages

The messaging system enables you to reassign a message to another user after the message is sent to the original recipient. This process changes whose queue the message appears in. For example, if you originally sent a message to Jim, you can reassign that message to Betty. The message will now be in Betty's queue and will not be in Jim's queue. You can also reassign messages that you receive.

You can only reassign messages in other users' queues if your queue security enables.






7.3.1.7 Delete Messages

You cannot recover a message after you move it to the Deleted queue. It remains in your Deleted queue until your system administrator purges messages, which is typically done on a periodic or predetermined schedule. Alternatively, you can remove a message from the system by deleting it from your Deleted queue.








7.3.2 Forms Used to Access the Work Center


	Form Name	FormID	Navigation	Usage
	Employee Work Center - Work Center	W012503F	In the Fast Path, type G02.	Send and receive internal email.
	Employee Work Center - Address Number / User / Role	W012503D	On Employee Work Center - Work Center, click the search button located beside the Address Number / User / Role field.	Select the default value you want displayed when you access Work Center.
	Employee Work Center - Address Book Search Without Private Data	W0101SXA	On Employee Work Center - Address Number / User / Role, click OK.	Search for records by address number, users, or roles.
	Address Book Master Search	W0101SA	On Employee Work Center - Address Book Search Without Private Data, select a record and click Search.	Look up address book numbers.










7.3.3 Viewing Messages

Access any application.

	
Click the down arrow on the hyper-button and select Tools, and then Work Center.


	
On Work Center, expand a queue that contains a message.

Unless the All Queues check box is selected, only those queues that contain mail will display. Any messages in that queue appear. Messages that have not been viewed appear in bold.


	
Click the message that you want to view.

The message appears in the view area on the right side of the Work Center form.









7.3.4 Revising Messages

Access any application.

	
Click the down arrow on the hyper-button, select Tools, and then select Work Center.


	
On Work Center, select the message that you want to revise.


	
From the Row menu, select Message Revisions.


	
On the Message Revisions form, change any of the following fields and then click OK:

	
From


	
Contact


	
Subject


	
Phone Number


	
Tickler Date


	
Text area












7.3.5 Moving a Message to Another Queue

Access any application:

	
Click the down arrow on the hyper-button, select Tools, and then select Work Center.


	
On Work Center, click the All Queues option if the target queue to which you want to move the message does not appear.


	
Click and drag the message to the target queue.


	
To verify the placement of the message, double-click the target queue and view the contents.









7.3.6 Redirecting Messages to the Priority or Secondary Queue

Access any application.

	
Click the down arrow on the hyper-button, select Tools, and then select Work Center.


	
On Work Center, select the message that you want to redirect to your Priority Mail or Secondary queue.


	
From the Row menu, select one of these options:

	
Priority


	
Secondary





	
Expand the target queue to verify the placement of your message.

Any further messages that you receive from this sender will arrive in the queue that you selected. Repeat these steps for redirecting other users' messages.









7.3.7 Canceling the Delivery of Messages

Access any application:

	
Click the down arrow on the hyper-button, select Tools, and then select Work Center.


	
On Work Center, select a message from the user for which you want to cancel automatic delivery.


	
From the Row menu, select Remove.


	
Move any other messages from this particular sender out of the Priority Mail or Secondary queue.

As long as you keep any messages in your Priority Mail or Secondary queue from the sender whom you removed, future messages from that sender will appear in that queue.









7.3.8 Reassigning Messages

Access any application:

	
Click the down arrow on the hyper-button, select Tools, and then select Work Center.


	
On Work Center, select the message that you want to reassign, and then, from the Row menu, select Reassign.


	
On Assign Message, complete these fields and click OK:

	
Address Number / User / Role


	
Queue Designator












7.3.9 Deleting Messages

To delete a message, drag the message to the Deleted queue. Alternatively, select the message and click Delete.








7.4 Printing Messages

This section provides an overview of message printing and discusses how to:

	
Print a message.


	
Print a report that lists all messages in a queue.






7.4.1 Understanding Message Printing

You might find that you want a printed copy of a message for your records. You can do either of these tasks:

	
Print a message

You can print a message from any of your queues.


	
Print a report that lists all messages within a queue

This report includes a summary for each message. The two types of message reports are:


	
Message Center - Summary


	
Message Center - Detail

These reports show the sender and recipient of the message, as well as the subject of the message. The detail report shows the content of each message.









7.4.2 Printing a Message

Access any application in JD Edwards EnterpriseOne.

	
Click the down arrow on the hyper-button, select Tools, and then select Work Center.


	
On Work Center, select the message that you want to print.


	
From the Row menu, select Print.


	
On Printer Selection, click OK.









7.4.3 Printing a Report that Lists All Messages in a Queue

Access any application in JD Edwards EnterpriseOne.

	
Click the down arrow on the hyper-button, select Tools, and then select Work Center.


	
On Work Center, select the message queue that you want to print.


	
From the Form menu, select Print.


	
On Work with Batch Versions - Available Versions, select the version and submit the report.














8 Working with Queues

This chapter contains the following topics:

	
Section 8.1, "Understanding Queues"


	
Section 8.2, "Setting Up Queues"


	
Section 8.3, "Logging Time and Adding Remarks"






8.1 Understanding Queues

Queues are a way to group related messages together in the Work Center. This topic describes how to manage your queues by creating new ones or adding security. As with a message, you can also add a shortcut to a queue.

You set up queues in the system as UDCs. The following task describes how to create queues or modify existing queues.






8.2 Setting Up Queues

This section discusses how to:

	
Set up a queue.


	
Specify the queues that a user can view.


	
Changing a user's queue security.






8.2.1 Setting Up a Queue

Access the Work With User Defined Codes form.

	
On Work With User Defined Codes, click Add.


	
On User Defined Codes, complete the following fields in an empty row on the grid and click OK:

	
Codes

Enter a unique number for the queue.


	
Description 1

Enter a name for the queue.


	
Description 2


	
Special Handling


	
Hard Coded

Enter N in this field.







	Codes
	
A list of valid codes for a specific user defined code list.


	Description 1
	
A user defined name or remark.


	Description 2
	
Additional text that further describes or clarifies a field in the system.


	Special Handling
	
A code that indicates special processing requirements for certain user defined code values. The value that you enter in this field is unique for each user defined code type.

The system uses the special handling code in many ways. For example, special handling codes defined for Language Preference specify whether the language is double-byte or does not have uppercase characters. Programming is required to activate this field.


	Hard Coded
	
A code that indicates whether a user defined code is hard-coded. Values are:

Y

The user defined code is hard-coded

N

The user defined code is not hard-coded

A check mark indicates that the user defined code is hard-coded.









8.2.2 Specifying the Queues that a User Can View

You can change the security status for a user or group of users within a queue. You can either give a user authority to monitor every queue within a group, or you can deny users access to certain queues.

You can add security by user, distribution list, or role. For example, you might want to set up security so that a manager can monitor all messages within certain queues. Or you might set up security by distribution list or role so that users within the group have authority to monitor certain queues.

If you want to give only a few people within a distribution list or a role access to certain queues, you enter the distribution list or the role, and then enter the users' address book numbers to define which queues those users in the group can access.

Access the Work With Workflow Message Security form.

	
On Work With Workflow Message Security, click Add.


	
On Workflow Message Security Revisions, complete these fields:

	
User


	
Group/Role





	
Specify the queues that a user can view by completing the Authority Y/N field and clicking OK.




	User
	
A user in the workflow system. This can also be a group.


	Group/Role
	
A group or list of users in the workflow system. The address book number that identifies a list of users in the workflow system.


	Authority Y/N
	
Indicates whether the user is authorized to make changes to security information.

--- FORM SPECIFIC ---

For workflow, indicates whether the user can view other queues in the Work Center.











8.3 Logging Time and Adding Remarks

This section provides an overview of the Work Center monitoring features and discusses how to:

	
Check in and out.


	
Enter remarks.


	
View time logs.






8.3.1 Understanding Work Center Monitoring

The Work Center enables you to inform others of your whereabouts. You can specify when you are in or out of the office by using the Check In and Check Out options. You can add remarks to your check out to provide detailed information about where you are. You can view this information from the Time Log form.






8.3.2 Checking In and Out

Checking in and out informs others of your whereabouts. When you check out, you can also enter a remark, return date, and return time. If you do not enter a remark, the system supplies the wordhome. If you do not enter a return date, the system enters the next business day. The check in and check out information that appears on the Time Log form is discussed later in this topic.

Access the Work With Employee Queue Manager form.

	
On Work With Employee Queue Manager, locate and select your record.


	
From the Row menu, select one of these menu options:

	
Check In


	
Check Out

Each time you select Check In or Check Out, the system updates your status, which you can view from the Time Log.












8.3.3 Entering Remarks

You can enter a remark to provide more information about your whereabouts, your schedule, and so on. For example, you might enter a remark indicating that you are in a meeting, on vacation, or can be reached at a particular phone number. You can update an existing remark.

Access the Work With Employee Queue Manager form. 

	
On Work With Employee Queue Manager, locate and select your record.


	
From the Row menu, select Remark.


	
On the Check In/Out and Update Remark form, select the Update Remark option.


	
Enter your remark in the Remark field.


	
The following fields in the Return area are optional; complete them if necessary:

	
Return Time


	
Return Date





	
Click OK.


	
To view your remark, click Find on Work With Employee Queue Manager.









8.3.4 Viewing Time Logs

You can view the times when you or other employees check in and out, and you can view any remarks.

Access the Work With Employee Queue Manager form.

	
On Work with Employee Queue Manager, select the employee record time log that you want to view.


	
From the Row menu, select Time Log.














9 Working with Media Object Attachments

This chapter contains the following topics:

	
Section 9.1, "Understanding Media Object Attachments"


	
Section 9.2, "Working with Media Objects"


	
Section 9.3, "Attaching Media Objects"


	
Section 9.4, "Searching for Media Objects"


	
Section 9.5, "Working with Templates"


	
Section 9.6, "Working with the Properties of Media Objects"


	
Section 9.7, "Working with Metadata to Media Objects"


	
Section 9.8, "Attaching OLE Objects at the Base Form Level"






9.1 Understanding Media Object Attachments

JD Edwards EnterpriseOne software media objects and imaging features enable you to attach useful information to an application, including information that might currently exist as a paper-based document. The media objects feature enables you to attach the information to JD Edwards EnterpriseOne software applications, forms and rows, and Object Librarian objects. The imaging feature within media objects gives you the flexibility to create an efficient method of information storage.

Use media objects to link information to applications, either to individual rows in a grid or to a form. The following list discusses the types of information that you can attach to a grid row or form:


	Information	Description
	Text	Media objects provides a word processor that lets you create a text-only attachment. For example, you could use a text attachment to provide specific instructions for a form or additional information about a record.
	Image	Images include files such as Windows bitmaps, Graphics Interchange Format (GIF) files, and Joint Photographic Experts Group (JPG) files. These files might represent electronically created files as well as scanned images of paper-based documents.
	Object Linking and Embedding (OLE)	Media objects can be files that conform to the OLE standard. OLE enables you to create links among different programs. Using these links, you can create and edit an object from one program through a different program. JD Edwards EnterpriseOne software provides the links that you need to attach OLE objects.
You attach OLE media objects at the base form level. Media objects attached at this level are attached to a form and not to any data that might appear in the form. You can attach media objects to a grid row or a form, but the files themselves exist in separate directories. The only file information included with the application to which the OLE links is the path to the supporting file.

You can only use OLE objects that you properly register and install as OLE objects through Windows.


	JDE shortcuts	A JDE shortcut is a link that opens a JD Edwards EnterpriseOne software application. Within media objects, you can only attach JD Edwards EnterpriseOne software shortcuts; you cannot attach shortcuts to third-party applications.
	Uniform Resource Locators (URL)/files	Media objects can be links to Web page URLs or other related files. When a developer attaches a URL media object to a control object on a form, the Web page appears as part of the form. When a user attaches a URL to a form or Object Librarian object, the media object acts as a link to the URL.






System administrators can set up templates that might include their own attachments, such as images and shortcuts. For example, you can create a letterhead and a standard form for a memo. Also, you might create a shortcut, to be included in the template, that provides access to an application that uses data specific to the information that you add to the template.

Each time you save a media object, whether it is a new media object, or whether you have modified an existing one, EnterpriseOne timestamps the media object with your user ID, the date, and time. This information displays in the upper right corner of the media object. The information that displays is retrieved from the Enterprise server, so if your Enterprise server resides in a different time zone, the time and date that displays will be different than the time zone in which you are working. For example, if you work in the Eastern time zone, but the Enterprise server you are using resides in the Pacific time zone, the date and time that is recorded when you save the media object will be Pacific time.




	
Note:

If you open a Microsoft Excel OLE media object, place the cursor in the spreadsheet, then click Save, EnterpriseOne timestamps the media object even if you have not made changes.












9.2 Working with Media Objects

This section provides an overview of working with media objects and discusses how to:

	
Check for attachments


	
Check for attachments for a single row or a range of rows






9.2.1 Understanding how to Work with Media Objects

You can use the Media Objects feature to add text, graphics, and other objects to forms and records. For example, you can use a text attachment to explain special circumstances surrounding a journal entry. Or you can attach drawings, animations, and other types of objects to forms and records. A pop-up menu provides access to established templates for attachments and an option to set the properties for the Media Objects form.

When you attach a media object to a form, the attachment might not be available if you access different data on the form. For example, if you attach a media object to a detail form that contains data for Order Number 2002, this attachment does not appear on the detail form that appears when you access data for Order Number 3003. The base form, which in this case is a detail form, is the same for both Order Numbers, but the data associated with the form is specific to each Order Number. The Order Number represents the key to the location where an attachment is stored.

JD Edwards EnterpriseOne software supports Object Linking and Embedding (OLE). OLE enables you to create links among different programs. Using these links, you can save an object from one program into a different program. The system provides the links that you need to attach OLE objects. You can attach OLE objects as media objects and at the base form level. When you attach an object at the base level of the form, you attach the object to the form and not to any data that might appear in the form.

If attachments exist for a form, a paper clip button appears at the right of the status bar when you open the form. For an OLE object attached at the base form level, a document button appears at the right of the status bar.

When a form first opens, grid rows do not indicate whether attachments exist for the corresponding records. You can perform a search on every record that the system loads onto your workstation or you can search each record to determine whether attachments exist for records.

The Text feature includes a word processor that lets you create, view, edit, and delete notes. When you create a text attachment, you can also set up templates. You can use templates to create a format for a frequently used media object.





9.2.2 Understanding how to Work with HTML Media Objects

The HTML editor offers eight font faces (Arial, Courier New, Comic Sans, Georgia, Helvetica, Impact, Tahoma, Times New Roman) and font size from HTML size 1 to 7 for the user.




	
Note:

The font appearance is dependent on the browser being used.








Figure 9-1 Media Object Viewer

[image: Description of Figure 9-1 follows]








	
Note:

: Tab space is not supported in the HTML editor.







When the HTML mode is enabled and users access an existing ActiveX attachment they will be presented with two options:

	
Download File


	
Data conversion




The data conversion option converts the ActiveX text to HTML and is displayed in the HTML editor.




	
Note:

: Once the data is converted and saved to the database in XHTML it cannot be returned to the ActiveX RTF format.







The ActiveX rich text editor supports font sizes from 10 to 72pts, the HTML editor supports HTML font size 1 to 7. The font mapping for the data conversion is listed below.


	ActiveX Font Size	HTML Font Size
	10	2
	11, 12	3
	13, 14	4
	16, 18	5
	20, 22, 24	6
	26, 28, 36, 48, 72	7






If a company switched from HTML mode to ActiveX mode after attachments were created the attachments will be read-only.






9.2.3 Checking for Attachments

To find out whether an attachment exists for a record, you must first perform a search on the record. You can perform this search on one record or on a number of records simultaneously. The system only searches for attachments on records that you load onto your workstation. For example, when you initially click the Find button to locate a number of records, only the records that appear in the grid exist on your workstation. Use the page buttons to view more records.

When you click the Find button to refresh the records in the grid or to display new records, the form resets the attachments view status. You must click the find attachments button again to display the attachments for the grid records.

Access a form with the attachments feature available.

To check for all attachments:

On a form with the attachments feature available, click the Checking for Attachments button to the left of the row of column titles. This button looks like a paper clip overlapping a magnifying glass.

A paper clip button appears in the row header for each loaded record with an attachment.






9.2.4 Checking for Attachments for a Single Row or a Range of Rows

Access a form with the attachments feature available.

	
On a form with the attachments feature available, hold the cursor over the row header for the grid row.

If an attachment exists for the row, a paper clip button appears in the row header.


	
Move the cursor up or down in the row header column to search for attachments for adjacent rows.











9.3 Attaching Media Objects

This section provides an overview about attaching media objects and discusses how to:

	
Attach text


	
Attach and image


	
Attach an OLE object


	
Attach a shortcut


	
Attach URL or file






9.3.1 Understanding how to Attach Media Objects

Use the Attachments feature to attach text, photos, drawings, spreadsheets, video images, sounds, and application shortcuts to forms and grid rows. For example, you might attach the image of an invoice to a data entry record, attach a legal document to a record that describes a contractual agreement, or attach text that describes a process on a form. The attachments feature is not available on all forms.




	
Note:

You cannot create attachments until an administrator has established and mapped media object queues as described in Media Objects and Imaging in the System Administration Guide.







When you enter text, you can format the paragraphs and run a spell check. JD Edwards EnterpriseOne software also supports object linking and embedding (OLE).






9.3.2 Attaching Text

Access a form with the attachments feature available.

	
On a form where attachments are available, do one of these tasks:

	
To attach text to a form, from the Form menu, select Attachments.

If attachments exist for the form, click the paper clip button to the right of the status bar.


	
To attach text to a grid row, select the row and then, from the Row menu, select Attachments.

The Media Objects workspace is split into two panels. The left panel is the button panel and the right panel is the viewer panel. Icons for any files previously attached to the record appear in the button panel.





	
Do one of these tasks:

	
From the File menu, select New, and then Text.


	
In the button panel, click the right mouse button, select New, and then select Text from the pop-up menu.





	
In the viewer panel, type the desired text.


	
When you finish, from the File menu, select Save and Exit.

You can use the formatting tools at the top of the viewer panel to format the text of your note.









9.3.3 Spell Checking Text Media Objects

EnterpriseOne enables you to spell check text media objects. When you run spell checker, EnterpriseOne displays your text in a read only field, and highlights each word red that it identifies as a possible error. Once found, EnterpriseOne places the word in an field named. It displays why it identified the item as an error, and provides suggestions to correct it. You can choose a suggestion, manually correct the word in Replace With field, or ignore the word.

You can enable or disable the items you want spell checker to identify as possible errors. The list below shows which items are enabled or disabled by default:

	
Ignore All-Caps Words Option - Disabled.


	
Ignore Words with Numbers Option - Disabled.


	
Ignore Words with Mixed Case Option - Disabled.


	
Ignore Domain Names Option - Enabled.


	
Report Doubled Words Option - Enabled.


	
Case Sensitive Option - Enabled.


	
Suggest Split Words Option - Enabled.




If the language preference setting you are using is not supported by the spell checker, you will receive an error when you try to spell check your text media objects.

To spell check your text media objects:

	
Click the Spell Check icon located on the media object control toolbar.


	
On Spell Checker, choose one of the following options:

	
Change

Click this option if you accept the suggestion displayed in the Replace With field. You can also manually change the word in the Replace With field, and click Change.


	
Change All

Click this option if you want spell checker to automatically replace every instance of the word with the suggestion displayed in the Replace With field. You can also manually change the word in the Replace With field, and click Change All.


	
Ignore

Click this option if you want to disregard that the word displayed in the Problem field is an error.


	
Ignore All

Click this option if you want to disregard that all instances of the word displayed in the Problem field is an error.


	
Show Options

Click this option to display a list of the items spell checker identifies as possible errors. Click the check box to enable or disable any item.





	
Click OK to close the Spell Checker.









9.3.4 Attaching a File

Access a form where attachments are available.

	
On a form where attachments are available, do one of these tasks:

	
To attach an image to a form, from the Form menu, select Attachments.

If attachments exist for the form, click the paper clip button to the right of the status bar.


	
To attach an image to a grid row, select the row and then, from the Row menu, select Attachments.





	
On Media Objects, do one of these tasks:

	
From the File menu, select New and then Image.


	
In the button panel, click the right mouse button, select New, and then select Image from the pop-up menu.





	
Complete these options:

	
Queue Name


	
Files of Type

The Preview option contains a default check mark to display a sample of the selected image. Toggle this option to display or hide the preview image.





	
Choose an image, and then click OK.

If the system supports the graphic format, the image appears in the viewer panel.


	
When you finish, from the File menu, select Save and Exit.


	Field	Explanation
	Queue Name	The name of the directory where the image file exists.
	Files of Type	The list of file extensions that the system supports. For example, file types might include .bmp for a Windows bitmap, .gif for a graphics interchange format file, and .jpg for a joint photographic experts group file.













9.3.5 Attaching an OLE Object

Access a form where attachments are available.

	
On a form where attachments are available, do one of these tasks:

	
To attach an OLE object to a form, from the Form menu, select Attachments.

If attachments exist for the form, click the paper clip button to the right of the status bar.


	
To attach an OLE object to a grid row, select the row and then, from the Row menu, select Attachments.





	
On Media Objects, do one of these tasks:

	
From the File menu, select New and then OLE.


	
In the button panel, click the right mouse button, select New, and then select OLE from the pop-up menu.





	
On Insert Object, to create a new object, select an object type and click OK.

Selections vary from system to system depending on what the system administrator installs on your workstation and on the network.


	
Create your object.


	
To attach an existing object, select Create from File, locate the object on your system, and then click OK.

Depending on whether you create an object or attach an existing object, the application associated with the object displays in the viewer panel either a blank workspace or the existing object.

The menu bar displays the menus for the application from which you call the object. For example, if you select an Excel document, the Excel menus display on the menu bar.


	
On Media Objects, edit the object in the viewer panel as necessary.


	
When you finish, from the File menu, select Save and Exit.









9.3.6 Attaching a Shortcut

Access a form where attachments are available.

Include a shortcut to provide access directly from a record to an associated application.

	
On a form where attachments are available, do one of these tasks:

	
To attach a shortcut to a form, from the Form menu, select Attachments.

If attachments exist for the form, click the paper clip button to the right of the status bar.


	
To attach a shortcut to a grid row, select the row and then, from the Row menu, select Attachments.





	
On Media Objects, do one of these options:

	
From the File menu, select New and then Shortcut.


	
In the button panel, click the right mouse button, select New, and then select Shortcut from the pop-up menu.





	
On Open, browse through your files, select the appropriate shortcut, and click Open.

Your shortcut appears in the viewer panel.


	
When you finish, from the File menu, select Save and Exit.









9.3.7 Attaching a URL or File

Access a form where attachments are available.

Attach a URL to provide access to a Web page or a file on a disk. You can also attach file types that cannot be attached as images or OLE files, such as bitmaps.

	
On a form where attachments are available, do one of these tasks:

	
To attach a URL or file to a form, from the Form menu, select Attachments.

If attachments exist for the form, click the paper clip button to the right of the status bar.


	
To attach a URL or file to a grid row, select the row and then, from the Row menu, select Attachments.





	
On Media Objects, do one of these tasks:

	
From the File menu, select New and then URL/File.


	
In the button panel, click the right mouse button, select New, and then select URL/File from the pop-up menu.





	
On Add URL/File, browse your files or queues, select the appropriate URL or file, and click Open. You can also type a URL in the field.


	
Click OK.

Your URL or file appears in the viewer panel. If you are attaching a URL, a download dialog box appears. You can either verify that the URL is active or you can click Cancel.


	
When you finish, from the File menu, select Save and Exit.











9.4 Searching for Media Objects

This section provides an overview of searching for media objects and discusses how to:

	
Search for a media object


	
Rename attachments


	
Delete media objects






9.4.1 Understanding how to Search for Media Objects

You can search for a specific media object in the system by using information such as creation date, alternate keys, or UDCs.




	
Note:

You can only search for media objects that already have codes defined for them and that your system administrator has made available to all users in the system.












9.4.2 Searching for a Media Object

Access a form where attachments are available.

	
On a form where attachments are available, do one of these tasks:

	
To search for a media object to attach to a form, from the Form menu, select Attachments.

If attachments exist for the form, click the paper clip button to the right of the status bar.


	
To search for a media object to attach to a grid row, select the row, and then from the Row menu, select Attachments.





	
On Media Objects, do one of these tasks:

	
From the File menu, select New and then Search.


	
In the button panel, click the right mouse button, select New, and then Search from the pop-up menu.





	
On Media Object Search, complete the Type field and click Find.

Enter the type of media object attachment for which you are searching. You can use the Query by Example line to limit your search.

Only attachments with defined metadata appear.


	
Choose an attachment and click Select.

Your media object appears in the viewer panel.


	
When you finish, from the File menu, select Save and Exit.









9.4.3 Renaming Attachments

When you add an attachment, the system displays its filename under its button in the button panel. You can rename the button to make it more meaningful to other users if you want.

Access media objects.

	
On Media Objects, select a button and do one of these tasks:

	
From the File menu, select Rename.


	
In the button panel, click the right mouse button and select Rename from the pop-up menu.





	
Type a new name for the button and then click anywhere on the form.









9.4.4 Deleting Media Objects

When you no longer need an attachment, use the Delete feature on Media Objects to remove the object. When you delete text, the text is permanently erased. When you delete images and OLE objects, you remove the attachment of the file to the record. The system continues to store a file for the object.

Access a form where attachments are available.

	
Complete one of these tasks:

	
To delete an attachment to a form, from the Form menu, select Attachments.

If attachments exist for the form, click the paper clip button to the right of the status bar.


	
To delete an attachment to a grid row, select a row with a paper clip button, and then, from the Row menu, select Attachments.





	
On Media Objects, select the appropriate button in the button panel and then select Delete from the File menu.


	
On Confirm Media Object Delete, click Yes to confirm the deletion.

The button disappears from the button panel.


	
When you finish, from the File menu, select Save and Exit.











9.5 Working with Templates

This section discusses how to:

	
Create a template


	
Attach a template


	
Modify a template


	
Delete a template


	
Delete a template with media objects






9.5.1 Creating a Template

On Media Objects, you can access the Work With Media Objects Templates form. On this form, you can attach, create, modify, and delete templates to help you format your text attachments.

Access a form where attachments are available.

	
Select the row from which you want to attach a template, and then select Attachments from the Row menu.


	
On Media Objects, in the button panel, click the right mouse button and select Templates from the pop-up menu.


	
On Media Objects Template, click Add.


	
On Media Object Template Revisions, complete these fields, and then enter your template information into the workspace:

	
Template Name


	
Description





	
Click Add.









9.5.2 Attaching a Template

Access a form where attachments are available.

	
Select the row to which you want to attach a template, and then select Attachments from the Row menu.


	
On Media Objects, in the button panel, click the right mouse button and select Templates from the pop-up menu.


	
On Work With Media Object Templates, click Find.

You can use the query-by-example line to refine your search.


	
To preview the template, double-click the paper clip button in the row header.


	
Choose the grid row for the template that you want to attach, and then click Select.


	
The template appears in the workspace on Media Objects.









9.5.3 Modifying a Template

Access a form where attachments are available.

	
Select the row from which you want to modify a template, and then select Attachments from the Row menu.


	
On Media Objects, in the button panel, click the right mouse button and then select Templates from the pop-up menu.


	
On Work With Media Object Templates, click Find.

You can use the Query by Example line to refine your search.


	
Choose the grid row for the template that you want to modify and then click Select.


	
On Media Objects, modify the template as necessary and then from the File menu, select Save and Exit.









9.5.4 Deleting a Template

Access a form where attachments are available. 

	
Select the row from which you want to delete a template, and then select Attachments from the Row menu.


	
On Media Objects, in the button panel, click the right mouse button and then select Templates from the pop-up menu.


	
On Work With Media Object Templates, click Find.

You can use the Query By Example line to refine your search.


	
Choose the grid row for the template that you want to delete, click Delete, and then on Confirm Delete, click OK.









9.5.5 Deleting a Template on Media Objects

Access a form where attachments are available.

	
Select the row from which you want to delete a template, and then select Attachments from the Row menu.


	
On Media Objects, in the button panel, select the text button for the template, and then select Delete from the File menu.


	
On Confirm Media Object Delete, click Yes.

The template and the text button disappear.











9.6 Working with the Properties of Media Objects

This section discusses how to:

	
Set media object properties


	
Set text properties


	
Set image properties


	
View OLE properties


	
Set shortcut properties






9.6.1 Setting Media Object Properties

The pop-up menu that appears when you click the right mouse button in the button panel on Media Objects provides you with the option to view and, for some objects, to change the properties of an object. Each object has unique properties.

In addition, you can define metadata for an object. Metadata contains information about the object, such as a description of the object, who created it, and when it was created. Other users can search for the object based on this information.

Access Media Objects.

	
On Media Objects, in the button panel, click the right mouse button and then select Properties.

The form or row must contain an attachment in order to access the Media Objects properties.


	
On Properties, review the "Technical information about the key for the form" on the Key Information tab.


	
Click the Flags tab and review this information:

	
Allow Text Items


	
Allow Image Item


	
Allow OLE Items


	
Allow RTF Text


	
Show Text Item On Open


	
Read Only












9.6.2 Setting Text Properties

Access Media Objects.

	
On Media Objects, in the button panel, click the right mouse button over a text button, and then select Properties from the pop-up menu.


	
On the text properties form, review these fields on User Audit Information:

	
Created by


	
Date Created


	
Time Created


	
Updated By


	
Date Updated


	
Time Updated





	
Click the Printing Information tab and then do the following, if necessary:

	
Click the Check to print before report item option


	
Complete the Effective From field


	
Complete the Effective To field












9.6.3 Setting Image Properties

Access Media Objects.

	
On Media Objects, in the button panel, click the right mouse button over an image button, and then select Properties from the pop-up menu.


	
On the Image Properties tab, review these fields:

	
File Name


	
Queue Name


	
Queue Path





	
To give the image a title, complete the Description field.









9.6.4 Viewing OLE properties

Access a form where attachments are available.

	
On Media Objects, in the button panel, click the right mouse button over an OLE object button, and then select Properties from the pop-up menu.


	
On the OLE Object Properties tab, review these fields:

	
File Name


	
Queue Name


	
Queue Path












9.6.5 Setting Shortcut Properties

Access Media Objects.

	
On Media Objects, in the button panel, click the right mouse button over a shortcut button, and then select Properties from the pop-up menu.


	
On the JDEShortcut Control Properties form, review these fields on the General tab:

	
Menu Name


	
Selection


	
Icon File


	
Icon Index





	
Do these tasks, if necessary:

	
Click the Colors tab to set the color for the shortcut hypertext.


	
Click the Fonts tab to set font properties such as size, family, bold, italics, underline, and strikeout.














9.7 Working with Metadata to Media Objects

This section discusses how to:

	
Enable metadata fields for media objects


	
View and define metadata






9.7.1 Enabling Metadata Fields for Media Objects

The system enables you to add information to media objects in the form of metadata. Metadata can include items such as author, creation date, and language of the media object attachment.

Before you can add metadata, you must enable the metadata fields for the media object in the Media Object Category Constants program (P00167).

To enable metadata fields for media objects:

From the GH9016 menu, select Media Object Constants (P00167).

	
On Work With Media Object Category Constants, find the media object that you want to enable.

The system will enable the metadata fields for all the media objects that are associated with the media object that you select.


	
Highlight the media object and then click Select.


	
On the General tab of Media Object Category Constants Revisions, select the check boxes next to the available metadata field options to enable those metadata fields in the media object.


	
Click OK.









9.7.2 Viewing and Defining Metadata

Access a form with an attachment. 

	
On any form with an attachment, in the Media Objects button panel, right-click an object button, and then select Characterize Object from the pop-up menu.


	
On the Media Object Category Revisions form, click the General tab, and then complete the available fields for the media object.


	
Click OK.


	Description	Glossary
	Description	A short description to describe what the media object is about.
	Author	This is the author of the media object document or attachment.
	Creation Date	For World, used in the DDS specifications for IBM's file-field reference display.
	Status	Indicate if this media object is active or obsolete.















9.8 Attaching OLE Objects at the Base Form Level

The section discusses how to:

	
Attach OLE objects at the base form level


	
Delete OLE objects at the base form level






9.8.1 Attaching OLE Objects at the Base Form Level

At the base level of a standard form, you can attach OLE objects using the OLE Objects button on the Links toolbar. Menu bars and toolbars appear on all standard forms. When you attach an OLE object at the base level of a form, rather than associating the attachment with a record, the OLE object attaches only to the form. No matter what record appears on the form, the OLE object that you attach using the OLE Objects button will always appear when you open the form.

Access a standard form.

	
Complete one of these tasks:

	
From the Links toolbar, select Preferences, and then OLE Objects.


	
From the Preferences menu, select OLE Objects.


	
If attachments exist for the form, click the document button to the right of the status bar.





	
On the Choose Queue form, select the appropriate queue.




	
Note:

If you do not know the queue in which the object you want to attach exists, ask your system administrator.








	
On the OLE Objects form, do one of the following:

	
From the File menu, select Add Object.


	
In the button panel, click the right mouse button and then select Add Object.





	
On Insert Object, to create a new object, select the type of object that you want to create and then click OK.

Selections vary from system to system depending on what the system administrator installs on your workstation and on the network.


	
Create your object.


	
To attach an existing object, select Create from File, locate the object on your system, and then click OK.

Depending on whether you create an object or attach an existing object, the application associated with the object displays either a blank workspace or the existing object in the viewer panel.

The menu bar displays the menus for the application from which you call the object. For example, if you select an Excel document, Excel menus display on the menu bar.


	
Edit the object in the viewer panel.


	
To return to the main form, click the X button on the OLE Objects form in the application workspace.









9.8.2 Deleting OLE Objects at the Base Form Level

Access a standard form.

	
Complete one of these tasks:

	
From the Links toolbar, select Preferences and then select OLE Objects.


	
From the Preferences menu, select OLE Objects.


	
Click the document button to the right of the status bar.





	
On the OLE Objects form, select the object and complete one of these tasks:

	
From the File menu, select Delete Object.


	
In the button panel, click the right mouse button and select Delete Object.





	
On Confirm Media Object Delete, click Yes.


	
To return to the main form, click the X button on the OLE Objects form in the application workspace.














10 Using MailMerge Workbench

This chapter contains the following topics:

	
Section 10.1, "Understanding MailMerge Workbench"


	
Section 10.2, "Creating a Data Set and Attaching Templates"


	
Section 10.3, "Attaching Templates to a Data Set"






10.1 Understanding MailMerge Workbench

MailMerge Workbench merges Microsoft Word 6.0 (or higher) word processing documents with JD Edwards EnterpriseOne system records to automatically print business documents, such as form letters. Some application suites, such as Human Resource Management, use these documents within their normal workflow process. See your application guides to determine which applications use mail-merge documents. In these applications, the system automatically prints the mail-merge documents as part of the workflow process, and no user intervention is needed.

You can use the Maintain MailMerge Documents application to add or change text in the business documents included with JD Edwards EnterpriseOne software to create new documents and to delete documents.

JD Edwards EnterpriseOne software enables you to create HTML versions of mail-merge documents to send to Web client users. After you add text and fields to the mail-merge document, you can copy it to an HTML version so that you can send mail-merge letters to Web client users. When a mail-merge letter is generated, the system displays the letter in the Web Mail Merge program (P980040).






10.2 Creating a Data Set and Attaching Templates

This section provides an overview of data set and discusses how to create a data set and how to attach templates to the data set.

Understanding Data Sets

A data set is the way you define the data structure that passes data to the API. After you define the data set, you will attach to it a simple template or a composite template. A simple template is a single template that you attach to a data set. A composite template is a collection of simple templates. Use only templates in the .rtf format.






10.3 Attaching Templates to a Data Set

After you have created a data set, you must attach either a simple template, or a composite template.









11 Using Processing Options

This chapter contains the following topics:

	
Section 11.1, "Understanding Processing Options"


	
Section 11.2, "Understanding Processing Option Functions"


	
Section 11.3, "Understanding the Types of Processing Options"


	
Section 11.4, "Working with Processing Options"






11.1 Understanding Processing Options

A processing option is a parameter in which you enter a value to control how an interactive or batch program runs.

You use processing options to instruct the system to perform functions to meet your specific business needs. If a program contains processing options, you set the required and optional processing options for the program during setup or before you run or submit a program.

You can create different versions of each program if your business needs require specific processing for different processes. You can then set these unique processing options differently in multiple versions of the same application. Changes to processing options immediately affect that version for every user. Anyone who uses that version after you make the change uses the new processing option values. You can also use processing options to access a version of another program.




	
Important:

XJDE versions are considered owned by JD Edwards. During an upgrade, the system might overwrite these versions. You should use these versions only as templates for your own versions.
ZJDE versions are used for default purposes, and are typically interactive applications or versions called from another application. You usually attach these versions to a menu. You can set these processing options. When called from a menu, interactive applications with a version are called with a blind execution based on predetermined processing option values.














11.2 Understanding Processing Option Functions

Use processing options to complete one of these tasks:

	
Set up default values


	
Customize an application for different companies or even different users


	
Control the format of forms and reports


	
Control page breaks and the location where totaling occurs for reports




Processing options appear in the system as a tabbed form. Tabs organize the processing options by purpose and function. Each processing option tab contains these items:

	
A standard or unique tab name


	
Processing option titles


	
Lists of values


	
Online help (enhanced processing options)

You access field-level help by placing the cursor is in a field and pressing F1 or by clicking the Item Help icon located at the top-right corner of a form. If the field in which the cursor resides is a business view column, the system displays the alias name, business view name and description, table name and description, and glossary text. If the field in which your cursor resides is a data dictionary column, the system displays the alias name, the term Data Dictionary Item, and the glossary text. This information enables you to identify problems in the item help functionality, should any occur.




	
Note:

If your system administrator has not turned on the appropriate functionality, you will see only the alias name and glossary text.















11.3 Understanding the Types of Processing Options

Processing options can be of two types: enhanced and nonenhanced.

Enhanced processing options provide detailed user information. For example, the user can look at the field name and values on the tab and quickly determine how to use the processing option; or the user can access online help by pressing F1 on the processing option for a detailed explanation. These processing options have been enhanced to JD Edwards EnterpriseOne standards. Enhanced processing option forms have a number, a brief title, and, if applicable, a concise list of values. These processing options have online help attached to them.

Nonenhanced processing options provide only a brief description in paragraph form. Sometimes these fields have no title; instead, they are numbered, and each number is followed by a brief explanation, in paragraph form, of relevant information (usually values). The processing option numbers sometimes span all tabs. The fields typically have data items attached but do not follow the same naming conventions as enhanced processing options






11.4 Working with Processing Options

This section provides an overview for working with process options and interactive and batch version processing options.



11.4.1 Understanding Processing Options

You can work with processing options in these two ways:

	
From a menu


	
From a version list






11.4.1.1 How Processing Options Work From a Menu

You can access processing options for an object either from the menu bar or by right-clicking the object. In either case, one of the options is Prompt For. The Prompt For submenu contains these options, when available:


	Options	Description
	Values	Choose this option to specify processing option values.
	Version	Choose this option to select which version of the object to run. Depending on how the version was designed, you might be prompted to enter processing option values after you select the version, or you might be able to modify them from the Row menu.
	Data Selection	Choose this option to specify which data to use.
	Data Selection and Values	Choose this option to specify which data to use and then to specify processing option values.






If you select to run processing options from a menu, the processing details defined at the menu level take precedence. Not all objects enable you to select from all four of these options.








11.4.2 Using Interactive Version Processing Options

The processing options that you define in interactive versions are a set of parameters that alter how an application runs. They are similar to initialization (.ini) files and command-line arguments for a traditional executable. These processing options let you specify the options that you want when you open an application. For example, you can specify how a form appears, show or hide a field, change the default status for order activity rules, and set default information to appear in a field.

Not all JD Edwards EnterpriseOne software applications have processing options. If the Prompt For Values option on the Edit menu is grayed out, either no processing options are associated with the application or the system administrator has secured a version for the application. When you open a secured version from the Interactive Versions application, a security message appears to inform you that you do not have access to the version.

You must set processing options for an interactive application before you use versions with the application.

Using processing options, you set up interactive programs to suit your business requirements. For interactive versions, processing options complete these tasks:

	
Change functions. For example, you can set a processing option to turn on or off order holds. You can also specify whether you want to automatically print pick slips after you enter an order that is based on a processing option value.


	
Change default values. For example, you can set the processing options to set defaults for document types (such as quote orders or purchase orders) or line types (such as stock or nonstock items).


	
Control the display of forms. For example, you can set the processing options to hide or show a cost field, a price field, or a commission field.




Access a Solution Explorer task view.

	
From the EnterpriseOne Menu, click the application for which you want to set processing options. 


	
Click the and select Prompt For Values from the menu.


	
On Processing Options, enter appropriate values where applicable and click OK.









11.4.3 Using Version Processing Options

You can change the processing options for an existing batch version to suit your business requirements. For example, you can change processing option values that specify a range of dates for a report. However, not all batch versions have processing options associated with them. For example, a list of addresses might not require special prompting.

For batch versions, processing options complete these tasks:

	
Change functionality. For example, you can set a processing option to move records to a history file after a report runs.


	
Change input parameters. For example, you can set a processing option to specify which category code to use when processing a report.


	
Define data. For example, you can set a processing option to define the fiscal year for which you want to run a report. You can also define the employee information included in a report.









11.4.4 Launching Processing Options for Batch Versions Manually

Access a Solution Explorer task view.

	
From a EnterpriseOne Menu, select the batch version application for which you want to set processing options.


	
On Work With Batch Versions - Available Versions, find and click a version of the report or other batch application.


	
On Work With Batch Versions - Available Versions, select Processing Options from the Row menu.


	
On Processing Options, enter appropriate values where applicable and click OK.









11.4.5 Using Processing Options for Master Business Functions

The purpose of a master business function (MBF) is to provide a central location for standard business rules about entering documents such as vouchers, invoices, and journal entries.

The MBF is composed of processing options that are shared by some programs. For example, the following journal entry programs use the processing options for the journal entry MBF:

	
Journal Entries (P0911)


	
Journal Entries with VAT (P09106)


	
Journal Entry Batch Processor (R09110Z)


	
Store and Forward JE Batch Processor (R09110ZS)


	
Recurring Journal Entry Compute & Print (R09302)


	
Indexed Comp Compute and Print Report(R093021)


	
Variable Numerator Compute and Print (R093022)




Access Work With Interactive Versions from the System Administration Tools menu (GH9011).

	
Type the application number in the Interactive Application field and click Find. For example, type P0900049.


	
Choose a version.


	
To review the processing option settings for the version, select Processing Options from the Row menu.














A Hot Keys

This appendix contains the following topics:

	
Understanding Hot Keys


	
Section A.2, "Keyboard Shortcuts"


	
Section A.3, "EnterpriseOne Menu"


	
Section A.4, "Tree Grid"


	
Section A.5, "Button Hot Keys"


	
Section A.6, "Keyboard Shortcuts for the Calendar Tool"


	
Section A.7, "Web Client Keyboard Shortcuts for the Calculator Tool"


	
Section A.8, "Keyboard Shortcuts for Media Object Text"


	
Section A.9, "Keyboard Shortcuts for Calendar Control"


	
Section A.10, "Moving in the Grid"






A.1 Understanding Hot Keys

Menu options and buttons throughout the system include key combinations, or hot keys, that perform the same functions as using the mouse. All of the standard push buttons in the system have hot keys associated with them.

You can recognize hot keys by the underline on a control or menu. For example, the I on the Find button is underlined. Press Ctrl + Alt + I to use this control.

The hot keys work in both the Windows client and Web Client of JD Edwards EnterpriseOne software, except where noted.




	
Note:

In the JD Edwards EnterpriseOne web client, all hot key combinations that use the Alt key only work with the left Alt key. The right Alt key is used for typing special characters for foreign languages.












A.2 Keyboard Shortcuts

The hot keys listed in the following tables are capitalized only to make them easier to read. You do not need to press the shift key to utilize hot key functionality unless the shift key is specifically listed.


	Hot Keys	Action
	F1	Access field help
	F2 (web only)	Launch search button/Calendar/Calculator button on the current field.
	Alt + Tab	Switch between all open applications on your PC.
	F8 (web only)	Move focus to the EnterpriseOne Menu and loop between open applications.
	F12 (web client only)	Move focus to the first focus-enabled control in the next group of controls.
	Shift + F12(web client only)	Move focus to the first focus-enabled control in the previous group of controls.
	Alt + 1 through Alt + 9 (web client only)	With focus on tab-sets, Alt + 1 shows the first tab, Alt + 2 shows the second and so forth, up to the 9th tab
	Ctrl + Alt + 1 through Ctrl + Alt + 9	With focus on subtab sets, Ctrl + Alt + 1 shows the first subtab, Ctrl + Alt + 2 shows the second subtab, and so on, up to the ninth subtab.
	Alt + N (web client only)	Launch new window
	Alt + M (web client only)	Minimize/maximize EnterpriseOne Menu
	Ctrl + Shift + J (web client only)	Launch System Information
	Ctrl + Shift + K (web client only)	Launch keyboard information help
	Alt + K (web client only)	Expand/Collapse subform or container
	Alt + Q (web client only)	Move focus to first or next issue (error or warning) field. Move focus back to the first issue after reaching the last issue.
	Ctrl + A	Selects all text in a field.
	Ctrl + X	Cut or delete selected text
	Ctrl + V	Paste cut or copied text to the new area
	Ctrl + C	Copy selected text
	Ctrl + Alt + P (web client only)	Open Report menu
	Ctrl + Alt + T (web client only)	Open Tools menu
	Ctrl + Alt + F (web client only)	Open Form menu
	Ctrl + Alt + R (web client only)	Open Row menu
	Up or Down Arrows	Move focus up or down between options on fly out menus. Press Enter to launch the option.










A.3 EnterpriseOne Menu


	Hot Keys	Action
	Alt + / (web client only)	Move focus to Fast Path when in EnterpriseOne Menu
	Ctrl + Enter	Opens new window.
	Ctrl + mouse click	Opens new window.
	Up and Down Arrows (web client only)	Move focus up or down from present node in navigation tree. If next node is a child node, move focus to it
	Right Arrow (web client only)	Expand present node in navigation tree
	Left Arrow (web client only)	Collapse present node in navigation tree
	Enter (web client only)	Launch end node if hyperlinked. If parent node, expand it. If expanded, collapses it
	Ctrl + Right Arrow	Activates the fly out for a menu item.
	Esc	Cancels the fly out for a menu item.
	Up Arrow and Down Arrow	Navigates the fly out when active.
	Ctrl + Home	If focused on the menu, this hot key combination will take you to the first menu item.
	Ctrl + End	If focused on the menu, , this hot key combination ill take you to the last menu item.
	Alt + X	Expands the menu to full size.










A.4 Tree Grid


	Hot Keys	Action
	Ctrl + Shift + Right Arrow (web client only)	Expand node
	Ctrl + Shift + Left Arrow (web client only)	Collapse node










A.5 Button Hot Keys


	Hot Keys	Action
	Ctrl + Alt + A (web client only)	Add
	Ctrl + Alt + B (web client only)	Save for Later, Back on Media Object Viewer form
	Ctrl + Alt + D (web client only)	Delete
	Ctrl + Alt + E (web client only)	Save and Continue, Continue in Import/Export Grid Data
	Ctrl + Alt + F (web client only)	Open Form menu, place focus on first option
	Ctrl + Alt + G (web client only)	Assign
	Ctrl + Alt + I (web client only)	Find, File Media Object view/add form
	Ctrl + Alt + L (web client only)	Cancel/Close
	Ctrl + Alt + M (web client only)	Remove, New Template on Media Object Viewer form
	Ctrl + Alt + N (web client only)	Save and Add New
	Ctrl + Alt + O (web client only)	OK, Save and Close, Submit, New OLE Media Object on Media Object Viewer form
	Ctrl + Alt + P (web client only)	Open Reports menu, place focus on first option
	Ctrl + Alt + R (web client only)	Open Row menu, place focus on first option
	Ctrl + Alt + S (web client only)	Select
	Ctrl + Alt + T (web client only)	Open Tools menu, place focus on first option
	Ctrl + Alt + U (web client only)	Undo Changes, Enter URL on Media Object Viewer form
	Ctrl + Alt + V (web client only)	Save, Save Changes
	Ctrl + Alt + X (web client only)	New Text media object on Media Object Viewer form
	Ctrl + Alt + Y (web client only)	Copy
	Ctrl + Alt + Z (web client only)	Characterize on Media Object Viewer form
	Ctrl + Alt + Up Arrow (web client only)	Move selection up in Data Selection and Sequencing dialog
	Ctrl + Alt + Down Arrow (web client only)	Move selection down in Data Selection and Sequencing dialog










A.6 Keyboard Shortcuts for the Calendar Tool


	Hot Keys	Action
	Page Up	Move to previous month.
	Page Down	Move to next month.
	Home (web client only)	Move to previous year.
	End (web client only)	Move to the next year.
	Enter (web client only)	Close the Calendar and set the current value to the input field with search button (OK action).
	Escape (web client only)	Close the Calendar and return to the input field with search button (Cancel action).










A.7 Web Client Keyboard Shortcuts for the Calculator Tool


	Hot Keys	Action
	Backspace (web client only)	Remove one digit from calculator display.
	F9 (web client only)	Change the sign of the number on calculator display.
	= or Enter (web client only)	Evaluate and display the result.
	Escape (web client only)	Clear the calculator display.
	Digit Key (0123456789.) (web client only)	Show the number in the display field.
	%, *, +, -, / (web client only)	Perform an operation corresponding to the key stroke and display the result.
	@ (web client only)	Perform square root operation.
	R or r (web client only)	1/X Operation.
	O (web client only)	Close the calculator and set the current value to the input field with search button (OK action).
	C (web client only)	Close the calculator and return to the input field with search button (cancel action).










A.8 Keyboard Shortcuts for Media Object Text


	Hot Keys	Action
	Ctrl + B	Bold the selected text
	Ctrl + I	Italicize the selected text
	Ctrl + U	Underline the selected text
	Ctrl + Shift + L	Create a bullet
	Ctrl + Tab	Exit the text edit form and display the next object in the tab sequence










A.9 Keyboard Shortcuts for Calendar Control


	Hot Keys	Action
	Ctrl + Alt + D (web client only)	Switch to Day view
	Ctrl + Alt + W (web client only)	Switch to Week view
	Ctrl + Alt + M (web client only)	Switch to Month view
	Ctrl + Alt + Right Arrow (web client only)	Move to next day/week/month as per current view
	Ctrl + Alt + Left Arrow (web client only)	Move to previous day/week/month as per current view
	Ctrl + Alt + A (web client only)	Add an activity
	Ctrl + Alt + E (web client only)	Move focus to first/next event. If All Day Events exist, the focus is set to the first day to last, from AM to PM. If on month view, move focus from first day to last.










A.10 Moving in the Grid


	Hot Keys	Action
	Tab	Move to the next cell. The order is right and then down. Available only in grids where you can enter information.
	Shift + Tab	Move focus to previous link, form field, button, or hot linked button.
	Ctrl + V	Paste the Clipboard data into the current cell location.
	Ctrl + C	Copy the current selection or data in a cell to the Clipboard.
	Enter in a grid cell (web client only)	Move focus to first editable field in the row below the current one.
	Spacebar on the Grid Selection Check box (web client only)	Select the row that the check box represents. A user can tab through the controls to set focus on the Grid Selection Check box.
	F2 (web client only)	Launch Search button from the current cell.
	Alt + / (web client only)	Move focus to first enabled cell in the QBE row, if QBE is present. Cycle through all QBE cells
	ENTER in QBE	Trigger Find operation.
	PAGE UP	Page up (or show previous page of grid data)
	PAGE DOWN	Page down (or show next page of grid data)
	Alt + R (web client only)	Maximize/minimize grid
	Ctrl + Shift + E (web client only)	Export Grid Data
	Ctrl + Shift + I (web client only)	Import Grid Data
	Alt + J (web client only)	On editable grids, set focus on the first editable cell in the grid.
On non-editable grids, set focus on the row selector for the first row in the grid.


	Up and Down Arrows	Move focus to the field above or below, in the same column
	Ctrl + Up Arrow (web client only)	Select previous row
	Ctrl + Down Arrow (web client only)	Select next row
	Ctrl + Alt + Left Arrow	Move focus to first editable cell in current row
	Ctrl + Alt + Right Arrow	Move focus to last editable cell in current row
	ENTER in grid row	Move focus to first editable field in the row below
	Ctrl + Home	Move focus to first row, current column
	Ctrl + End	Move focus to last row, current column
	Ctrl + Alt + [spacebar] (web client only)	Select current row













B JD Edwards EnterpriseOne Software Systems

This appendix contains the following topics:

	
Section B.1, "JD Edwards EnterpriseOne Software Systems"




This appendix provides a list of the JD Edwards EnterpriseOne systems.



B.1 JD Edwards EnterpriseOne Software Systems

The following table identifies the JD Edwards EnterpriseOne systems:


	Number	System
	00	Foundation Environment
	01	Address Book
	02	Electronic Mail
	03	Accounts Receivable
	0301	Credit Management
	03B	Enhanced Accounts Receivable
	03C	Issue Management System
	04	Accounts Payable
	05	Time Accounting and HRM Base
	05A	OW HR & PR Foundation
	05C	OW HR & PR Foundation Canadian
	05T	Time Entry
	05U	OW HR & PR Foundation US
	06	Do not use
	07	Payroll
	07S	Payroll SUI
	07Y	U.S. Payroll Year End
	08	Human Resources
	08B	Benefits Administration
	08C	OW HR Canadian
	08H	Health and Safety
	08P	Position Control
	08R	Recruitment Management
	08U	OW HR US
	08W	Wage and Salary
	09	General Accounting
	09E	Expense Reimbursement
	10	Financial Reporting
	10C	Multisite Consolidations
	11	Multicurrency
	11C	Cash Basis
	12	Fixed Assets
	13	Plant/Equipment Management
	14	Modeling, Planning & Budgeting
	15	Property Management
	16	Profit Management (EPS)
	17	Customer Service Management
	17C	Call Management
	18	Resource Scheduling
	19	Utility CIS
	30	Product Data Management
	3010	Process Data Management
	31	Shop Floor Control
	3110	Process Control
	32	Configuration Management
	32C	Custom Works
	33	Capacity Planning
	34	Requirements Planning
	34A	Advanced Planning & Scheduling
	35	Enterprise Facility Planning
	36	Forecasting
	37	Quality Management
	38	Agreement Management
	39	Advanced Stock Valuation
	40	Inventory/OP Base
	4010	Advanced Price Adjustments
	41	Inventory Management
	41B	Bulk Stock Management
	42	Sales Management
	42A	Sales Force Automation
	42E	ECS Sales Management
	43	Procurement
	44	Subcontract Management
	4401	Homebuilder Management
	44H	Homebuilder Management
	45	Advanced Pricing
	46	Warehouse Management
	47	Electronic Commerce
	48	Work Order Processing
	48S	Service Billing
	49	Transportation Management
	50	Job Cost Base
	51	Job Costing
	52	Contract Billing
	53	Change Management
	55 - 59	Reserved for Clients
	60 - 69	Reserved for JDE Custom
	70	Multinational Products
	71	Client Server Applications
	72	World Vision
	73	M & D Complementary Products
	74	EMEA Localization
	74H	Hungary
	74I	Ireland
	74L	Portugal
	74N	Nordics
	74P	Poland
	74R	CIS
	74S	Spain
	74T	Turkey
	74Z	Czech Republic
	75	ASEAN Localization
	75H	Thailand
	75I	India
	75K	Korea
	75T	Taiwan
	76	Latin American Localization
	76A	Argentina
	76B	Brazil Localization
	76C	Colombia
	76H	Chile
	76P	Peru
	76V	Venezuela
	77	Payroll (Canadian)
	77Y	Canada Payroll Year End
	79	Translation Tools
	80	Business Intelligence
	81	DREAM Writer
	82	World Writer
	83	Management Reporting - FASTR
	84	Distributive Data Processing
	85	Custom Programming
	86	Electronic Doc. Interchange
	87	JDE Internal
	88	Cautious Purge System
	89	Conversion Programs
	91	Documentation
	92	Computer Assisted Design
	93	Computer Assisted Programming
	94	Security Officer
	95	Sleeper-now in system 96
	96	Computer Operations
	97	Software Installation
	98	Technical Tools
	98E	Electronic Burst and Bind
	98FT	Form Type
	98SA	Sample Application
	99	Technical Tools - Internal
	99D	Technical Tools - DASD Sizer
	99M	Technical Tools-Masters/Update
	B	LANGUAGE TRANSLATIONS
	B1A	Chinese - Simple
	B1B	Chinese - Complex
	B1E	English
	B1F	French
	B1G	German
	B1I	Italian
	B1J	Japanese
	B1P	Portuguese
	B1S	Spanish
	B2A	Dutch
	B2D	Danish
	B2F	Finnish
	B2N	Norwegian
	B2S	Swedish
	B3C	Czech
	B3H	Hebrew
	B3R	Russian
	BC1	Chinese - Simple
	BC2	Chinese - Complex
	BCR	Czech
	BDN	Danish
	BDU	Dutch
	BFI	Finnish
	BFR	French
	BGR	German
	BHE	Hebrew
	BIT	Italian
	BJP	Japanese
	BNO	Norwegian
	BPO	Portuguese
	BRU	Russian
	BSP	Spanish
	BSW	Swedish
	D3N	dcLINK (data collection)
	H01	Address Book (inc. ALL Mail)
	H03	Accounts Receivable
	H03B	New Accounts Receivable
	H04	Accounts Payable
	H05	Standalone Time Accounting
	H07	Payroll
	H08	Human Resources
	H09	General Accounting
	H12	Fixed Assets
	H13	Equipment/Plant Management
	H15	Commercial Property Management
	H30	Product Data Management
	H301	Process Data Management
	H31	Shop Floor Control
	H311	Process Control
	H32	Configuration Management
	H33	Capacity Requirements Planning
	H34	DRP/MRP/MPS
	H35	Enterprise Facility Planning
	H36	Advanced Forecasting
	H40	Inventory/OP Base
	H41	Inventory Management
	H415	Bulk Inventory Management
	H42	Sales Order Processing
	H43	Purchase Order Processing
	H44	Contract Management
	H44H	Homebuilder Management
	H45	Sales Analysis
	H46	Warehouse Management
	H50	Job Cost Base
	H72	Client/Server Base
	H73	CS - A/P Voucher Entry
	H74	CS - Pay Time Entry
	H75	CS - Sales Order Entry
	H76	CS - Training & Development
	H78	CS - Travel Expense Management
	H79	CS - Forecasting
	H90	JD Edwards EnterpriseOne TOOLS
	H91	Design Tools
	H92	Interactive Engine/OL
	H93	Data Base and Communications
	H94	Batch Engine
	H95	Tech Resources/Applications
	H96	Deployment
	H97	Benchmarking/Performance
	H98	internet
	H99	Product Version Control
	H99P	Technical Tools-OWPVC Internal
	JE42	Sales Order/Pricing
	JE44	Distribution Contracts
	JE48	Automated Gantry Inter.
	KZ1	PC Budget Upload (A3 to A5)
	KZ2	PC Data Entry for AP
	KZ3	PC Data Entry for Payroll
	SY	SYSTEM
	Z101	MTI Electrical Distribution
	Z102	CRES
	Z91	System/ Product Codes













Glossary


Accessor Methods/Assessors

Java methods to “get” and “set” the elements of a value object or other source file.





activity rule

The criteria by which an object progresses from one given point to the next in a flow.





add mode

A condition of a form that enables users to input data.





Advanced Planning Agent (APAg)

A JD Edwards EnterpriseOne tool that can be used to extract, transform, and load enterprise data. APAg supports access to data sources in the form of rational databases, flat file format, and other data or message encoding, such as XML.





application server

Software that provides the business logic for an application program in a distributed environment. The servers can be Oracle Application Server (OAS) or WebSphere Application Server (WAS).





Auto Commit Transaction

A database connection through which all database operations are immediately written to the database.





batch processing

A process of transferring records from a third-party system to JD Edwards EnterpriseOne.

In JD Edwards EnterpriseOne Financial Management, batch processing enables you to transfer invoices and vouchers that are entered in a system other than JD Edwards EnterpriseOne to JD Edwards EnterpriseOne Accounts Receivable and JD Edwards EnterpriseOne Accounts Payable, respectively. In addition, you can transfer address book information, including customer and supplier records, to JD Edwards EnterpriseOne.





batch server

A server that is designated for running batch processing requests. A batch server typically does not contain a database nor does it run interactive applications.





batch-of-one

A transaction method that enables a client application to perform work on a client workstation, then submit the work all at once to a server application for further processing. As a batch process is running on the server, the client application can continue performing other tasks.





best practices

Non-mandatory guidelines that help the developer make better design decisions.





BPEL

Abbreviation for Business Process Execution Language, a standard web services orchestration language, which enables you to assemble discrete services into an end-to-end process flow.





BPEL PM

Abbreviation for Business Process Execution Language Process Manager, a comprehensive infrastructure for creating, deploying, and managing BPEL business processes.





Build Configuration File

Configurable settings in a text file that are used by a build program to generate ANT scripts. ANT is a software tool used for automating build processes. These scripts build published business services.





build engineer

An actor that is responsible for building, mastering, and packaging artifacts. Some build engineers are responsible for building application artifacts, and some are responsible for building foundation artifacts.





Build Program

A WIN32 executable that reads build configuration files and generates an ANT script for building published business services.





business analyst

An actor that determines if and why an EnterpriseOne business service needs to be developed.





business function

A named set of user-created, reusable business rules and logs that can be called through event rules. Business functions can run a transaction or a subset of a transaction (check inventory, issue work orders, and so on). Business functions also contain the application programming interfaces (APIs) that enable them to be called from a form, a database trigger, or a non-JD Edwards EnterpriseOne application. Business functions can be combined with other business functions, forms, event rules, and other components to make up an application. Business functions can be created through event rules or third-generation languages, such as C. Examples of business functions include Credit Check and Item Availability.





business function event rule

See named event rule (NER).





business service

EnterpriseOne business logic written in Java. A business service is a collection of one or more artifacts. Unless specified otherwise, a business service implies both a published business service and business service.





business service artifacts

Source files, descriptors, and so on that are managed for business service development and are needed for the business service build process.





business service class method

A method that accesses resources provided by the business service framework.





business service configuration files

Configuration files include, but are not limited to, interop.ini, JDBj.ini, and jdelog.properties.





business service cross reference

A key and value data pair used during orchestration. Collectively refers to both the code and the key cross reference in the WSG/XPI based system.





business service cross-reference utilities

Utility services installed in a BPEL/ESB environment that are used to access JD Edwards EnterpriseOne orchestration cross-reference data.





business service development environment

A framework needed by an integration developer to develop and manage business services.





business services development tool

Otherwise known as JDeveloper.





business service EnterpriseOne object

A collection of artifacts managed by EnterpriseOne LCM tools. Named and represented within EnterpriseOne LCM similarly to other EnterpriseOne objects like tables, views, forms, and so on.





business service framework

Parts of the business service foundation that are specifically for supporting business service development.





business service payload

An object that is passed between an enterprise server and a business services server. The business service payload contains the input to the business service when passed to the business services server. The business service payload contains the results from the business service when passed to the Enterprise Server. In the case of notifications, the return business service payload contains the acknowledgement.





business service property

Key value data pairs used to control the behavior or functionality of business services.





Business Service Property Admin Tool

An EnterpriseOne application for developers and administrators to manage business service property records.





business service property business service group

A classification for business service property at the business service level. This is generally a business service name. A business service level contains one or more business service property groups. Each business service property group may contain zero or more business service property records.





business service property key

A unique name that identifies the business service property globally in the system.





business service property utilities

A utility API used in business service development to access EnterpriseOne business service property data.





business service property value

A value for a business service property.





business service repository

A source management system, for example ClearCase, where business service artifacts and build files are stored. Or, a physical directory in network.





business services server

The physical machine where the business services are located. Business services are run on an application server instance.





business services source file or business service class

One type of business service artifact. A text file with the .java file type written to be compiled by a Java compiler.





business service value object template

The structural representation of a business service value object used in a C-business function.





Business Service Value Object Template Utility

A utility used to create a business service value object template from a business service value object.





business services server artifact

The object to be deployed to the business services server.





business view

A means for selecting specific columns from one or more JD Edwards EnterpriseOne application tables whose data is used in an application or report. A business view does not select specific rows, nor does it contain any actual data. It is strictly a view through which you can manipulate data.





central objects merge

A process that blends a customer's modifications to the objects in a current release with objects in a new release.





central server

A server that has been designated to contain the originally installed version of the software (central objects) for deployment to client computers. In a typical JD Edwards EnterpriseOne installation, the software is loaded on to one machine—the central server. Then, copies of the software are pushed out or downloaded to various workstations attached to it. That way, if the software is altered or corrupted through its use on workstations, an original set of objects (central objects) is always available on the central server.





charts

Tables of information in JD Edwards EnterpriseOne that appear on forms in the software.





check-in repository

A repository for developers to check in and check out business service artifacts. There are multiple check-in repositories. Each can be used for a different purpose (for example, development, production, testing, and so on).





checksum

A fixed-size datum computed from an arbitrary block of digital data for the purpose of detecting accidental errors that may have been introduced during its transmission or storage. JD Edwards EnterpriseOne uses the checksum to verify the integrity of packages that have been downloaded by recomputing the checksum of the downloaded package and comparing it with the checksum of the original package. The procedure that yields the checksum from the data is called a checksum function or checksum algorithm. JD Edwards EnterpriseOne uses the MD5 and STA-1 checksum algorithms.





connector

Component-based interoperability model that enables third-party applications and JD Edwards EnterpriseOne to share logic and data. The JD Edwards EnterpriseOne connector architecture includes Java and COM connectors.





Control Table Workbench

An application that, during the Installation Workbench processing, runs the batch applications for the planned merges that update the data dictionary, user-defined codes, menus, and user override tables.





control tables merge

A process that blends a customer's modifications to the control tables with the data that accompanies a new release.





correlation data

The data used to tie HTTP responses with requests that consist of business service name and method.





credentials

A valid set of JD Edwards EnterpriseOne username/password/environment/role, EnterpriseOne session, or EnterpriseOne token.





cross-reference utility services

Utility services installed in a BPEL/ESB environment that access EnterpriseOne cross-reference data.





database credentials

A valid database username/password.





database server

A server in a local area network that maintains a database and performs searches for client computers.





Data Source Workbench

An application that, during the Installation Workbench process, copies all data sources that are defined in the installation plan from the Data Source Master and Table and Data Source Sizing tables in the Planner data source to the system-release number data source. It also updates the Data Source Plan detail record to reflect completion.





deployment artifacts

Artifacts that are needed for the deployment process, such as servers, ports, and such.





deployment server

A server that is used to install, maintain, and distribute software to one or more enterprise servers and client workstations.





direct connect

A transaction method in which a client application communicates interactively and directly with a server application.

See also batch-of-one and store-and-forward.





Do Not Translate (DNT)

A type of data source that must exist on the iSeries because of BLOB restrictions.





embedded application server instance

An OC4J instance started by and running wholly within JDeveloper.





edit code

A code that indicates how a specific value for a report or a form should appear or be formatted. The default edit codes that pertain to reporting require particular attention because they account for a substantial amount of information.





edit mode

A condition of a form that enables users to change data.





edit rule

A method used for formatting and validating user entries against a predefined rule or set of rules.





Electronic Data Interchange (EDI)

An interoperability model that enables paperless computer-to-computer exchange of business transactions between JD Edwards EnterpriseOne and third-party systems. Companies that use EDI must have translator software to convert data from the EDI standard format to the formats of their computer systems.





embedded event rule

An event rule that is specific to a particular table or application. Examples include form-to-form calls, hiding a field based on a processing option value, and calling a business function. Contrast with the business function event rule.





Employee Work Center

A central location for sending and receiving all JD Edwards EnterpriseOne messages (system and user generated), regardless of the originating application or user. Each user has a mailbox that contains workflow and other messages, including Active Messages.





enterprise server

A server that contains the database and the logic for JD Edwards EnterpriseOne.





Enterprise Service Bus (ESB)

Middleware infrastructure products or technologies based on web services standards that enable a service-oriented architecture using an event-driven and XML-based messaging framework (the bus).





EnterpriseOne administrator

An actor responsible for the EnterpriseOne administration system.





EnterpriseOne credentials

A user ID, password, environment, and role used to validate a user of EnterpriseOne.





EnterpriseOne development client

Historically called “fat client,” a collection of installed EnterpriseOne components required to develop EnterpriseOne artifacts, including the Microsoft Windows client and design tools.





EnterpriseOne extension

A JDeveloper component (plug-in) specific to EnterpriseOne. A JDeveloper wizard

is a specific example of an extension.





EnterpriseOne object

A reusable piece of code that is used to build applications. Object types include tables, forms, business functions, data dictionary items, batch processes, business views, event rules, versions, data structures, and media objects.





EnterpriseOne process

A software process that enables JD Edwards EnterpriseOne clients and servers to handle processing requests and run transactions. A client runs one process, and servers can have multiple instances of a process. JD Edwards EnterpriseOne processes can also be dedicated to specific tasks (for example, workflow messages and data replication) to ensure that critical processes don't have to wait if the server is particularly busy.





EnterpriseOne resource

Any EnterpriseOne table, metadata, business function, dictionary information, or other information restricted to authorized users.





Environment Workbench

An application that, during the Installation Workbench process, copies the environment information and Object Configuration Manager tables for each environment from the Planner data source to the system-release number data source. It also updates the Environment Plan detail record to reflect completion.





escalation monitor

A batch process that monitors pending requests or activities and restarts or forwards them to the next step or user after they have been inactive for a specified amount of time.





event rule

A logic statement that instructs the system to perform one or more operations based on an activity that can occur in a specific application, such as entering a form or exiting a field.





explicit transaction

Transaction used by a business service developer to explicitly control the type (auto or manual) and the scope of transaction boundaries within a business service.





exposed method or value object

Published business service source files or parts of published business service source files that are part of the published interface. These are part of the contract with the customer.





fast path

A command prompt that enables the user to move quickly among menus and applications by using specific commands.





file server

A server that stores files to be accessed by other computers on the network. Unlike a disk server, which appears to the user as a remote disk drive, a file server is a sophisticated device that not only stores files, but also manages them and maintains order as network users request files and make changes to these files.





final mode

The report processing mode of a processing mode of a program that updates or creates data records.





foundation

A framework that must be accessible for execution of business services at runtime. This includes, but is not limited to, the Java Connector and JDBj.





FTP server

A server that responds to requests for files via file transfer protocol.





HTTP Adapter

A generic set of services that are used to do the basic HTTP operations, such as GET, POST, PUT, DELETE, TRACE, HEAD, and OPTIONS with the provided URL.





instantiate

A Java term meaning “to create.” When a class is instantiated, a new instance

is created.





integration developer

The user of the system who develops, runs, and debugs the EnterpriseOne business services. The integration developer uses the EnterpriseOne business services to develop these components.





integration point (IP)

The business logic in previous implementations of EnterpriseOne that exposes a document level interface. This type of logic used to be called XBPs. In EnterpriseOne 8.11, IPs are implemented in Web Services Gateway powered by webMethods.





integration server

A server that facilitates interaction between diverse operating systems and applications across internal and external networked computer systems.





integrity test

A process used to supplement a company's internal balancing procedures by locating and reporting balancing problems and data inconsistencies.





interface table

See Z table.





internal method or value object

Business service source files or parts of business service source files that are not part of the published interface. These could be private or protected methods. These could be value objects not used in published methods.





interoperability model

A method for third-party systems to connect to or access JD Edwards EnterpriseOne.





in-your-face error

In JD Edwards EnterpriseOne, a form-level property which, when enabled, causes the text of application errors to appear on the form.





jargon

An alternative data dictionary item description that JD Edwards EnterpriseOne appears based on the product code of the current object.





Java application server

A component-based server that resides in the middle-tier of a server-centric architecture. This server provides middleware services for security and state maintenance, along with data access and persistence.





JDBNET

A database driver that enables heterogeneous servers to access each other's data.





JDEBASE Database Middleware

A JD Edwards EnterpriseOne proprietary database middleware package that provides platform-independent APIs, along with client-to-server access.





JDECallObject

An API used by business functions to invoke other business functions.





jde.ini

A JD Edwards EnterpriseOne file (or member for iSeries) that provides the runtime settings required for JD Edwards EnterpriseOne initialization. Specific versions of the file or member must reside on every machine running JD Edwards EnterpriseOne. This includes workstations and servers.





JDEIPC

Communications programming tools used by server code to regulate access to the same data in multiprocess environments, communicate and coordinate between processes, and create new processes.





jde.log

The main diagnostic log file of JD Edwards EnterpriseOne. This file is always located in the root directory on the primary drive and contains status and error messages from the startup and operation of JD Edwards EnterpriseOne.





JDENET

A JD Edwards EnterpriseOne proprietary communications middleware package. This package is a peer-to-peer, message-based, socket-based, multiprocess communications middleware solution. It handles client-to-server and server-to-server communications for all JD Edwards EnterpriseOne supported platforms.





JDeveloper Project

An artifact that JDeveloper uses to categorize and compile source files.





JDeveloper Workspace

An artifact that JDeveloper uses to organize project files. It contains one or more project files.





JMS Queue

A Java Messaging service queue used for point-to-point messaging.





listener service

A listener that listens for XML messages over HTTP.





local repository

A developer's local development environment that is used to store business service artifacts.





Location Workbench

An application that, during the Installation Workbench process, copies all locations that are defined in the installation plan from the Location Master table in the Planner data source to the system data source.





logic server

A server in a distributed network that provides the business logic for an application program. In a typical configuration, pristine objects are replicated on to the logic server from the central server. The logic server, in conjunction with workstations, actually performs the processing required when JD Edwards EnterpriseOne software runs.





MailMerge Workbench

An application that merges Microsoft Word 6.0 (or higher) word-processing documents with JD Edwards EnterpriseOne records to automatically print business documents. You can use MailMerge Workbench to print documents, such as form letters about verification of employment.





Manual Commit transaction

A database connection where all database operations delay writing to the database until a call to commit is made.





master business function (MBF)

An interactive master file that serves as a central location for adding, changing, and updating information in a database. Master business functions pass information between data entry forms and the appropriate tables. These master functions provide a common set of functions that contain all of the necessary default and editing rules for related programs. MBFs contain logic that ensures the integrity of adding, updating, and deleting information from databases.





master table

See published table.





media storage object

Files that use one of the following naming conventions that are not organized into table format: Gxxx, xxxGT, or GTxxx.





message center

A central location for sending and receiving all JD Edwards EnterpriseOne messages (system and user generated), regardless of the originating application or user.





messaging adapter

An interoperability model that enables third-party systems to connect to JD Edwards EnterpriseOne to exchange information through the use of messaging queues.





messaging server

A server that handles messages that are sent for use by other programs using a messaging API. Messaging servers typically employ a middleware program to perform their functions.





Monitoring Application

An EnterpriseOne tool provided for an administrator to get statistical information for various EnterpriseOne servers, reset statistics, and set notifications.





named event rule (NER)

Encapsulated, reusable business logic created using event rules, rather that C programming. NERs are also called business function event rules. NERs can be reused in multiple places by multiple programs. This modularity lends itself to streamlining, reusability of code, and less work.





Object Configuration Manager (OCM)

In JD Edwards EnterpriseOne, the object request broker and control center for the runtime environment. OCM keeps track of the runtime locations for business functions, data, and batch applications. When one of these objects is called, OCM directs access to it using defaults and overrides for a given environment and user.





Object Librarian

A repository of all versions, applications, and business functions reusable in building applications. Object Librarian provides check-out and check-incapabilities for developers, and it controls the creation, modification, and use of JD Edwards EnterpriseOne objects. Object Librarian supports multiple environments (such as production and development) and enables objects to be easily moved from one environment to another.





Object Librarian merge

A process that blends any modifications to the Object Librarian in a previous release into the Object Librarian in a new release.





Open Data Access (ODA)

An interoperability model that enables you to use SQL statements to extract JD Edwards EnterpriseOne data for summarization and report generation.





Output Stream Access (OSA)

An interoperability model that enables you to set up an interface for JD Edwards EnterpriseOne to pass data to another software package, such as Microsoft Excel, for processing.





package

JD Edwards EnterpriseOne objects are installed to workstations in packages from the deployment server. A package can be compared to a bill of material or kit that indicates the necessary objects for that workstation and where on the deployment server the installation program can find them. It is point-in-time snapshot of the central objects on the deployment server.





package build

A software application that facilitates the deployment of software changes and new applications to existing users. Additionally, in JD Edwards EnterpriseOne, a package build can be a compiled version of the software. When you upgrade your version of the ERP software, for example, you are said to take a package build.

Consider the following context: “Also, do not transfer business functions into the production path code until you are ready to deploy, because a global build of business functions done during a package build will automatically include the new functions.” The process of creating a package build is often referred to, as it is in this example, simply as “a package build.”





package location

The directory structure location for the package and its set of replicated objects. This is usually \\deployment server\release\path_code\package\package name. The subdirectories under this path are where the replicated objects for the package are placed. This is also referred to as where the package is built or stored.





Package Workbench

An application that, during the Installation Workbench process, transfers the package information tables from the Planner data source to the system-release number data source. It also updates the Package Plan detail record to reflect completion.





Pathcode Directory

The specific portion of the file system on the EnterpriseOne development client where EnterpriseOne development artifacts are stored.





patterns

General repeatable solutions to a commonly occurring problem in software design. For business service development, the focus is on the object relationships and interactions. For orchestrations, the focus is on the integration patterns (for example, synchronous and asynchronous request/response, publish, notify, and receive/reply).





print server

The interface between a printer and a network that enables network clients to connect to the printer and send their print jobs to it. A print server can be a computer, separate hardware device, or even hardware that resides inside of the printer itself.





pristine environment

A JD Edwards EnterpriseOne environment used to test unaltered objects with JD Edwards EnterpriseOne demonstration data or for training classes. You must have this environment so that you can compare pristine objects that you modify.





processing option

A data structure that enables users to supply parameters that regulate the running of a batch program or report. For example, you can use processing options to specify default values for certain fields, to determine how information appears or is printed, to specify date ranges, to supply runtime values that regulate program execution, and so on.





production environment

A JD Edwards EnterpriseOne environment in which users operate EnterpriseOne software.





Production Published Business Services Web Service

Published business services web service deployed to a production application server.





program temporary fix (PTF)

A representation of changes to JD Edwards EnterpriseOne software that your organization receives on magnetic tapes or disks.





project

In JD Edwards EnterpriseOne, a virtual container for objects being developed in Object Management Workbench.





promotion path

The designated path for advancing objects or projects in a workflow. The following is the normal promotion cycle (path):

11>21>26>28>38>01

In this path, 11 equals new project pending review, 21 equals programming, 26 equals QA test/review, 28 equals QA test/review complete, 38 equals in production, 01 equals complete. During the normal project promotion cycle, developers check objects out of and into the development path code and then promote them to the prototype path code. The objects are then moved to the productions path code before declaring them complete.





proxy server

A server that acts as a barrier between a workstation and the internet so that the enterprise can ensure security, administrative control, and caching service.





published business service

EnterpriseOne service level logic and interface. A classification of a published business service indicating the intention to be exposed to external (non-EnterpriseOne) systems.





published business service identification information

Information about a published business service used to determine relevant authorization records. Published business services + method name, published business services, or *ALL.





published business service web service

Published business services components packaged as J2EE Web Service (namely, a J2EE EAR file that contains business service classes, business service foundation, configuration files, and web service artifacts).





published table

Also called a master table, this is the central copy to be replicated to other machines. Residing on the publisher machine, the F98DRPUB table identifies all of the published tables and their associated publishers in the enterprise.





publisher

The server that is responsible for the published table. The F98DRPUB table identifies all of the published tables and their associated publishers in the enterprise.





QBE

An abbreviation for query by example. In JD Edwards EnterpriseOne, the QBE line is the top line on a detail area that is used for filtering data.





real-time event

A message triggered from EnterpriseOne application logic that is intended for external systems to consume.





refresh

A function used to modify JD Edwards EnterpriseOne software, or subset of it, such as a table or business data, so that it functions at a new release or cumulative update level.





replication server

A server that is responsible for replicating central objects to client machines.





rules

Mandatory guidelines that are not enforced by tooling, but must be followed in order to accomplish the desired results and to meet specified standards.





secure by default

A security model that assumes that a user does not have permission to execute an object unless there is a specific record indicating such permissions.





Secure Socket Layer (SSL)

A security protocol that provides communication privacy. SSL enables client and server applications to communicate in a way that is designed to prevent eavesdropping, tampering, and message forgery.





selection

Found on JD Edwards EnterpriseOne menus, a selection represents functions that you can access from a menu. To make a selection, type the associated number in the Selection field and press Enter.





serialize

The process of converting an object or data into a format for storage or transmission across a network connection link with the ability to reconstruct the original data or objects when needed.





Server Workbench

An application that, during the Installation Workbench process, copies the server configuration files from the Planner data source to the system-release number data source. The application also updates the Server Plan detail record to reflect completion.





SOA

Abbreviation for Service Oriented Architecture.





softcoding

A coding technique that enables an administrator to manipulate site-specific variables that affect the execution of a given process.





source repository

A repository for HTTP adapter and listener service development environment artifacts.





Specification merge

A merge that comprises three merges: Object Librarian merge, Versions List merge, and Central Objects merge. The merges blend customer modifications with data that accompanies a new release.





specification

A complete description of a JD Edwards EnterpriseOne object. Each object has its own specification, or name, which is used to build applications.





Specification Table Merge Workbench

An application that, during the Installation Workbench process, runs the batch applications that update the specification tables.





SSL Certificate

A special message signed by a certificate authority that contains the name of a user and that user's public key in such a way that anyone can "verify" that the message was signed by no one other than the certification authority and thereby develop trust in the user's public key.





store-and-forward

The mode of processing that enables users who are disconnected from a server to enter transactions and then later connect to the server to upload those transactions.





subscriber table

Table F98DRSUB, which is stored on the publisher server with the F98DRPUB table and identifies all of the subscriber machines for each published table.





super class

An inheritance concept of the Java language where a class is an instance of something, but is also more specific. “Tree” might be the super class of “Oak” and “Elm,” for example.





table access management (TAM)

The JD Edwards EnterpriseOne component that handles the storage and retrieval of use-defined data. TAM stores information, such as data dictionary definitions; application and report specifications; event rules; table definitions; business function input parameters and library information; and data structure definitions for running applications, reports, and business functions.





Table Conversion Workbench

An interoperability model that enables the exchange of information between JD Edwards EnterpriseOne and third-party systems using non-JD Edwards EnterpriseOne tables.





table conversion

An interoperability model that enables the exchange of information between JD Edwards EnterpriseOne and third-party systems using non-JD Edwards EnterpriseOne tables.





table event rules

Logic that is attached to database triggers that runs whenever the action specified by the trigger occurs against the table. Although JD Edwards EnterpriseOne enables event rules to be attached to application events, this functionality is application specific. Table event rules provide embedded logic at the table level.





terminal server

A server that enables terminals, microcomputers, and other devices to connect to a network or host computer or to devices attached to that particular computer.





transaction processing (TP) monitor

A monitor that controls data transfer between local and remote terminals and the applications that originated them. TP monitors also protect data integrity in the distributed environment and may include programs that validate data and format terminal screens.





transaction processing method

A method related to the management of a manual commit transaction boundary (for example, start, commit, rollback, and cancel).





transaction set

An electronic business transaction (electronic data interchange standard document) made up of segments.





trigger

One of several events specific to data dictionary items. You can attach logic to a data dictionary item that the system processes automatically when the event occurs.





triggering event

A specific workflow event that requires special action or has defined consequences or resulting actions.





user identification information

User ID, role, or *public.





User Overrides merge

Adds new user override records into a customer's user override table.





value object

A specific type of source file that holds input or output data, much like a data structure passes data. Value objects can be exposed (used in a published business service) or internal, and input or output. They are comprised of simple and complex elements and accessories to those elements.





versioning a published business service

Adding additional functionality/interfaces to the published business services without modifying the existing functionality/interfaces.





Versions List merge

The Versions List merge preserves any non-XJDE and non-ZJDE version specifications for objects that are valid in the new release, as well as their processing options data.





visual assist

Forms that can be invoked from a control via a trigger to assist the user in determining what data belongs in the control.





vocabulary override

An alternate description for a data dictionary item that appears on a specific JD Edwards EnterpriseOne form or report.





web application server

A web server that enables web applications to exchange data with the back-end systems and databases used in eBusiness transactions.





web server

A server that sends information as requested by a browser, using the TCP/IP set of protocols. A web server can do more than just coordination of requests from browsers; it can do anything a normal server can do, such as house applications or data. Any computer can be turned into a web server by installing server software and connecting the machine to the internet.





Web Service Description Language (WSDL)

An XML format for describing network services.





Web Service Inspection Language (WSIL)

An XML format for assisting in the inspection of a site for available services and a set of rules for how inspection-related information should be made.





web service softcoding record

An XML document that contains values that are used to configure a web service proxy. This document identifies the endpoint and conditionally includes security information.





web service softcoding template

An XML document that provides the structure for a soft coded record.





Where clause

The portion of a database operation that specifies which records the database operation will affect.





Windows terminal server

A multiuser server that enables terminals and minimally configured computers to display Windows applications even if they are not capable of running Windows software themselves. All client processing is performed centrally at the Windows terminal server and only display, keystroke, and mouse commands are transmitted over the network to the client terminal device.





wizard

A type of JDeveloper extension used to walk the user through a series of steps.





workbench

A program that enables users to access a group of related programs from a single entry point. Typically, the programs that you access from a workbench are used to complete a large business process. For example, you use the JD Edwards EnterpriseOne Payroll Cycle Workbench (P07210) to access all of the programs that the system uses to process payroll, print payments, create payroll reports, create journal entries, and update payroll history. Examples of JD Edwards EnterpriseOne workbenches include Service Management Workbench (P90CD020), Line Scheduling Workbench (P3153), Planning Workbench (P13700), Auditor's Workbench (P09E115), and Payroll Cycle Workbench.





workflow

The automation of a business process, in whole or in part, during which documents, information, or tasks are passed from one participant to another for action, according to a set of procedural rules.





workgroup server

A server that usually contains subsets of data replicated from a master network server. A workgroup server does not perform application or batch processing.





XAPI events

A service that uses system calls to capture JD Edwards EnterpriseOne transactions as they occur and then calls third-party software, end users, and other JD Edwards EnterpriseOne systems that have requested notification when the specified transactions occur to return a response.





XML CallObject

An interoperability capability that enables you to call business functions.





XML Dispatch

An interoperability capability that provides a single point of entry for all XML documents coming into JD Edwards EnterpriseOne for responses.





XML List

An interoperability capability that enables you to request and receive JD Edwards EnterpriseOne database information in chunks.





XML Service

An interoperability capability that enables you to request events from one JD Edwards EnterpriseOne system and receive a response from another JD Edwards EnterpriseOne system.





XML Transaction

An interoperability capability that enables you to use a predefined transaction type to send information to or request information from JD Edwards EnterpriseOne. XML transaction uses interface table functionality.





XML Transaction Service (XTS)

Transforms an XML document that is not in the JD Edwards EnterpriseOne format into an XML document that can be processed by JD Edwards EnterpriseOne. XTS then transforms the response back to the request originator XML format.





Z event

A service that uses interface table functionality to capture JD Edwards EnterpriseOne transactions and provide notification to third-party software, end users, and other JD Edwards EnterpriseOne systems that have requested to be notified when certain transactions occur.





Z table

A working table where non-JD Edwards EnterpriseOne information can be stored and then processed into JD Edwards EnterpriseOne. Z tables also can be used to retrieve JD Edwards EnterpriseOne data. Z tables are also known as interface tables.





Z transaction

Third-party data that is properly formatted in interface tables for updating to the JD Edwards EnterpriseOne database.









Index

A  B  C  D  E  F  G  H  I  J  K  L  M  O  P  Q  R  S  T  U  W 


A

	active messages, 6.3
	application suite, system integration, 2.3
	applications
	
	form types, 3.2
	sharing of data and logic, 2.3



	attachments
	
	checking for, 9.2.3
	metadata attachmentsstatus, 9.7.2
	renaming a button, 9.4.3



	Auto Populate, 3.9.1.2





B

	batch version processing options, 11.4.3
	button shortcuts, A.5





C

	calendar, 5.5.4





D

	data and logic, 2.3





E

	email, 6.1, 6.1
	
	canceling delivery to a specific queue, 7.3.7
	deleting messages, 7.3.9
	internal and external messages, 6.2
	moving message to another queue, 7.3.5
	printing messages, 7.4.1
	reassigning messages, 7.3.8
	redirecting messages, 7.3.6
	revising messages, 7.3.4
	sending internal messages, 7.1.1
	sending internal messages to a role, 7.1.5
	sending internal messagesquick list, 7.1.4
	workflow messages, 6.3
	working with shortcuts, 7.2.1



	EnterpriseOne Menu, 3.4.1, 3.4.2
	entry points, 2.1
	error messages and error dialog boxes, 3.9.1.1





F

	Find/Browse form, 3.2.1
	Fix/Inspect form, 3.2.4
	form types, 3.2
	
	Find/Browse form, 3.2.1
	Fix/Inspect form, 3.2.4
	Header Detail and Headerless Detail form, 3.2.3
	message box, 3.2.6
	Parent/Child form, 3.2.5
	Search/Select form, 3.2.2



	forms
	
	check in/out and update remark, 8.3.3
	maintaining mailmerge documents, 10.1
	working with workflow message security, 8.2.2








G

	grids, keyboard hot keys, A.10





H

	Header Detail and Headerless Detail forms, 3.2.3
	hot keys
	
	button shortcuts, A.5
	calendar tool, A.6
	keyboard shortcuts, A.1, A.2
	media object text, A.8
	moving around in the grid, A.10
	web client calendar tool, A.7








I

	imaging, 9
	interactive version processing options, 11.4.2, 11.4.2
	internal and external messages, 6.2
	internal messages, 7.1.1
	
	quick list, 7.1.4
	role, 7.1.5
	send to one person, 7.1.3








J

	JD Edwards EnterpriseOne Software
	
	entry points, 2.1



	JD Edwards EnterpriseOne Software Access, 2.1
	JD Edwards EnterpriseOne software features, 2.2
	
	adaptability, 2.2
	integrated supply chain, 2.2
	interoperability, 2.2
	multiplatform computing, 2.2
	user-friendly, 2.2



	JD Edwards EnterpriseOne systems, B.1
	JD Edwards software application suites, 2.3





K

	keyboard hot keys, A.1
	keyboard shortcuts, A.2
	
	calendar tool, A.6
	hot keys, A.1
	media object text, A.8
	web client calendar tool, A.7








L

	logs, viewing, 8.3.4





M

	mailmerge documents, 10.1
	mailmerge templates, 10.1
	media objects, 9.2, 9.3
	
	attaching a shortcut, 9.3.6, 9.3.7
	attaching a template, 9.5.2
	attaching an image object, 9.3.4
	attaching an OLE object, 9.3.5
	attaching media objects, 9.3
	attaching OLE objects at the base form level, 9.8, 9.8.1
	attaching text objects, 9.3.2
	checking for attachments, 9.2.3
	creating a template, 9.5.1
	deleting a template, 9.5.4
	deleting a template on media objects, 9.5.5
	deleting media objects, 9.4.4
	deleting OLE objects at the base form level, 9.8.2
	image files, 9
	modifying a template, 9.5.3
	object linking and embedding (OLE), 9
	overview, 9
	properties of media objects, 9.6
	setting image properties, 9.6.3
	setting media object properties, 9.6.1
	setting media object text properties, 9.6.2
	setting shortcut properties, 9.6.5
	templates, 9.5
	text files, 9
	viewing OLE properties, 9.6.4



	message box, 3.2.6
	messages, 7.3.4
	
	accessing the employee work center, 7.3.1
	cancel delivery to a specific queue, 7.3.7
	deleting messages, 7.3.9
	internal and external messages, 6.2
	internal messagesend to one person, 7.1.3
	moving message to another queue, 7.3.5
	moving to another queue, 7.3.5
	print a report of all messages in a queue, 7.4.1
	printing messages, 7.4.1
	reassigning, 7.3.8
	redirecting messages, 7.3.6
	revising, 7.3.4
	send shortcut, 7.2.3
	sending, 7.3.3
	sending internal messages, 7.1.1
	sending internal messagesquick lists, 7.1.4
	understanding queues, 6.4
	viewing messages, 7.3.3
	Work Item Manager, 6.1
	workflow messages, 6.3
	working with shortcuts, 7.2.1



	messages and queues, 6.1
	metadata for an attachment, define, 9.7.2





O

	OLE objects
	
	as media objects, 9.3
	attaching at the base form level, 9.8, 9.8.1
	deleting at the base form level, 9.8.2



	OLE objects at the base form level, 9.8, 9.8.1
	OLE objects at the base form level, deleting, 9.8.2
	OLE properties, 9.6.4





P

	Parent/Child form, 3.2.5
	password, changing, 5.1.5
	priority or secondary queue
	
	canceling delivery to a specific queue, 7.3.7
	redirecting messages, 7.3.6



	processing option functions, 11.2
	processing options, 11
	
	batch version processing options, 11.4.3
	interactive processing options, 11.4.2
	interactive processing optionsmanuallylaunch, 11.4.2
	master business functions, 11.4.5
	processing option functions, 11.2
	types of processing options, 11.3
	working with processing options, 11.4



	programs and IDs
	
	P0112 (Time Log Ledger Update)Check In/Outand Update Remark, 8.3.3








Q

	queue manager
	
	logging timecheckingin and out, 8.3.2
	logging timeentering remarks, 8.3.3
	logging timeviewing time logs, 8.3.4
	time entry, 8.3.1



	queue security, 8.2.2
	queues, 6.4, 8.1
	
	canceling delivery to a specific queue, 7.3.7
	moving a message to another queue, 7.3.5
	redirecting messages, 7.3.6
	workflow queues, 6.4.2



	quick list, 7.1.4





R

	records
	
	checking for attachments, 9.2.3



	remarks, 8.3.3
	report
	
	viewing output, 5.1.4



	reports
	
	print report that lists all messages in a queue, 7.4.1



	role, send a message to a role, 7.1.5





S

	Search/Select form, 3.2.2
	shortcut properties, 9.6.5
	shortcuts, 7.2.1
	
	media object, 9
	send shortcut, 7.2.3



	system integration, 2.3





T

	tables and business views, viewing data, 5.3.1
	task documentation, 3.9.2
	templates, 9.5
	
	attaching a template, 9.5.2
	create a template, 9.5.1
	delete a template, 9.5.4
	deleting a template on media objects, 9.5.5
	modify a template, 9.5.3



	text properties, 9.6.2
	time entry
	
	checking in and out, 8.3.2
	entering remarks, 8.3.3
	logging time and adding remarks, 8.3.1
	viewing time logs, 8.3.4



	types of processing options, 11.3





U

	User Defined Codes
	
	queues, 6.4








W

	Work Center, 7.3.1
	
	accessing the employee work center, 7.3.1
	messages, 6.1
	queue, 8.1
	sending internal messages, 7.1.1
	sending internal messages to a role, 7.1.5
	sending internal messagesquick list, 7.1.4
	setting up a queue, 8.2.2
	understanding queues, 6.4
	viewing messages, 7.3.3
	working with queues, 8.1



	Work Item Manager, 6.1
	workflow message security, forms, 8.2.2
	workflow messages, 6.3
	workflow queues, 6.4.2







Oracle Legal Notices

Copyright Notice

Copyright © 1994-2014, Oracle and/or its affiliates. All rights reserved.

Trademark Notice

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective owners.

Intel and Intel Xeon are trademarks or registered trademarks of Intel Corporation. All SPARC trademarks are used under license and are trademarks or registered trademarks of SPARC International, Inc. AMD, Opteron, the AMD logo, and the AMD Opteron logo are trademarks or registered trademarks of Advanced Micro Devices. UNIX is a registered trademark of The Open Group.

License Restrictions Warranty/Consequential Damages Disclaimer

This software and related documentation are provided under a license agreement containing restrictions on use and disclosure and are protected by intellectual property laws. Except as expressly permitted in your license agreement or allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish, or display any part, in any form, or by any means. Reverse engineering, disassembly, or decompilation of this software, unless required by law for interoperability, is prohibited.

Warranty Disclaimer

The information contained herein is subject to change without notice and is not warranted to be error-free. If you find any errors, please report them to us in writing.

Restricted Rights Notice

If this is software or related documentation that is delivered to the U.S. Government or anyone licensing it on behalf of the U.S. Government, the following notice is applicable:

U.S. GOVERNMENT END USERS: Oracle programs, including any operating system, integrated software, any programs installed on the hardware, and/or documentation, delivered to U.S. Government end users are "commercial computer software" pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the programs, including any operating system, integrated software, any programs installed on the hardware, and/or documentation, shall be subject to license terms and license restrictions applicable to the programs. No other rights are granted to the U.S. Government.

Hazardous Applications Notice

This software or hardware is developed for general use in a variety of information management applications. It is not developed or intended for use in any inherently dangerous applications, including applications that may create a risk of personal injury. If you use this software or hardware in dangerous applications, then you shall be responsible to take all appropriate fail-safe, backup, redundancy, and other measures to ensure its safe use. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this software or hardware in dangerous applications.

Third-Party Content, Products, and Services Disclaimer

This software or hardware and documentation may provide access to or information on content, products, and services from third parties. Oracle Corporation and its affiliates are not responsible for and expressly disclaim all warranties of any kind with respect to third-party content, products, and services. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or damages incurred due to your access to or use of third-party content, products, or services.

Alpha and Beta Draft Documentation Notice

If this document is in preproduction status:

This documentation is in preproduction status and is intended for demonstration and preliminary use only. It may not be specific to the hardware on which you are using the software. Oracle Corporation and its affiliates are not responsible for and expressly disclaim all warranties of any kind with respect to this documentation and will not be responsible for any loss, costs, or damages incurred due to the use of this documentation.

[image: Oracle Logo]

OEBPS/img/attach.gif





OEBPS/img/parameterized_url.gif
Sales Order Detail Revisions.
o Cwen fom Sow Toow

R
{DetatRoisons | Lne0sf _ Oasroer

EporGia0ats
impon Gaa 0t

st g OwFomas

StoTo  [da; |+ AtcPopuice

SenaSnonat

Routir (000 Brancnptant

o

ey G50
Sae Catesntes)

|

=

|

Mooooooo o
8
[3

oss  es00000
ostos 7980000
ose0s  es00000
omeos  7em0000
oss0s  esooo00
os2005 7980000
om0e0s es00000

om

om0 60 A
o000 820
2000050 60
s s w20
810000 520
19950000 580
3000000 580






OEBPS/img/row_exits.gif





OEBPS/img/favorites_form_exit.gif
Customer Service Inqui

Fom
Rebat Histoy

Regionat o

S0 HeacerBrowse






OEBPS/dcommon/oracle-logo.jpg
ORACLE

JD Edwards
EnterpriseOne Tools
Foundation Guide,
Release 8.98 Update 4





OEBPS/img/move_up.gif





OEBPS/img/print.gif





OEBPS/img/activexmode.gif
ORACLE’ 1o EDWARDS ENTERPRISEONE

(e s G 1 e e o
o e
— Export Assistant
|
P
oot et
B (OEwortto an sisting Worbook
e
s ot
e et —
Sevrcoms

Lo st vpas e

st con e

ot OuOsouces ORmpe
ChekContru o xport o s coens.






OEBPS/dcommon/oracle.gif





OEBPS/img/delete.gif





OEBPS/img/edit.gif





OEBPS/img/price.gif





OEBPS/img/toggle_on.gif





OEBPS/img/htmleditor.gif
ORACLE" 1 EpwaRDS ENTERPRISEONE

& tMedia Object Viewer
Sue Cancel Ten Fle UL Temps Charac Qe Soelcn
a

X ¢ m @ PR @ 0 ¥
[Font ] L‘JIQ@OIAEE
Tett BIYUESIEl&x






OEBPS/img/unlock.gif





OEBPS/img/copy_and_lock.gif





OEBPS/img/view.gif





OEBPS/img/move_down.gif





OEBPS/img/toggle_off.gif





OEBPS/img/form_exits.gif
Customer Service Inquiry
Seect fpo e Cony Cpe fm o Tws

v & + & X O8 R

Orgertumber B
Cusomerp0 -

temtiomser -

soaTo F

spTo

@e

Brancnpiant

Favortes Pesena gack oder uanty

S0 HaserBranse

Form
Rebate sty
Regional o
S0 aacerBranse

o orser Order e soo extencea
T Wamber Guntty Co. Wumber SodTo  hame. vou Amunn

S0 201 s 2000 262 Copassem e 5200000

50 201 z0000 4000 422 Caprassem e st wnsns
S0 201 7s00200 5000 4242 Captasystem & 4810000 082005
S0 201 00020 6000 4262 Caprasysem e 19950000 082005






OEBPS/img/htmlmode.gif
ORACLE" b EDWARDS ENTERPRISEONE

[@ Work With Addresses.
Contiug. Cance!
a x

Export Assistant

Export Options
©BporToExcel
OBt To Comma Separated Values (CSV)
OBt To Cigboard

Define CellRange.
Export © 41l O Selected ORange
Click Continue 1o export al ows and all columns.

[E——






OEBPS/img/weigh.gif





